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1 Introduction

Steele Mutual Fund Expert is a comprehensive reference source of mutual fund data and a powerful
software tool to help you select, analyze, and track the mutual funds that are best for you.

The software has many exclusive features and gives the user full creative control over the data and its
presentation.

Steele Expert allows you to choose and evaluate the factors you believe are most important in
measuring and analyzing mutual fund performance, and then to isolate the funds that meet those
criteria. Any portion of the data can be reported in an unlimited number of ways, either displayed on the
screen, printed, graphed or exported for further manipulation or analysis to other applications.

If you are a new mutual fund investor, you may start simply by ranking (sorting) the data by the Year-to-
date, 1, 6, 12-month or 3-year return columns, and also by the Ratings columns, to see which funds
are at the top. You may also try the Winners Wizard , which helps you find the best funds in each
category. As you get to know the program, you will learn how to isolate funds that meet very specific
conditions.

Although we compute various derivative data, the underlying data is supplied by Morningstar, Inc., the
authority on mutual fund information.

Steele Mutual Fund Expert offers the following benefits and features:

30 Customizable Reports & Graphs View the included reports or create your own typeset quality, full-
page or tabular reports and graphs, to compare and view funds exactly the way you want. You can
place several graphs of any type on a report, along with smart data tables, and your own text boxes
and lines, with drag-and-drop convenience.

Create your own full-page reports and graphs Customize your own reports with drag-and-drop
editing and our many templates to facilitate your own research and presentations. You can even import
outside graphics, such as logos, and other images. Your saved reports will automatically be updated
with new data when you receive your next database.

Customize client analysis reports and presentations Combine tables, graphs, your text, and even
portfolios on the same page to create powerful, effective presentations, incorporating client information
and your firm name and logo by using the Expert’s desktop publishing and slide show capabilities.

Comprehensive Mutual Fund data from Morningstar. Authoritative and accurate information based
on original data from the recognized, leading source of investment data. It includes the performance of
over 30,000 mutual funds (with ETFs and money market funds), 150,000 variable annuities, and about
400 benchmarks and investment objective & category averages since 1962.

Compare funds Analyze the performance of any mutual fund or portfolio of funds against any other
fund, category of funds, or against 400 different benchmarks and investment objective and category
averages. Calculate averages for any number funds.

Portfolio Analysis & Tracking Set up any number of portfolios and the Mutual Fund Expert will
compare their performance with other funds, benchmarks, or portfolios, and will monitor their exact
value with every issue of your subscription.

Add your own Notes to each fund Enter your own notes and comments on each fund you are
interested in to enhance your research or create your own rating system.

Easily export or Cut & Paste data, graphs, and reports Use data for further spreadsheet analysis,
graphing, specialized presentations and reports by exporting data or simply using “Cut & Paste
Special” for great-looking graphs, tables, and reports, from the Expert into your other notebooks or

popular programs such as Microsoft® Word, Excel, PowerPoint, and Access.
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FINRA report compliant: Users of the Pro and Pro Plus editions can show to their clients fund reports
that do not need to be submitted for review to FINRA. See FINRA Compliance .

Find the Winners The Winners Wizard  finds the best performing funds in each investment
objective category with a few clicks.

Filter and rank funds according to your exact criteria Build custom filters to display only funds
matching criteria you choose, such as fund type, management fees, risk, and performance. 
Automatically track funds that beat benchmarks you choose, like S&P 500 index funds.

Create Custom Benchmarks and “Portfolio Funds” They can represent the weighted average of
each of the benchmarks or funds in your portfolios. Then, graph and compare them against other funds,
benchmarks, and each other.

Download the data from our Internet site Access the data as soon as it becomes available after the
5th business day every month. Here you can also obtain software updates, customer service, technical
support, find out about our latest product releases, ask questions, and make suggestions.

ABCDE & Star Fund Ratings Funds are awarded stars and letter grades on a 3-year basis for return,
risk, and overall risk-adjusted performance within their investment Category for easy, yet effective
quality comparison.

5-year Category Ranking graph Displayed for each fund in the database view, it makes it easy to
compare 5-year consistency visually, allowing you to identify the best performing funds within each
investment Category.

Risk-return graph instantly shows you whether a fund's performance is in proportion to its risk.

Outline-based user interface with Folders & Pages Makes viewing and organizing groups of mutual
fund graphs, reports, portfolios, clients, slide-show presentations, and research project easier and more
intuitive than ever. Create your own folders for each project and organize your work conveniently with
drag-and-drop.

 

41
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2 New Features

Most Recent Features

Category changes  (See Investment Category )
o Added the "Defined Outcome" category.

o Renamed and redefined the "Options Trading" category to "Equity Hedged".

Category changes
o Added the Digital Assets category.

o Revised definitions of Allocation—15% to 30% Equity, Allocation—30% to 50% Equity, Allocation—

50% to 70% Equity, Allocation—70% to 85% Equity, and Allocation—85%+ Equity.
o Renamed "World..." categories to "Global...".

The "Type" column has been renamed "Broad Category" and the "Category Group" column has been
renamed "US Category Group". All filters using these fields adjust automatically.

Under the "Filters" drop-down list in all tabular views the following built-in filters have been added:
- "ESG Funds" (Socially Responsible funds) (filter)
- "Index Funds" (filter)
- "Index Funds for Benchmarking" (securities group with select Index Funds). See Index Funds .

Index funds, such as those in the "Index Funds for Benchmarking" built-in securities group can be
used instead of indexes for benchmarking and comparisons for more real-world performance
comparisons. Several Index Funds faithfully follow their underlying index but, unlike the index, which
is a theoretical list of securities and their weights, they provide an investment vehicle that one can
actually purchase/hold and its performance does include the cost of managing its operation and
maintaining it.

Using an Index Fund instead of its underlying index for comparing performance is a more correct and
accurate apples-to-apples comparison of investment vehicle to investment vehicle, instead of a
mutual fund that one can invest in (whose performance includes the cost of existing) versus an index
which is a hypothetical collection of securities (without any associated costs of acquiring and trading
those securities, and managing the operation).

When Modern Portfolio Theory was born, comparing a security to the "market", often referred to a
large list of securities such as the S&P 500, Russell 1000/2000/3000, Wilshire 5000. It was highly
impractical and expensive to attempt to actually attempt to hold the contents of such benchmarks.
Today, however, low-cost Index Funds such as "Fidelity 500 Index" and "Vanguard S&P 500 ETF"
represent real-world incarnations of the underlying index that one can actually hold. As a result, for
example, it is more accurate and relevant to compare funds in the Large Cap category to those Index
Funds. If a considered mutual fund has not been matching (and is not projected to exceed) the
performance/risk provided by the Index Fund, the investor can instead actually buy the Index Fund
itself.

The Portfolio Environment now shows the Symbol column by default

Category and Objective Average names now reflect "Cat./Obj. Avg" in the name for easier
identification on reports and graphs.

Category and Objective Averages are now tracked internally and are not affected on reports and
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graphs by category/objective additions, deletions and changes.

Category changes
o Added Macro Trading, Event Driven, Relative Value Arbitrage, Derivative Income, Options Trading,

Multistrategy, Equity Market Neutral, World Large-Stock Growth, World Large-Stock Blend, World
Large-Stock Value, and Target-Date 2065+

o Added U.S. Category Groups Nontraditional Equity and Miscellaneous

o Retired Long-Short Credit, Bear Market, Volatility, Multicurrency, Options-based, Multialternative,

Market Neutral, and World Large Stock
o Renamed Target-Date 2060+ to Target-Date 2060 and Managed Futures to Systematic Trend

o Revised text definition of World Small/Mid Stock, Bank Loan, and Nontraditional Bond

Ultra High-resolution Screens (high-DPI / 4K)
The application now automatically adjusts for ultra high-resolution monitors such as 4K screens.

If some components of the application used to display too small and you previously had to manually
select a scaling mode for the Steele Expert application, you can improve the program's display by
returning that setting to automatic as follows:
o Find "Steele Mutual Fund Expert" in the Windows 10 Start menu. Right-click on it and select "More

> Open file location".
o There, right-click on "Steele Mutual Fund Expert" and select "Properties > Compatibility > Change

high DPI settings".
o Uncheck "Override high DPI scaling behavior" (or select "Application)".

The application now requires the following versions of Windows or later: Windows 10, 8, 7, Vista.

Category changes
o Added Commodities Focused category

o Retired Commodities Agriculture, Commodities Energy, Commodities Industrial Metals, and

Commodities Precious Metals
o Revised text definition of Mid-Cap Value, Mid-Cap Blend, and Mid-Cap Growth

To be able to see all the new report/graph changes, you should create a new Notebook file, which
will automatically contain all new objects and settings, and then copy your own reports into it. You
should keep all your modified/customized report templates in a folder in the Pages List so you can
copy it easily into a new, updated notebook.

To create a new notebook, select "Menu > File > New notebook / Select Database". To copy any
report/graph templates you have created or modified into a new notebook see "Copying a Page or a
Folder ". (We recommend copying them to the "Customized" folder and its subfolders in the
"Pages List".)

When we make improvements and additions to the standard reports, graphs and settings, this is the
best method to view and take advantage of them.

Category changes
o Added Intermediate Core-Plus Bond, Target Maturity, Muni Target Maturity, and World Bond-USD

Hedged
o Renamed Intermediate-Term Bond to Intermediate Core Bond

o Revised text definition of World Bond, Corporate Bond, Long-Term Bond, and Intermediate Core

Bond
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Best-fit Index Modern Portfolio Theory statistics added to Pro Plus edition. Modern Portfolio Theory
statistics driven by the Primary Index for each fund in all editions. See how to take full advantage of 
alphas .

Maximum Drawdown risk measure added to Pro Plus, Professional and Variable Annuities editions.

Added several benchmarks.

Windows 10 High DPI display handling
The application selects optimal display settings in Windows 10 for screens up to 1920x1080.

For ultra-high resolution 2k and 4k screens, if some components of the application display too small,
you can select a different scaling mode for the Steele Expert program:
o Find "Steele Mutual Fund Expert" in the Windows 10 Start menu. Right-click on it and select "More

> Open file location".
o There, right-click on "Steele Mutual Fund Expert" and select "Properties > Compatibility > Change

high DPI settings".
o Check "Override high DPI scaling behavior" and select "System (Enhanced)".

Category changes:
o Added: Money Market—Non-40 Act

o Revised text definition of Muni National Long, Muni National Intermediate, Muni National Short, Muni

Single State Long, Muni Single State Intermediate, Muni Single State Short, Muni California Long,
Muni California Intermediate, Muni New York Long, Muni New York Intermediate, and Bank Loan.

Category changes
"Option Writing" is being renamed "Options-based". The text definitions have been revised for
"Options-based", "World Bond", "Target-Date 2055", and "Target-Date 2060+".

Category changes
"Commodities Miscellaneous" has been retired. "World Small/Mid Stock" has been added, and
"World Stock" has been renamed to "World Large Stock".

Category changes
o Added: Infrastructure, Emerging-Markets Local-Currency Bond, Target-Date 2060+, Option Writing,

Long-Short Credit, Prime Money Market, Allocation—15% to 30% Equity, Allocation—85%+ Equity
o Renamed: Target Date 2051+ to Target-Date 2055, Conservative Allocation to Allocation—30% to

50% Equity, Moderate Allocation to Allocation—50% to70% Equity, Aggressive Allocation to
Allocation—70% to 85% Equity

Added to the Personal, Professional, and Variable Annuity editions
Full Equity Style Box Breakdown, Average Bond Duration and Average Bond Quality. Also added to
these editions: Equity Style Analysis report and 3 Equity Style Breakdown graphs (Detail, Market
Cap, Growth/Value).

Category changes
Added the "Energy Limited Partnership" category. See Investment Category .

Category Ranks Analysis
Added Category Percentile Ranks fields along with reports and graphs for the last 20 years of Rolling
Returns and for the last 10 Calendar Years.  These enhance comparing and filtering based on
consistency of managerial success in relation to each fund's peers. See Category Rank .

200

142

165



New Features 19

© 2024 Steele Systems, Inc.

Equity World Regions Exposure Breakdown
Added equity regional breakdown fields, reports and graphs to facilitate assessing and comparing
geopolitical risk. See Equity World Region Allocation .

New/updated reports & report reorganization
New fund and portfolio graphs and reports such as "Portfolio Quick View", "Category Performance
Ranks", and "Allocation Analysis" have been added and organized in a new, convenient way.

Category changes:
Added the "Corporate Bond", "Preferred Stock ", and "Tactical Allocation" categories. See 
Investment Category .

Portfolio Extended Performance: Now the system computes portfolio performance since the earliest
security data in the portfolio.  The Hypothetical Illustration environments, such as the "Long-Term
Growth" graph, now also use the same computational methodology.  (The assigned weights of any
securities missing data for any data point are allocated equally to the remaining securities. See 
Creating a Portfolio , Graph Options .)

Category changes:
o Added the "Single Currency" and "Miscellaneous Region" categories

o Renamed the "Currency" category to "Multicurrency"

o Renamed the field "Broad Asset Class" to "Category Group"

o Renamed the following Category Groups: "Balanced" to "Allocation", "U.S. Stock" to "U.S. Equity",

"International Stock" to "International Equity", and "Sector Stock" to "Sector Equity".
See Investment Category .

Keyboard shortcut added to display only tagged records:
The Ctrl+Shift+A keystroke was added to display only tagged records in Database views. It
complements Ctrl+A which displays all records. This allows rapid switching between viewing all
records and only those that have been tagged with two simple keystrokes.

Fields added:

o Redemption Fee Maximum Period: Expressed in days, it is the period that must pass for the

redemption fee to be reduced to zero (All editions and reports). See Redemption Fee .
o Asset Allocation Short-only Positions to complement Net positions (Pro Plus edition). See Asset

Allocation Breakdown .

After-Tax Returns added:
SEC tax-adjusted returns have been added to the Pro Plus edition for both Pre- and Post-Liquidation
scenarios aimed at comparing, ranking and filtering fund returns in a way that includes the effect of
taxation.  The "After-Tax Returns Comparison Analysis" report has also been added.  See After-Tax
Returns .

Y/N Fields added
The following Y/N fields were added to the professional editions to facilitate filtering: Leveraged Fund,
Inverse Fund, Dividend Yield Fund (for ETF's).  See Fund Characteristics .

Category changes:
o Added new Sector Stock broad asset class: 14 categories were moved from U.S. Stock,

International Stock, and Alternative broad asset classes into this new broad asset class
o Added India Equity, Foreign Small/Mid Blend, Target-Date 2046-2050 categories
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o Replaced Target-Date 2050+ with Target-Date 2051+ category

o Re-launched the Muni Single State Short category

o Renamed Muni Short to Muni National Short

New Rolling Returns Graphs
The Rolling Returns graph displays 1, 3, 5, and 10-year returns for quick, yet powerful comparisons. 
You can select to display either Average or Total returns.  There is also a Rolling Returns graph for
short-term periods displaying 1, 3, 6, 9 and 12-month returns.  Besides using these stand-alone
graphs, you can change any graph on any built-in or customized report to the Rolling Returns types.

Import Symbols text files
This feature allows you to import text files with securities symbols into the system.  You can now
import special mutual fund groups or portfolios that you can then save as Securities Groups (which
can be easily used as conditions in Filtering) or save as Portfolios. See Import a Symbols text file
.
"Record Pools" are now referred to as "Securities Groups" system-wide.

New Fixed-Income Sectors & Super Sectors :
These new classifications can help investors and investment professionals easily compare and
understand the sector exposures of each portfolio. The data is especially useful for comparing two
investments that may be in the same category.
Expense Ratios and 12b-1 fees are now provided with three decimal places for greater accuracy
when comparing fund costs.

Added comprehensive "Risk-Return Comparison Analysis" landscape report (Pro Plus): It allows the
easy comparison of risk and return of multiple funds and benchmarks at the same time.
Graph Options: Easily change the automatic benchmark for Performance, Growth and Risk/Return
graphs

Risk/Return Graphs: 1) Now the user can graph any risk measure in the database: Standard
Deviation, Downside Deviation , Upside Deviation , Semi-standard Deviation, Loss Deviation,
Volatility, Beta.  2) The user can also select any rolling time period: 1, 3, 5, 10, 15, or 20-years.  3)
Beta Risk/Return graphs and improved reports have been added.

Personal edition: Annualized Standard Deviation and monthly data for graphs for the last 10 years
have been added.

Post Modern Portfolio Theory  statistics columns for 1, 3, 5, 10, 15, and 20 years, and "Risk
Analysis" report added to the Pro Plus edition. They include Sortino Ratio , Information Ratio ,
Upside/Downside Capture Ratios, Tracking Error, Batting Average , Relative Risk, Percent Of
Positive Months, Downside Deviation , Upside Deviation , Semi-standard Deviation, Loss
Deviation, Skewness, Kurtosis.

Equity Style Complete Breakdown  columns, graphs, and "Equity Style Analysis" report added to
the Pro Plus edition.

Category changes: Replaced Long/Short with Long/Short Equity. Added: Managed Futures,
Multialternative, Volatility, Trading-Leveraged Commodities, Trading-Inverse Commodities, Trading-
Leveraged Debt, Trading-Inverse Debt, Trading-Leveraged Equity, Trading-Inverse Equity, Trading-
Miscellaneous.  See "Investment Categories " for their definitions.

New Equity & Fixed-Income Sectors & Super Sectors:
The new sector structure allows more intelligent sector analysis and diversification when constructing
portfolios.  The Personal edition includes the new Top 10 Sectors, while the Professional and Pro
Plus editions now also include the complete equity and fixed-income sector and super sector
breakdowns, allowing those to be automatically calculated by user-created portfolios. All new fields
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are available for all operations including ranking, filtering, graphing, exporting, etc.  See "Equity
Sectors " and "Fixed-Income Sectors ".

Top 10 Countries breakdown and graph is now included for all funds in the professional editions as
well.

New reports & graphs: The Fund Allocation Analysis & Portfolio Allocation Analysis reports have
been added and several other reports have been updated. Graphs for Equity & Fixed-Income
Sectors and Super Sectors have been added. The graphing options have also been upgraded.

Automatic Updating of installed program and database files: Now, if there is an update to the
software or data after the initial publication of an issue, Steele Expert will notify you and will
download, install and restart the program.  This way you are ensured to have the latest version of
the Steele software and data that is installed on your computer.

Added new fields to the Professional & Pro Plus editions:

Oldest Share Class (Y/N): It identifies whether this is the oldest share class for a mutual fund.
This allows users to evaluate a series of multi-class funds by looking at one representative share
class for each unique portfolio. You can add this condition to your filter to ensure that it only
contains unique mutual fund portfolios. If several classes of the same fund were started at the
same time, only one of them is designated as the oldest share class.

Oldest Share Class Security ID: The Security ID of the oldest share class for each mutual fund.
This allows users to evaluate a series of multi-class funds by identifying  all the share classes that
are represented by the same unique portfolio.

Investment Category changes: Added Aggressive Allocation, China Region and Market Neutral
categories. Removed Muni Single State Short category. You should review any filters that contain
categories as they may be affected by these changes.

The user interface has been revamped.

The "Quick Filter" feature has been added as a toolbar button (lightning bolt) and to the Filters
drop-down list.  It allows you to click first on any cell value in the database (spreadsheet) display,
and then click on the "Quick Filter" button to instantly filter the database by that value.  See 
Quick Filter .

Now you can rapidly select many columns to display or hide on the "Database Options" dialog
box by using the Spacebar key. See Database | Choose Columns to display .

Upgraded Growth Graph Options for Hypothetical Illustrations:
1) They can now use an additional user-supplied annual rate of return applied to the investment
each interval (yearly, quarterly, monthly).  This rate can represent additional investing based not
on a fixed amount, but an amount based on a rate such as the rate of inflation.  It can also be
negative to represent management fees of an advisor or the erosion of a forecast inflation rate. 
The annual rate will be converted to quarterly or monthly based on the selected interval.

2) Growth graphs can now be displayed on a Relative basis against any other benchmark, fund or
portfolio in the database.

To see the Graph Options dialog box, simply double-click on a stand-alone graph.  (If a graph is
placed on a report, enter "Design Mode" first so you can modify the objects on the report,
including report graphs).
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See Graph Options [Data]

New data added (and improved reports):
- Equity & Bond Style Boxes (See Style Boxes )
- Share Class (for easier filtering distinction among share classes)
- Since inception Average & Total Return (Pro Plus)
- Portfolio Date (See General Portfolio Information )
- Number of holdings in each fund portfolio
- Top-10 Holdings Percent
- Exact most Senior Manager Starting Date

Filtering Fund Characteristics (Y/N): ( See Fund Characteristics )
- True No-Load
- Systematic Withdrawal Plan
- Fund of Funds
- Index Fund
- Enhanced Index Fund
- Socially Responsible Fund
- Life Cycle Fund
- Hedge Fund
- Institutional Only
- Master-Feeder
- HOLDR

The Variable Annuities database has been very extensively upgraded with many new fields added.
Some user filters may need to be rebuilt due to the extensive field additions and changes.

New equity & fixed-income sectors, additional portfolio data for selected benchmarks, increased
decimal places in various fields such as Yield/Turnover, minimum load no longer supported.

Set any report or graph for Quick Access: Designate a page to go to when F7 is pressed, or when
a row is double-clicked in table (database) view.  See "Set page for Quick Access ".

Updated Up/Down/Full Cycle reports & graphs.

New Categories: Precious Metals was renamed to Equity Precious Metals.  Added Consumer
Discretionary, Consumer Staples, Equity Energy and Industrials.  Added six Commodities
categories: Broad Basket, Energy, Precious Metals, Agriculture, Industrial Metals and
Miscellaneous.  For descriptions see Investment Categories .  If you use categories in your
filters, you may need to reassign some of them.

Now you can place any .gif, .jpg, and .bmp image file on reports.  See Insert an Image (Logo) into
a Report .

Upgraded the Portfolio environment dialog and Portfolios management.

Upgraded the Filter environment dialog and Filters management.

Variable Annuities: Added Category Averages to the database and to all graphs, added Star
Ratings, and 1-Year ABCDE Ratings, and updated the VA reports to include the Star Rating.

To be able to see the changed VA reports, you should create a new Notebook, which will
automatically contain all built-in reports, and then copy your own reports into it. When we make
improvements and additions to the standard reports, graphs and settings, this is the method to
take advantage of them. See "Copying a Page or a Folder ".
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Share portfolios, filters, securities groups, user notes with others.  See How to share portfolios,
etc.

Steele Expert now sets up a dedicated user data folder where all user-created data reside.  Its
default name is "Steele Expert" and it is located under "My Documents" in Windows XP or
"Documents" in Vista.  All user-created files are now found there.

(You can see it in Steele Expert by clicking "Menu/Pages/Global Options/Settings/Change the
User Data Folder".  If you change the user data folder, all your notebooks will be closed and you
will have to open a notebook again or create a new one by clicking "Menu/File/New notebook /
Select Database...".)

See also Backup Your Data , Transfer to Another Computer , Global Options .

The Open & Save As dialog boxes default to the user data folder.

Several Categories have been renamed/changed/added.  You may need to review any filters that
use Categories.  See Investment Categories .

An upgraded User's Guide in pdf format can be found in the "Support" section of the Steele
website at www.MutualFundExpert.com.

New File menu command to save Portfolios, Filters, Security Groups, and Global Options without
having to wait until you exit the program. That way your data can be saved at any time, in case
there is a Windows system crash.

The "New Notebook" dialog box remembers the last folder and database name used.

The Copy command (Ctrl+C) will now copy the current cell in Database view, if no records are
tagged. If there are tagged records, they will be copied instead. To paste in another application
such as Excel, use the Paste command (Ctrl+V).

All color settings for all graphs, reports, tables and the user interface can now use any of the
millions of colors available under Windows for full creative control in customizing graphs and
reports.

Changed the quick "Find" function to be able to easily search the most commonly searched
columns in Database views such as Name, Symbol, etc.

Changed the full "Find" function to also display a search column drop-down list for more intuitive
and flexible searches. It is accessible by pressing Ctrl+F or clicking on the magnifying glass
button in the middle of the toolbar.

The Variable Annuities database now includes a view sorted by Company/Product/Fund to
facilitate finding sub accounts.

Added new toolbar buttons to quickly switch among Report viewing modes: Page Width, Full
Page, and 100%.

Added the capability to use half font sizes, e.g., 8.5 instead of just 8, 9, 10, etc. and improved the
font selection dialog boxes.

Added message that the program will not run under Windows 95/98/Me/NT: The program needs
Windows 2000, XP, or Vista.

New softer colors used as defaults in the application and added for use in program settings,
graphs and reports.

To be able to see all the new color scheme changes, you should create a new Notebook, which will
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automatically contain all new objects and settings, and then copy your own reports into it. When we
make improvements and additions to the standard reports, graphs and settings, this is the method to
take advantage of them. See "Copying a Page or a Folder ".72
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3 Did You Know That You Can...

Copy Pages and Folders

You can copy pages between Notebooks. Choose the page you wish to copy, and then select from the
menu Edit...Copy or press Ctrl+C. Now, go to the destination Notebook and select Edit...Paste or
Ctrl+V. The Expert will copy the page into the Notebook. The new page will be an identical copy that
you can change without modifying the original.

See Copying a Page or a Folder .

Customize Full-Page Reports

You can change a report to look exactly the way you like. Click the Design Mode button on the tool bar
to put the Report into design mode. Now click any object on the report and you will see small “grippers”
appear around the object. You can use them to move or resize the objects with the mouse. Any text,
table or graph on a report can be moved, resized or deleted. Double-click on any object to change its
properties.

Copy Graphs And Reports Into Other Applications

You can copy your favorite Graphs and Reports from the Expert into your spreadsheet or word
processor. Select Edit...Copy. Now switch to the other application, for example Microsoft Word, and
select Edit...Paste Special. Choose the “Picture (Enhanced Metafile)” format and select OK. You may
resize the image as you wish.

Lock Securities In A Page

You can keep the same securities in a page permanently by clicking on the Lock button. Normally the
Expert will transfer the tagged records into a Report or Graph automatically. If you wish to keep the
same records in a Page even after moving to a different Page, click on the Lock button on the button
bar. The same securities will remain in the Page until you change them manually with the Options
dialog box.

Compare Portfolios

We have a new Portfolio Comparison report. Just tag two “portfolio” funds and click on the “Portfolio
Comparison” page. The portfolios are shown side-by-side along with performance numbers and graphs.
If you want to change the value in a portfolio, click on the Design Mode icon to be able to edit the
report. Then just hold down the Control key and double click on the number you want to change, type
in the new value and hit "Enter". The report will be updated automatically.

Rank By More Than 1 Column

You can rank by more than one column at a time in a Database View. First, double-click on the column
for the primary rank. Next, hold the Control key and double-click on the next column you wish to rank
by. You can rank by up to 5 columns at once. Remember the secondary column only comes into play
if there is a tie in the first column and so on... See Ranking Columns .

Rank Values In A Portfolio

You can sort a Portfolio by any column. In the Portfolio window, just double-click on the column header
and the funds will be placed in order according to the values in that column. If you want to manually
rearrange the funds, type Ctrl+Shift+  to move a fund up or down in the portfolio view. This will not
affect the calculations.
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4 License Agreement

License Agreement

This software product is the property of Steele Systems, Inc. (Steele Systems) and is protected by
both United States copyright law and international copyright treaty provisions. If you choose to use this
software, you agree to all the terms and conditions of this license statement and Limited Warranty.

You may copy this product onto a computer for your own use, and you may make additional copies
ONLY for archival/backup purposes in order to preserve the product in case your original software is
lost or damaged. You may make more than one copy for your own use, as long as there is no
possibility that the software may be in use by more than one person at the same time. Any other
copying or distribution of this software or data is prohibited. Please contact Steele Systems for fees
and conditions regarding multiple-user site licenses, or for use on a computer network, or if you intend
to distribute more than 10 copies of reports or data included in this product, as such uses are not
covered by this individual license.

Distribution of any output from the product is limited to your internal use only, and use on an ad hoc
basis, including showing output such as reports to your clients. Any exported data is considered output
from the product and may not be resold. It may only be used internally with a standard, commercially-
available, third-party program, only if you require use of a function that is not available in this product
and the exported data are limited to the data necessary to use such function. Exported data shall not
be used in any other third-party software program, application or database or in any user proprietary
software, application or database. Output from this product may not be used in any kind of advertising
or included in websites or other mass communication vehicles or formats, including, but not limited to,
advertisements.

Certain of the information contained in the product: (1) is proprietary to Morningstar Inc. and/or its
content providers; (2) may not be copied or distributed; and (3) is not warranted to be accurate,
complete or timely. Steele Systems, Morningstar and its content providers are not responsible for any
damages or losses arising from any use of this information. Past performance is no guarantee of future
results.

You may transfer all your rights to use this software to another person, provided that you transfer to
that person, or destroy, all copies of the software and its documentation (including but not limited to all
copies on hard disks, CDs, diskettes, any electronic or other media, and all back-up copies). Any
person who agrees to receive all your rights to use this software, also agrees to all the terms and
conditions of this license statement and Limited Warranty. Except as specified in this paragraph, you
may not otherwise transfer, rent, lease, sub-lease, time-share, or lend the software, its CDs, electronic
media, or documentation.

Your use of this software is limited to acts that are essential for you to use the software on your
computer as described in the written and/or electronic documentation accompanying the product. You
may not otherwise modify, alter, adapt, merge, decompile or reverse-engineer our software, and you
may not remove or obscure our copyright or trademark notices.

Governing Law And General Provisions

This license statement shall be construed, interpreted, and governed by the laws of the State of
Nevada. If any provision of this statement is found void or unenforceable, it will not affect the validity of
the balance of this statement, which shall remain valid and enforceable according to its terms. If any
remedy provided is determined to have failed of its essential purpose, all limitations of liability and
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exclusions of damages set forth in the Limited Warranty shall remain in full force and effect. This
statement may only be modified in writing signed by you and an authorized officer of Steele Systems.
All rights not specifically granted in this statement are reserved by Steele Systems.

Limited Warranty

If you use this product, you agree to accept the software and the accompanying data on an "as is"
basis. You assume responsibility for the use of this software and application of the included information
to your own purposes. Although the data accompanying this software is supplied to Steele Systems by
sources we believe to be reliable, Steele Systems does not warrant the accuracy of any original or
calculated data. The data included in this product is intended only for your initial reference. The only
source you should rely on for mutual fund information of any kind is the prospectus of each mutual
fund, which you should obtain and read before you make any mutual fund purchase.

Steele Systems warrants the physical aspect of this product to be free of defects in materials and
workmanship for a period of thirty days from the date of purchase. If Steele Systems is notified within
the warranty period of defects in materials or workmanship, and Steele Systems determines that to be
correct, Steele Systems will replace the defective CD. Please do not return anything to Steele
Systems before being authorized to do so by Steele Systems customer support department.

The entire and exclusive liability and remedy for breach of this Limited Warranty shall be limited to the
replacement of defective CDs and shall not include or extend to any claim for or right to recover any
other damages, including but not limited to, loss of profit, data, or use of the software, or special,
incidental, or consequential damages or other similar claims, even if Steele Systems has been
specifically advised of the possibility of such damages. In no event will Steele Systems liability for any
damages to you or any other person ever exceed the actual price paid for the license to use the
software, regardless of the form of the claim.

Steele Systems, Inc. specifically disclaims all other warranties, express or implied, including but not
limited to, any implied warranty of merchantability or fitness for a particular purpose. Specifically,
Steele Systems makes no representation or warranty that the software is fit for any particular purpose
and any implied warranty of merchantability is limited to the thirty-day duration of the Limited Warranty
covering the physical CD only (and not the software) and is otherwise expressly and specifically
disclaimed.

This limited warranty gives you specific legal rights; you may have others which may vary from state to
state. Some states do not allow the exclusion of incidental or consequential damages, or the limitation
on how long an implied warranty lasts, so some of the above may not apply to you.
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5 Expert Basics

5.1 Getting Help & Data Definitions

You can get help by pressing F1 or by clicking on the question mark on the right side of the tool bar.

The Expert has context-sensitive help. This means that when you access help, the Expert presents
you with information that is related to the activity that is currently on-screen. For instance, if you want
to find out what Beta means select the column header named “Beta 3-Year” and press F1; the context-
sensitive help pops up.

If you want to find out how a specific menu command works, pull down the menu, highlight the
command you want and press F1 to view context-sensitive help on that operation.

 

5.2 Cursor Movements

In addition to cursor movements, you can also use the scroll bars to change what is visible on-screen,
but the cursor remains fixed.

A Database View can be quite large! It can consist of more than 20,000 records and can have over 700
columns of data. All this data won’t fit on the screen at one time so we need a way to navigate the
View. The table below lists the keystrokes used to move the cursor through the View.

Location Keys to use

Left one column Left Arrow ( )

Right one column Right Arrow ( )

Down one row Down Arrow ( )

Up one row Up Arrow ( )

Left side of View Home

Right side of View End

Left one window Ctrl+Left Arrow ( )

Right one window Ctrl+Right Arrow ( )

Top of View Ctrl+Home

Bottom of View Ctrl+End

Move to next tagged fund Ctrl+Up/Dn Arrow ( )

KeySearch movement allows you to move to any column in the View quickly. Pressing any individual
letter or number moves the cursor to the next column header that begins with that letter or number. If
there is more than one column header beginning with that character, subsequent key presses move the
cursor through all of them, in a circular fashion.

For example, if you want the “3-Year Average” column shown on-screen, type the number 3. If the
cursor first moves to a different column that begins with the number “3”, press 3 again, and again if
necessary, until the cursor is moved into the desired column.
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5.3 Invoking Commands

For most commands, there are multiple ways to invoke the command (through a menu selection, by
selecting a toolbar icon, or by pressing shortcut keys). To invoke a command using the menu, pull
down the appropriate menu, and select the command you want to invoke. This can become tiresome
for commands that you use repeatedly; the solution is toolbar icons and shortcut keys.

The toolbar provides quick mouse access to the most frequently used Expert functions. Selecting
(clicking on) the toolbar icon invokes the command without having to select the item from the menu
(such as selecting the Find toolbar icon).

Shortcut keys provide quick keyboard access to functions. You’ll notice that next to some of the
commands in the menus, there are shortcut key definitions (such as Edit...Find Value [menu selection],
Ctrl+F [shortcut key definition]). To invoke a command using shortcut keys, press both keys
simultaneously.

 

5.4 Navigating Pages

The Expert contains Notebooks that consist of Pages.

Anytime you choose to create a new Notebook, you are presented with the default Page List.
Depending on the size and resolution of your monitor, you may or may not be able to see all of the
Pages available to you in a Notebook. If the list is longer than the screen, you can use the Page List
scrollbar or the Page menu item to see more Pages. When you double-click on the name of a Page in
the list or select the name from the menu, the Expert displays the contents of the page on-screen.
Notice that the currently selected Page is highlighted in the list.

Because all monitors are not created equal, we’ve included a way for you to expand your screen real
estate by hiding the Page List, simply click on the Pages Outline toolbar icon or choose Pages...Hide

Page List from the menu.

To go to the last selected page, the one you were viewing before you switched to the current one, click
on the Go to Last Page icon on the toolbar or press Ctrl+Backspace.

 

5.5 Reports

The Expert contains a powerful Report editor, with features similar to desktop publishing programs. The
Expert comes with pre-defined Reports, including the Fund Detail Report and the Ranks & Averages
Report. Both of these Reports were created using the Expert features.

The Report can be thought of as a virtual "page" on which you place Tables, Graphs and Text Boxes.
Every object on the page is independent, yet they may be grouped together visually to produce stylish
effects. Every object maintains its own font, colors, options and data. To create a new report select 
Pages...New...Full-Page Report, enter a unique name for the Page, and then add objects to the page.

 

5.6 Graphs

The Expert contains powerful graphing features that allow you to visually compare the performance of
the securities that interest you. You may combine as many as 16 securities and benchmarks together
in one graph to track the performance of an entire portfolio of securities.

Graphs may be viewed in a Page or in a Report  that you create.74
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To create a graph

Select Pages...New...Graph.

The Graph Options  dialog box appears. Select OK.

You can also place graphs on Full Page Reports by entering Design mode and then choosing from the
menu Pages...Insert Object...Graph.
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6 How To...

6.1 Load the Database

The first time you load the Expert, you are presented with the Create New Notebook  dialog box. This
dialog box lists the database files you have installed in the program folder. The Expert will load the
database you select and show its contents in the Database view Page.

Also see File > New notebook / Select Database...

In the future, when you load the Expert, if you exit without closing all Notebooks, the Expert will load
any open saved Notebooks automatically. If you closed all Notebooks, you will need to either create a
new Notebook or open a Notebook you have previously saved.

6.2 Find a Security by Name or Symbol

1) Simply click in the “Find” text box above the column headers and start typing the name of the fund.
As you type, the Expert will instantly put the fund name matching what you are typing on the screen
and highlight it. Then, click on any Detail Report.

(The database should be sorted by the "Name" column (which is the default sort order) for this to
function effectively.  To sort the "Name" or any other column, simply double-click its header.)

To search by symbol select "Symbol" from the "Find" drop-down list.

2) Alternatively, for more flexible searches you can use the full Find command by clicking on the
toolbar button with the magnifying glass or pressing Ctrl+F. (You can also click on "Menu > Edit >
Find".) The "Find" dialog box will appear where you can customize your search and click on the "Find"
button. The Expert searches for the first instance of the value you entered and the fund appears
highlighted on the screen.

 

6.3 View a Fund Detail Report

1. Highlight the fund that interests you.

2. Select the Fund Detail Page from the Page List.

3. Use the scrollbar or PgDn to view the bottom half of the report.

Click on the “Hide the Page List” icon on the toolbar to enlarge the report and view its text better. All
reports are optimized for printing by most popular printers.

 

6.4 Compare 2 or more Securities or Portfolios

To view a report or graph in the "Report Templates" list for a single security (or a portfolio of securities),
click on the row of that security in any tabular view, such as the "Database" view, and then click on any
report or graph on the left of the screen in the "Report Templates" list. To create a portfolio see Creating
a Portfolio .

In order to view and compare multiple securities (or portfolios) on the report and graph templates in the
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"Report Templates" list, you need to tag  (select) those records in any tabular (spreadsheet) view. To
tag records simply click  on their row number. This will mark or unmark them with a red triangle, if they
are already tagged.

After you have tagged (selected) the records in a tabular view that you want to compare, click on any
report or graph template on the left of the screen in the "Report Templates" list. The system will
automatically display all the securities or portfolios you have selected (up to 16) on the report or graph
template providing instant comparison. You can continue to click on other templates to view different
types of comparisons based on different data and statistics.

Note: When you have tagged multiple records, the security or portfolio that is highlighted in the tabular
view will be the "main" security that will populate the report while the rest of the tagged records will be
added to any graphs and comparison tables on the report template.

6.5 Use Portfolios, Securities Groups & Filters

This section describes the differences among user-created Portfolios, Securities Groups, and Filters,
and when to use them.

They are some of the various ways the system provides for grouping and isolating securities such as
mutual funds and/or benchmarks.  You can create as many portfolios, securities groups and filters as
you want.

All portfolios, filters and securities groups can be instantly invoked to filter any database view (tabular
view) by selecting them from the "Filters" drop-down list that is above the column names in all tabular
views.  They are saved separately from notebook files that store the visual settings of all tabular views,
single-page reports, stand-alone graphs, and the contents of the "Pages List" on the left of the screen.
All portfolios, filters and securities groups are available to all notebooks you may create or open.

You can fully manage your portfolios, filters and securities groups by renaming, deleting or copying
them.

Tip: To ensure that all portfolios, securities groups and filters you create or modify in session are saved
to disk, select "Menu > Save Portfolios/Filters/Groups/Global Options".  You will be asked to save
them before exiting the program anyway, but this way you can force them to be committed to disk, in
case something crashes your system.

However, there are differences in their properties and capabilities.  These are guidelines to the "best
practices" as to when to use each one.

Portfolios

You need to create a portfolio when you want to be able to view aggregate statistics on the included
securities as a whole, and compare them to other securities and benchmarks.  Once you create a
portfolio, it appears as a any other record in the database (with an asterisk in front of its name) and you
can compare it easily to any other security, benchmark, or other portfolio.

Also, you can put benchmarks or averages in a portfolio in percentages that you choose, thus creating
you own benchmarks that you can then use in any kind of comparison including on graphs, ranked
tabular views and reports.  It is a great way to create your own benchmarks that are appropriate for
performance comparisons specific to your purposes.

One of the easiest ways to create a new portfolio is to tag records in Database view (by clicking on
their row number) and then selecting "Menu > Portfolio > Create New Portfolio...".  The system will put
all tagged records in the newly created portfolio.
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Securities Groups

You can create a securities group by tagging the row number of records that you want grouped
together, and then saving them as a group under a name that you specify. (Menu > Database > Save
Tagged Records as Securities Group...)

Securities groups are ideal for gathering any set of securities into a group that you can then use to
filter any tabular view.  Securities groups can be used as conditions in the Filtering environment so you
can test for membership or exclusion in a given securities group in combination with other conditions. 
Such groups may represent sub-universes of the database that you may want to be selecting securities
from, or the opposite, avoiding securities in a certain group.

Filters

Filters are created and saved in the Filtering environment. (Menu > Database > Filter the Database...)

They are appropriate for isolating securities based on conditions and criteria you specify.  A very
powerful feature of the system is that you can use in a filter that you create existing securities groups
and other existing filters as conditions that can test for either inclusion or exclusion.

6.6 Create and e-mail PDF files of Steele Expert reports

In order to create a .pdf document you need to have PDF writer software installed on your computer. A
PDF writer is installed as a printer driver on your computer. Simply choose it as your printer before
printing any document, and then print. Instead of actually printing, it will prompt you for a name for the .
pdf file you want to save. You can then, e-mail that file to someone who will only need a PDF reader to
view it.

For a free PDF writer, you may go to www.CutePDF.com.

Adobe PDF Reader is free, but Adobe Acrobat PDF writer is not. Both are available at the Adobe web
site at www.Adobe.com.

After creating a .pdf file of any Steele Expert report or graph, you can attach it as a file and e-mail it to
someone.

To do that, you can simply choose any report in Steele Expert and try to print it. When the "Print"
dialog box appears, choose as the Printer Name the name of the PDF writer, for example, "CutePDF
Writer", and click on OK to print. The PDF writer will then create a .pdf document that anyone can read
if they have Adobe Reader or any other PDF reading software.

 

6.7 View the Ranks & Averages Report

1. Highlight the fund that interests you.

2. Select the Ranks & Averages Page.

3. Averages are available on the Performance Report. The averages are based on the funds listed in the
last View that was on-screen.

4. Use the scroll bar to view the bottom half of the report.

The Ranks & Averages Report is calculated using all funds that were in the last Database View that
was on-screen. You may filter a Database view to compute the Ranks & Averages of a specific group of
funds, such equity only, or no-load only funds.



How To... 39

© 2024 Steele Systems, Inc.

 

6.8 Print the Current Page

1. Select the Print command by clicking on the Printer toolbar icon. The Print dialog box appears. If it
is a Database view, choose carefully the number of pages you want printed.

2. Select OK.

6.9 Copy or move a Page or Folder

See Copying a Page or a Folder

 

6.10 Copy or Move Objects & Data

Copying Records From a Database View For Use in Another Application

You can use the copy command to copy records in a View to the clipboard. This data can then be
pasted from the clipboard into another Windows application. To copy records in a View to the clipboard,
select Edit...Copy or press Ctrl+C. The currently selected fund will be copied unless there are tagged
funds; in which case, only the tagged funds will be copied to the clipboard. All columns in the current
View are copied to the clipboard. Open the receiving Windows application and paste the data into it.

Making a Copy of a Page

To copy the entire contents of the current Page to the clipboard, select Edit...Copy or press Ctrl+C. The
current Page will be copied to the clipboard. To paste the Page, open the Notebook in which you want
to insert the Page, and select Edit...Paste Special. The Paste Special dialog box will appear. Choose to
paste the Page Into This Notebook and select OK. The copied Page will appear as the current Page with
a default name derived from the Page type.

Transferring Funds Between Pages and Portfolios

The Expert gives you the ability to transfer a lists of funds from one location to another. This allows for
an easy way to copy a list of funds from a Portfolio to a Page or vice versa. To copy funds from a 
Portfolio box, select the Copy button. All funds will be copied to the clipboard.

These copied funds may then be pasted into a Page or another Portfolio box. To paste funds in a 
Portfolio box, select the Paste button. To paste funds in a Page select Edit...Paste Special. The Paste
Special dialog box will appear. Choose to paste the Funds Into current Page and select OK. When you
paste funds into a View, the View will contain only the pasted funds. Funds pasted in a Report or
Graph Page become the base funds.

Copying Objects to a Report

You can select objects on a Report (such as a tables , graphs, or text boxes) and copy and paste
them to a new Page. You can also copy a Graph from a Graph Page and paste it on to a Report. To
copy objects select Edit...Copy or press Ctrl+C. The selected objects or the Graph (if you are copying a
Graph Page) will be copied to the clipboard. To paste the copied objects, select the Report Page in
which you want to insert the objects, and select Edit...Paste or Ctrl+V. The objects will appear on the
current Report Page.
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6.11 Backup Your Data

Backing up the data that is stored on your computer is important.

If your hard drive fails, if your data becomes corrupted, or if you delete data you need by mistake, a
backup will save you a lot of time that otherwise would have been spent recreating the same data
again.

You should backup your entire hard drive with backup software.

If you want to backup specifically your Steele Expert user data, you should backup the two folders
below:

1. User-created data 

As far as your Steele Expert user-created data are concerned, at a minimum you should backup
your User Data Folder.  Its default location is under "My Documents" for XP and under "Documents"
in Vista and later Windows versions and its default name is "Steele Expert".  (You can see it in
Steele Expert by clicking "Menu/Pages/Global Settings/Settings/Change the User Data Folder").

Below are some of the files you will find in the User Data Folder:
*.mem - User data files: They store all user memorized Portfolios, Filters, Securities Groups, and Notes.
*.exp - Notebook files: They store any changes you make to reports, graphs, database views.

2. Program Settings (Optional)

Your program settings can be found in the following folder:
Windows XP: "C:\Documents and Settings\<UserName>\Application Data\Steele Systems\Steele
Expert"
Vista & later: "C:\Users\<UserName>\AppData\Roaming\Steele Systems\Steele Expert"

Database files (*.db) are stored in the program folder and contain the investment performance data. 
They do not contain any user-created data.

You can reinstall these files from the self-installing updates you have downloaded and saved or from the
optional backup CDs.

6.12 Transfer to Another Computer

How to transfer Steele Expert user-created data to another computer

A user is allowed to download and install Steele Expert to a second computer that he owns, if it is, for
example, his desktop and his laptop, or a work  and a home computer. In other words a situation where
the software would not be used at the same time on the two computers.

Here are the steps to transfer/backup all your data created with Steele Expert from one computer to
another:

1. On your main computer, locate with File Explorer the Steele Expert user data folder. Its default
location is under "Documents" in Vista and later Windows versions and its default name is "Steele
Expert".  (You can see it in Steele Expert by clicking "Menu/Pages/Global Options/Settings/Change
the User Data Folder").
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To start File Explorer, right-click on the "Start" button on the bottom left of the screen and select
"File Explorer".

2. By using a flash drive, external hard drive, or any other media, or a direct/network connection copy
that folder (named "Steele Expert") to the same location on your second computer (under
"Documents" in Vista or later).

3. Optional: If you want to transfer your global program settings as well, copy the following folder from
one computer to the other:
Vista & later: "C:\Users\<UserName>\AppData\Roaming\Steele Systems\Steele Expert"

4. Install the latest program and database you have onto your 2nd computer.

5. Start the Expert program on your 2nd computer.  Especially if you are transferring between different
versions of Windows, you may need to change your User Data Folder by clicking "Menu/Pages/
Global Options/Settings/Change User Data Folder".  All your data and settings will have been
transferred.

6.13 Comply with FINRA

Brokers, financial consultants and planners who sell stocks, bonds, load mutual funds and/or variable
annuities are regulated by the Financial Industry Regulatory Authority (FINRA) (formerly NASD) as far
as advertising and sales materials they present to clients and prospective clients are concerned.

Typically, such materials are submitted by each broker-dealer’s compliance department to FINRA for
approval before they can be used by their registered representatives.

FINRA member firms do not have to file material that has been reviewed by FINRA and found consistent
with applicable standards.

The “Fund Detail (FINRA)” report included in the Professional and Pro Plus editions of the Expert (but
not in the Personal edition), has been found by FINRA to be consistent with their standards. This report
can be used as supplementary sales literature when accompanied by the fund prospectus and the
three Disclosure pages found in the Expert.

Before use, each firm must edit “Disclosure page 2” to replace the text “FINRA Firm Name” with their
company name. Also, the “Date of first use” of this report must be added to the same page as well as
the name of the firm that securities are offered through. These changes need to be made and saved
only once.

These are the only items that can and must change on this report. The data should be as of the most
recent calendar quarter to be compliant with FINRA rules. Therefore, this report should be used with a
database as of 3/31, 6/30, 9/30 or 12/31, whichever is most recent.

Compliance departments can obtain a copy of the FINRA review letter for this report for their files by
contacting Steele Systems at Support@SteeleSystems.com or via telephone.

FINRA compliance is the members' responsibility and this information does not constitute legal advice.
Any related questions should be directed to FINRA at www.FINRA.org or at (301) 590-6500.

Investment advisors who provide fee-based services and who do not sell securities, are only regulated
by the Securities and Exchange Commission (SEC) and can use all the graphs and reports of the
Expert in client presentations.

With Steele Mutual Fund Expert, almost any kind of report can be generated that will suit the exact
purposes of each financial sales professional.

All financial sales professionals can use all the reports and graphs of the Expert for their own mutual
fund research, analysis, and client portfolio tracking tasks.
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6.14 Rank a Column

1. Double-click on the column header of the column you wish to rank. The Expert will sort the column
and a green arrow will appear.

2. The arrows indicate whether the column is sorted in ascending or descending order.

3. A single green arrow indicates a primary rank.

 

6.15 Rank More Than One Column

1. You can also rank by selecting the column and clicking on the rank or rank add toolbar icon.

2. Double-click on the column header of the first column you want to rank. This performs the primary
rank.

3. Press the Ctrl key and double-click on the column header of the second column you want to rank.
The Expert will sort the column and two green arrows will appear.

To add another column to the rank, press the Ctrl key and double-click in the column header of the
column. You can rank up to five columns at one time.

 

6.16 Pick the Winners

The Expert can filter the top performing funds for you based on several main categories. The Expert
filters all funds that meet the criteria you have selected, ranks the funds according to the performance
measure you have selected, and then filters the percentage you have chosen.

1. Select the Winners toolbar icon. The Winners Wizard dialog box appears.

2. Select a Performance Measure. This is the numeric field used to find the performers.

3. Choose to view either the funds that performed the best or the funds that performed the worst for the
categories that you will choose.

4. Choose a Method. Choose whether you want funds from all the checked categories to be combined
as a group or each category to be a grouped together.

5. Pick the percentage of funds that make the cut. For instance, if you choose 5%, only the top 5% of
the funds (as indicated by the Performance Measure) will be shown.

6. Choose a memorized filter to add selection criteria. This ensures that the results of the search will
also match the conditions of the filter. If you want resulting funds to have no load, choose the No-
Load Funds filter.

7. Select a main Category. All funds shown in the View will match the category. Your choices are
Category, Objective, Fund Family, or Broad Category.

8. What appears in this list box depends on the category you chose. If you chose Broad Category,
then the available general types of mutual funds will appear in this box. You may select one or more
from this list box.

9. Select OK to see the top performers.
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6.17 Tag Records

1. Click on the record number of the security you want to tag. A red triangle will appear.

2. To tag multiple sequential records, click on the first record number and while holding the left mouse
button down drag over more row numbers until you have tagged all the sequential records you want.

 

6.18 Show Only Tagged Records

1. Tag the desired records by clicking on their row number, or pressing the space bar key.

2. Select "Menu > Database > Show Only Tagged Records". You can also press Ctrl+Shift+A.

6.19 Show All Records

From the Filters drop-down list choose “All records”. Or select "Menu > Database > Show All
Records". All the records in the database will be displayed. You can also press Ctrl+A.

6.20 Untag All Records

Select "Menu > Database > Untag All Records".

6.21 Create a Securities Group

Securities Groups are handy for records that you view on a regular basis, but cannot be easily filtered
in order to be isolated.

To create a securities group:

1. Tag the records that you wish to include in the Securities Group.

2. Select "Menu > Database > Save Tagged Records to Securities Group". The Enter a Name for
This Securities Group dialog box appears.

3. Enter a unique name for the Securities Group.

4. Select OK. The Securities Group is saved for future use.

To delete a Securities Group:

1. Click "Menu > Database > Open/Manage Securities Groups...".

2. In the dialog box that appears, select the securities group you wish to delete and click on the
"Delete" button.



STEELE Mutual Fund Expert44

© 2024 Steele Systems, Inc.

6.22 Open & display a Securities Group

To display a securities group:

1. While viewing a database, select "Menu > Database > Open/Manage Securities Groups".
The Open a Securities Group dialog box appears.

2. Select the name of the securities group you want to display.

3. Select OK. Only the records that were saved in that Securities Group appear on the screen.

To delete a securities group:

1. Click "Menu > Database > Open/Manage Securities Groups...".

2. In the dialog box that appears, select the securities group you wish to delete and click on the
"Delete" button.

 

6.23 Combine Securities Groups

The most efficient way to combine two or more securities groups of tagged records is to use the
Filtering environment.

1. Click on “Menu > Database > Filter the Database…” and add each securities group as a
condition. The second and subsequent conditions should be “OR” conditions which is the default.
Then click on “Run Filter” and the funds in all the included securities groups will be displayed.

2. Click on “Menu > Database > Tag All Records” and then click “Menu > Database >  Save Tagged
Records to Securities Group...” to save the combined securities group under a new name.

6.24 Import a Symbols text file

This feature allows you to import text files with securities symbols into the system. You can import
special mutual fund groups or portfolios that you can then save as Securities Groups (which can be
easily used as conditions in Filtering) or save as Portfolios.

To accomplish this, follow these steps:

1. First, create a simple text file that has a single mutual fund or stock symbol on each line. Such a file
can be created with Notepad or any word processor that can save simple text files with file extension
.txt.  Such a text file may also be created by exporting from a program like Excel, Access, or any
custom application.

Note: It is very important that the text file is saved as a plain text file (with ANSI encoding). If it is
saved with Unicode encoding, the 2-byte characters in that format will prevent the proper import of
the file. When saving a text file with Notepad, simply choose ANSI encoding at the bottom of the
Save dialog box.

2. Then, in the Expert, click on "Menu > File > Open notebook". Once the "Open" file dialog appears,
at the bottom of the dialog select from the "Files of type:" drop-down list "Tab Delimited (*txt)". That
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will display only the files with file extension .txt in your Steele Expert data folder. You can navigate
to the text file you want to import and open it.

3. You will then be prompted to open a database file in which the Expert will look to match the symbols
in the text file. Open your most recent database.

4. The Expert then scans the symbols text file, and displays and tags only the matching database
records.

5. You can then save all tagged records as a Securities Group by clicking "Menu > Database > Save
Tagged Records as Security Group".

6. If you want to save the tagged records as a Portfolio, create a new portfolio, which will import all
tagged records into the new portfolio automatically. To do that, click "Menu > Portfolio > Create New
Portfolio...", enter a name for the portfolio and click "OK".

7. To save these to disk , click  "Menu > File > Save Portfolios/Filters/Groups/Global Options".
(You do not need to save the temporary notebook used to tag the funds.  To create a new notebook
with all the built-in templates, click "Menu > New notebook > Select Database...".)

8. Your new securities group and/or portfolio will now appear in the "Filters" drop-down list that is above
the column headers in any tabular view like the "Database" view.  Selecting the security group or
portfolio from the "Filters" list will display instantly only those records.

9. TIP: Note that securities groups can be included as conditions in the Filtering environment so you
can restrict any additional filtering conditions to select records only from a specified securities group.

6.25 Change Colors

You can alter the colors used in Views, Graphs, and objects appearing on Reports. Color selections
appear on the Display tab of the Options dialog box. Changes made affect only the current Page.

There is also a global option available for assigning colors and patterns to the bars (or lines) used in
Graphs. Select "Menu > Pages > Global Options...". When the Global Options dialog box appears,
choose the Graph Colors tab.

 

6.26 Exit the Expert

Whenever you load the Expert, the program loads in the same state that it was in when you last exited
the program. If you close all notebooks prior to exiting the program, the next time you start the Expert,
you will need to open your notebook by choosing "Menu > File > Open notebook" and selecting your
notebook, or choose Menu > File > New notebook / Select Database" to open a new notebook.

If, however, you exit the program without closing your Notebook, the next time you load the Expert,
your Notebook will be automatically opened. To exit the Expert so that your Notebook will be
automatically opened the next time you use the Expert, choose one of the following methods:

1. using the menu - File > Exit,

2. using the keyboard - Alt+F4,

3. or double-click in the small square in the topmost left corner.

If you are working on a new Notebook and you have not saved it, you will be asked whether you want
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the Expert to save the Notebook before exiting the program. If you select Yes, the Save Notebook As
dialog box will appear. Select OK to accept the default file name or enter a file name (the Expert will
assign the extension EXP to the file name) and select OK.
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7 Database

7.1 Database View

The “Database View ” Page displays the database in a row and column format (a View). As with all
Database Views, it is a template that can show all of the funds in the database or some subset of the
funds in the database. You can customize the View to fit your needs for on-screen display, printing,
and exporting.

Whenever you create a new Notebook, the Database View will be the first Page to appear on-screen. It
contains a listing of all funds or a subset thereof. You may also create your own Views by selecting 
Pages...New...Database.

Use one of the following methods to display the Database View:

press F5 (If already on the Database page, it will switch to the last viewed page for easy back and

forth between them),

or select Database from the Page List,

Views that you have customized can be copied into other Pages to allow for different views of the same
database.

 

7.2 Working with Database Views

The fund data that you see in a Database View is contained in the Database, not in the Database View
itself. This means that after you install an update, the fund data in the view will change but the column
sizes, order, font, margins etc... will remain the same. The Database View is simply the way in which
you look at the data in the Database, and you may have as many Database Views in a Notebook as
you like.

To create a new Database View

Select Pages...New...Database View/Tabular Report. You will see the Database View Options
dialog box. Select OK to create the new Page.

To see a definition for a column

Press F1 to see a Field Definition

To change the number of visible columns

Hide the current column. Type Ctrl+H .

Type Ctrl+T  and select the [Columns]  tab.

To change the number of visible funds

Filtering .

Tag  and hide specific funds.

To change the colors and font

Choose Database View Options
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To change the order of funds

Double click on a column header to Rank  it.

 

7.3 Columns

The complete database is presented in a View using rows and columns. Each column consists of a
column header (field name) and data for each record (fund). A column is selected by clicking anywhere
within the column (which causes the cursor to move to the selected column).

You can view a definition for any field name by selecting the column and pressing F1 or selecting the
Help toolbar icon. You can rank any column in a View. You can also edit (move, resize, hide, etc.) the
columns in a View.

The Columns tab in the Options dialog box allows you to select which columns to include in a View or
a Portfolio Table. Use one of the following methods to display the Columns tab for a View:

select Edit...Options,

or press Ctrl+T,

or select the Options toolbar icon.

The Options dialog box appears. Choose the Columns tab. Select the fields that you want to display
and select OK when you are done.

Locating the Current Column

The cursor highlights the current fund. The color of the highlight is black, unless you have modified the
cursor color. The selected column of the current fund is the same color as the background (it is not
highlighted).

Try the following so that you can learn to easily identify which column is selected. Select the first fund
in the database. The fund will be highlighted and one of the columns will be the same color as the
background. Click on the name of the current fund or click on the Name column header (the Name
column of the current fund now appears as the same color as the background of the database). Now,
select the Objective column by clicking on the detailed objective of the current fund or clicking on the
Objective column header (the Name column of the current fund is highlighted and the Objective column
of the current fund becomes the same color as the background).

Hiding Columns

To hide a column, move the cursor to the column you want to hide and use one of the following
methods.

select Edit...Hide Column,

press Ctrl+H,

or drag the column border all the way over to the left.

The column will disappear from the View. To retrieve the column, choose Edit...Reset Columns or select
the column in the Column tab of the Options dialog box.

You can use the same method to hide columns in an edit window on a Report.

Displaying Columns
The Expert allows you to select which columns (fields) you want to display in a View and which
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columns you want to omit. This can be handy when you are printing reports from a Database View or
exporting information to another application. To select which columns to display, use one of the
following methods:

select Options,

press Ctrl+T,

or select the Options toolbar icon.

The Options dialog box appears, select the Columns tab.

All Columns in Database Order

A check in the All Columns in Database Order box indicates that all columns are selected and
positioned in the original database order. To check or clear the box press Alt+D or click in the box. 

Selected Columns

When the All Columns in Database Order box is cleared, checkmarks appear next to the fields that
are selected to be displayed. If you do not want the field displayed, click on the field name and the
checkmark will disappear. You can also use the spacebar to select and deselect the field.

All

Selects all of the database columns and displays them in the View in any order.

None

Deselects all columns in the database. You must display at least one column in the View.

Another quick way to view all columns in their original database order is to choose Edit...Reset Columns

from the menu. This command restores all columns to their original order and width.

Resetting Columns

A menu item is available to reset all columns in the View to their original database order and size.
Select Edit...Reset Columns from the menu. The Expert will confirm that you want all columns reset to
their original order and width. Select OK to reset the columns.

Locking Columns

Locking a column ensures that the column will remain on-screen as you scroll to the right. When you
print a View that contains locked columns, the locked columns appear on the left side of each printed
page.

To lock a column, select the column, and then select Edit...Lock Column. Locked columns are placed
to the left of the first unlocked column and a darker column grid appears to delineate between columns
that are locked and those that are not. To unlock a column, select the column and select Edit...Unlock

Column from the menu.

Moving Columns

You can move columns around in a View. To move a column, click on the column and drag it to its new
location. The column you are moving will push the column it is dropped on to the right.

Column Width

You can resize the columns in a View; this is especially helpful if you have a small screen or want to
ensure all columns print on one page. Place your mouse cursor on the right border of the column
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header. You will see the column-width cursor appear. Click and drag the column border to any size you
want. Dragging the column size all the way over to the left will hide the column.

 

7.4 Databases

A database is a file that contains information for thousands of mutual funds and benchmarks. The
Expert uses Notebooks to display the database in the form of Database Views, Graphs, and Reports—
each of these is a type of Page. All Pages within the same Notebook utilize the same database.

Whenever you create a new Notebook, the Expert ties the Notebook to a database file name that you
select.

 

7.5 Tagging Records

You may tag or untag any record in the current view by moving the cursor to that record and pressing
the space bar. You may also click on the row number (at the left of the record) and drag it to tag as
many funds in a row as you like. Similarly you may hold down the SHIFT key while moving up and
down with the arrow keys. Tags are shown as a red pointer in the row number. Once you have tagged
the records you are interested in, you may do one of the following:

Move between tagged records

Use the Ctrl+(Up and Down) arrow keys to move through only records that are tagged.

Show only the records that are tagged

Choose "Show Only Tagged Records" from the Database menu. Your view will be reduced to only
those records that you had tagged.

Hide those records that are tagged

Choose "Hide Tagged Records" from the Database menu. Your view will be reduced to only those
records that were NOT tagged.

Saving a Securities Group

Choose "Save Tagged Records to Securities Group" from the Database menu. Enter a unique name in
the dialog box and press Enter. The Expert can store as many unique Securities Groups as you need.
You may recall the securities groups at any time to add or subtract records. You may also specify a
securities group as a Condition  in a filter.

7.6 Exporting Records to other software

To export data to an Excel spreadsheet simply click on the number of the row at the left of the data
display to tag each of the records you wish to copy into Excel.  See Tagging Records .  Then, click
"Menu > Edit > Copy" to copy them to the Windows clipboard. Switch to Excel and choose "Menu >
Edit > Paste" to copy the data into the spreadsheet.

This operation copies all the records and columns that you tagged in database view. You can reduce
the number of columns by using "Menu > Edit > Options" to choose which columns to display before
tagging and exporting.
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If this is a recurring task, the best way is to create a new tabular report ("Menu > Pages > New >
Database View > Tabular Report"). Then, choose "Menu > Edit > Options" and select only the columns
you are interested in exporting. You can then, choose to isolate the funds you want by either tagging
them and choosing "Menu > Database > Show Only Tagged Records", or by specifying their “ID
number”, "Symbol" or other identifier in the Filtering environment.

TIP: Before pasting into an Excel spreadsheet, you may want to format the entire first row of cells in
the range that will receive the column names as "Text" in order to ensure that all column names are
accurately interpreted by Excel as text and not anything else, such as dates or numbers.

You can also paste the data into Windows WordPad or other software.  The format is tab-delimited
text.

You can then save the file, if necessary, and create an import file to another database application.

If you have tagged any records, they will be copied with the Copy command. If there are no tagged
records, the Copy command will only copy the current cell of the data table.

 
Additionally, you can export tagged records directly to file via "Menu > Database > Export Tagged
Records...".  See Export Tagged Records to File .

The subsequent use of such exported data must follow the single user license of Steele Expert. See 
License Agreement . If you need to have the data be used by more than a single person, please
contact us at Support@SteeleSystems.com for a discounted site license.

7.7 Securities Groups

Securities Groups are a collection of securities stored under one name for easy retrieval. You may
create Securities Groups consisting of your favorite securities, a client’s securities, or a list of
commisionable funds. If you find yourself looking up the same securities every time you start the
Expert, then it is time you created and saved a Securities Group.

Tag all the records you want to included in the group. Select Database...Save Tagged Records to

Securities Group. Enter a unique name and select OK. The group of records is called a securities group
and it may be recalled/opened in a Database view or used in a Filter along with other conditions to
restrict your filtering to that universe.

Securities Groups with a red lock in front of their names are built-in Record Pools that may come
standard with the Expert. These cannot be deleted.

Displaying a Securities Group

To recall/open a Record Pool, select Database... Open/Manage Securities Groups. Double-click on the
securities group you want to use. You can also select it from the "Filters" drop-down list located above
the column names in Database view.  Your Database view will now contain only those records that
belong to the securities group. Any records previously tagged will remain tagged if they belong to the
recalled securities group.

Deleting a Securities Group
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To delete a securities group, select Database...Open/Manage Securities Groups, highlight the securities
group you want to delete, and click on the Delete button.

Modifying the record selection in an existing Securities Group

Records may be added to or deleted from a securities group you have previously created.

To modify the records in an existing securities group, recall the securities group and select Database...

Tag All Records. Then show all records by pressing Ctrl+A. Tag the records you want to add and untag
the records you want to delete from to your securities group. Select Database...Save Tagged Records to

Securities Group. Enter a new name for the Record Pool, or select OK to accept the same name as the
existing securities group and the Expert will overwrite it. You may not overwrite any built-in securities
groups.

7.8 Ranking

You may rank (sort) the funds by any visible column in the database. By default the funds are ranked
by “Name.” You may change this by ranking a different column. Columns can be ranked in either
ascending or descending order. The default ranking for numeric columns is descending. The default
ranking for alphanumeric columns is ascending.

You can rank up to five different columns at a time; the initial ranking is considered a primary ranking.
To perform a primary rank, use one of the following methods:

select the column and then select Edit...Primary Rank,

double-click on the column header,

or select the column and then press Ctrl+R,

or select the column and then select the Rank toolbar icon.

The Expert ranks all funds by the values in the selected column. Tagged funds remain tagged . If you
want to see the funds ranked in the opposite order, select Edit...Rank Column Ascending/Descending.
You’ll notice that a green arrow appears in the top left-hand corner of the column header; a single arrow
indicates a primary ranking, the direction of the arrow indicates an ascending sort (up arrow) or a
descending sort (down arrow).

To perform additional ranks - columns that rank within the primary rank - use one of the following
methods:

select the column and then select Edit...Add Rank,

press Ctrl+double-click on the column header,

select the column and then press Ctrl+Shift+R,

or select the column and then select the Rank+ toolbar icon.

If you want to see the funds ranked in the opposite order, select Edit...Add Rank Ascending Descending.
The Expert will indicate additional rankings by incrementing the number of green arrows in the top left-
hand corner of the column header.

You may remove columns from the ranking order by selecting and ranking a column that is already in
the ranking order. This will remove any columns below it from the rank.
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7.9 Ranking Columns

Data in any of the visible columns may be ranked (sorted) in ascending or descending order. You can
rank by up to five different columns at a time. As the following table shows, when the data in the
primary column is the same the Expert will check the data in the second column. If these are the same
then data in the third column is checked and so on..., until the funds can be placed in the proper order.

Order Primary 2nd 3rd

1 A A A

2 A A B

3 A B A

4 A B B

5 A B C

6 A C A

7 A C B

Suppose you want to see all AAA rated funds in each of the Objective categories. First rank by
Objective, then add Return Rating, Risk Rating and then Overall Rating in succession. At the top of
each objective, you will find the AAA Rated funds followed by ABA, ACA and so on.

You can change the primary ranking by double-clicking on the column header or typing Ctrl+R . The
Expert will pause for a moment while it ranks the column and displays the results. You may add
additional columns to the ranking by holding the Ctrl Key down while Double-Clicking the column
header or by typing Ctrl+Shift+R .

You may remove columns from the ranking order by “adding” a column that is already in the ranking
order. This will remove any columns above it from the rank.

 

7.10 Database Display Options

Select the Options toolbar icon. The View Options dialog box will appear.

Choose the Display tab.

 
The following options appear:

Show

Choose whether to display any of these parts of the View.

Column Headers:

Minimal

The smallest headers.

Short

Short headers.
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Descriptive

Full database field names (the default).

Fast Column Alignment

When this box is checked it speeds up horizontal scrolling. For precisely aligning columns for printing,
clear this box.

Colors  Change the screen colors.

Cell Margin Change the margin (border) within each cell.

Row Height Change the row height of each cell.

Select another Options tab or select OK. All changes that have been made to the options will be saved.
To lose all changes choose Cancel.

 

7.11 Choose Columns to display

1. While in any Database view (tabular view), click on the Options toolbar button (with the check mark
icon), or click "Menu > Edit > Options", or press Ctrl+T. The Database Options dialog box will
appear.

2. Choose the Columns tab.

3. To display all the columns in the database in their natural order, you can check the box “All Columns
in Database Order”.

4. The data is organized in data category folders.  You can open or close the folders by clicking on
them.

5. You can remove the check marks next to the fields that you do not want displayed by clicking on
them or by pressing the Spacebar key.  Using the Spacebar key will check or uncheck the current
item and will move to the next item.  That makes the Spacebar key, along with the arrow keys on
the keyboard, the best way to check or uncheck many columns very fast.

6. OR to select just a few columns, deselect all fields by clicking on the None button. Then, select only
the fields that you want to display.

7. Finally, click on OK. Only the columns you have selected will appear on the current database view.
To discard all changes choose Cancel.

Any previously hidden columns that you check will be reinserted into the database view to
the left of the current column in the view. (That is the column the cell pointer was in before the
Database Options dialog box was opened.) Therefore, to insert previously hidden columns at specific
position in the database view, first click in the appropriate column before opening the Options dialog
box.

Note:

You can move columns around by dragging their column header to a new position. See Moving
Columns .

You can copy the main Database view on the Pages list and customize it to display only the
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columns and records you want. See Copying a Page or a Folder .

7.12 Moving Columns

1. Click on the column header of the column you wish to move and continue holding down the left
mouse button.

2. Drag the column to its new location. As you drag the column, a small rectangle icon will appear.

3. Drop the icon at its new location. The column will push the column it is dropped on top of to the
right.

 

7.13 Changing the Column Width

To auto-size a column to the length of the longest text it contains double-click on its right border.

To size it manually:

1. Place your mouse cursor on the right border of the column header. The column-width cursor
appears.

2. Click and drag the column border to any size you wish. Dragging the column size all the way over to
the left will hide the column.

 

7.14 Changing the Row Height

1. Hold down the Control key while placing your mouse cursor on the bottom border of the row number
bar. The row-height cursor appears.

2. Click and drag the column border to any size you wish. The new size will affect all rows.

 

7.15 Printing

Use one of the following methods to print the current page.

Select File...Print,

press Ctrl+P,

or select the Print toolbar icon.

The Print dialog box appears indicating the default printer and the following choices for the Print Range:

All

Print everything in the current view.

Selection
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Print the selected items.

Pages

Print from page n to page n (where n is a range of page numbers). Pay attention to the numbers in
these boxes when you are printing Views, sometimes the number can be quite large (10,000+ pages!).

When you are printing Views, the Expert will calculate the number of pages that it will print before
showing the Print dialog box. You can enter the page range in the dialog box if you only want to print
some of the pages. If the print job contains too many pages, consider reducing the amount of visible
information in the View by modifying the number of funds and columns. Pages are printed across
columns left-to-right then down rows.

The printed page uses the same fonts, margins, headers, and footers that are used on-screen.

While in Database View, if you select Database...Print Reports, the Expert will print a copy of the
selected Report for each of the tagged funds. This option is only available for printing Graphs and
Reports and must be invoked from a Database View.
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8 Filtering the Database

8.1 Filters List

The Filters drop-down list is located above the column headers in Database view (the data table or
spreadsheet view).

The Filters list shows first all built-in and then all user-created filters, portfolios, and securities
groups.  Any filters, portfolios, or securities groups you create will appear on that list, and are instantly
accessible with a single click.

8.2 Quick Filter

Quick Filter is a convenient feature that allows you to instantly filter the database view by the value of
any table cell.

It works as follows: In Database view, select any table cell and then click on the Quick Filter (lightning
bolt) button on the toolbar, or choose "Quick Filter" from the Filters drop-down list.  The result is an
instant filtering of the database by the value in that cell.  In other words, only the records that match
that value will be displayed.  You can display all records again by choosing "All records" from the
Filters list.  The "Quick Filter" feature works with any value in the database.

The column and cell value you have used for Quick Filtering will be displayed on the left side of the
status bar.

8.3 Filtering Environment Basics

Filtering gives you the power to view only the funds that interest you based on criteria that you input.
Select the Filter toolbar icon and the Filter dialog box will appear on-screen. The criteria that will be
used to filter the current View appear in the white rectangle. Each View has its own Filter. Filters that
are saved become global and can be recalled from any Filter dialog or the Filters drop-down list
which means they can be applied to any Database View.

 
Below is a list of other options found on the Filter dialog box:

Add Condition Add a condition to the filter.

Delete Condition Delete the currently highlighted condition.

Edit Condition Allows you to edit the currently highlighted condition.

Clear All Conditions Deletes all conditions in the filter.

Switch All And/Or Changes all the ANDs to ORs and all the ORs to ANDs.

Undo Action Undoes the most recent action.

Redo Action Cancels the effect of the last undo.

Open/Manage Filters Open any previously memorized filter, including the ones build into the Expert.
This will overwrite the currently visible filter. Here you can also copy, rename and delete filters you
have created.

Save Filter At any time, you may save a filter by clicking this button and entering a name. The
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saved filters are stored globally and are accessible from any Database View or Notebook. Once
you have memorized a filter, you may use it in a another filter condition. See Adding A Condition To
A Filter .

Print Filter Print the current filter.

Long Descriptions You may view the conditions in English (long descriptions) or using
mathematical symbols (>, <, =, etc.).

Stay On Screen Check this box to keep the Filter dialog box visible after running the filter.

 

8.4 Adding the First Condition

We want to isolate all funds whose Category is Aggressive Growth.

1. Select the Filter toolbar icon. The Filter dialog box appears.

2. Select Add Condition. The Add Condition dialog box appears.

3. Select Field as the Condition Type.

4. Select OK. The Add Field Condition dialog box appears.

5. Select Objective in the Field list box.

6. Select Pick Value. The Objective Selection dialog box appears.

7. Select an Objective from the list.

8. Select OK. The Add Field Condition box appears with the Objective that you chose as the value.

9. Select OK. The Filter dialog box appears with the condition that you have created shown in the
workspace.

10.Select Run Filter. The Expert selects all funds that meet the conditions you have specified.

11.Select Close to close the Filter dialog box and view the results.

 

8.5 Adding More Conditions

Now that we have isolated all of the funds of that Objective, we want to make our filter more specific.
We want all the funds of that Objective that have a 3-Year Total greater than the 3-Year Total of the
S&P 500 w/Div.

1. Open the Filter dialog box. If you have not already created a condition to isolate the Aggressive
Growth funds, do so now. In addition to all funds needing to match the criteria of being of that
Objective, the funds must have out performed the 3-Year Total of the S&P 500 w/Div.

2. Select the Add Condition button in the Filter dialog box. You are given the choice of making a
selection under the headings “Relation” and “Condition Type.”

3. Relation tells the Expert whether you want to see funds that meet both conditions And or funds
that meet either one condition Or the other. For our purposes, select And for the Relation. We
want to see funds that meet the first condition and the current condition that we are adding. The
funds must be the funds of that Objective and they must have outperformed the S&P 500 w/Div.

4. You can add conditions that are based on a field, a securities group, or a previously saved filter.
Select Field for the Condition Type.
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5. Select OK. The Field Condition dialog box appears, prefaced by “(And).”

6. Select 3-Year Total as the Field.

7. Select > Greater than as the Operator.

1. Select Security/Index as the Compare To selection. This changes the “Pick Value” button to the
Pick Record button.

8. Click on the Pick Record button. The Select a Security dialog box appears.

9. Since we are looking specifically for an index, you can use the “Filters” drop-down list to select 
Indexes.

10.Type in the "Find" box the name of the index S&P 500 TR - you will probably only have to type
the first few letters of the name before the Expert locates the correct index record.

11.With the S&P 500 TR highlighted, select OK. “S&P 500 TR" appears in the Pick Record box of
the (And) Field Condition dialog box.

12.Select OK to return to the Filter dialog box.

8.6 Adding a Subordinate Condition

We have satisfied the first two conditions, all funds must be, for example, Aggressive Growth funds and
they must have outperformed the 3-Year Total of the S&P 500 w/Div. We also want to see all the funds
that have outperformed the 10-Year Total of the Aggressive Growth Average.

The language is very important to understand in order to know how to set up your filter. There is a
difference between searching for funds that have:

outperformed both the S&P 500 w/Div and the Aggressive Growth Average

and searching for funds that have

outperformed either the S&P 500 w/Div or the Aggressive Growth Average.

The first filter would be exclusive of all funds that match only one of the conditions. The second filter
would be inclusive of all funds that match either condition. In this case we are searching for funds that
match either condition.

Because we want to add a condition that is subordinate to the S&P 500 w/Div condition, make sure
that the S&P 500 w/Div condition is highlighted. Choose Add Condition to add another condition to the
filter. The Add Condition dialog box appears.

Since we want the Expert to find all Aggressive Funds that have outperformed either the S&P 500 w/Div
or the Aggressive Growth Average we need combine the two conditions. The Aggressive Growth Fund
condition must be nested with the S&P 500 w/Div condition. Under the heading Nest Condition, choose
Subordinate to the Current Condition. Notice that the option under Relation is changed from And to Or.

We are still using a Field for our Condition Type.

1. Select OK. The Field Condition dialog box appears, prefaced by “(Or).”

2. Select 10-Year Total under the “Field” heading.

3. Select > Greater Than as the Operator.

4. Under the “Compare To” heading, select Fund/Index.

5. Click the Pick Fund button. The Select a Fund dialog box appears.

6. Since we are looking specifically for a benchmark, you can use the “Filters” drop-down list to
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select Indexes.

7. In the Find Fund Name box, type Aggressive Growth Average until the Aggressive Growth
Average Fund is highlighted.

8. Select OK

9. Select Run Filter and the Close or clear the Stay on Screen box and then press Run Filter.

 

8.7 Nested Conditions

When you add a third condition to a filter, the Nest Condition selections on the Add Condition dialog
box become available to you. Indentation gives you a clue as to the level at which a condition is added.
Below are some examples of filter conditions.

At the Same Level

The new condition (highlighted) is added at the same level as the condition that was selected when the
new condition was created.

All three conditions must be met.

Subordinate To Current Condition

The new condition is added at a level subordinate to the condition that was selected when the new
condition was created.

Condition one must be met and either condition two or condition three must be met.

All funds that are selected must have a 12-Month Return greater than or equal to 5 and the funds must
also meet one of the following conditions, either have Expenses equal to 0 or Open equal to Y.

Versus All Conditions Combined

The new condition is added at the same level (indentation) as the first condition. Condition two is
subordinate to condition one.

Either condition one and condition two must be met or only condition three.

All funds that are selected must have either a 12-Month Return greater than or equal to 5 and
Expenses equal to 0, or Open equal to Y.

 

8.8 Nested Condition Example

The Nest Selection is available when adding conditions to a Filter. It specifies how the condition you
are about to enter relates to the condition currently selected in the Filter workspace. To display the Add
Condition dialog box, select the Filter toolbar icon and then select Add.

At the Same Level

The next condition should have the same precedence (or weight) as the current condition. If you are
creating a simple filter, you may want to choose this setting (the default).

Subordinate to Current Condition

The next condition will be combined with the current condition into a nested statement, equivalent to
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logical parentheses. The power of the combined statement will be the same as that of the current
condition.

Versus All Conditions Combined

The next condition will be combined with the entire filter in parentheses. In other words, the next
condition will have as much weight as the whole current filter taken as one statement.

You can place conditions inside other conditions, for instance:

A condition or conditions placed inside another condition is said to be nested. The Expert allows you to
nest conditions up to eight levels deep, creating Filters of any desired complexity. The Expert indents
nested conditions to make the Filter more readable.

Suppose you have the following criteria:

The funds must be open,

and the funds must have a Return Rating of “A”

or the expenses must be below two percent.

In the Expert, you would create a Filter to meet the criteria above:

“Or Expenses...” is a nested condition of the Return Rating condition; both conditions can be
considered as a unit - as condition number two. In order for a fund to appear in the filtered list, it must
meet condition number one and both criteria of the unit condition number two. 

Indentation gives you a clue as to the level at which a condition is added. Below are some examples of
Filter conditions:

At the Same Level

The new condition (highlighted) is added at the same level as the condition that was selected when the
new condition was created.

All three conditions must be met.

Subordinate To Current Condition

The new condition is added at a level subordinate to the condition that was selected when the new
condition was created.

Condition one must be met and either condition two or condition three must be met.

All funds that are selected must have a 12-Month Return greater than or equal to 5 and the funds must
also meet one of the following conditions, either have Expenses equal to 0 or Open equal to Y.

Versus All Conditions Combined

The new condition is added at the same level (indentation) as the first condition.

Either condition one and condition two must be met or only condition three.

All funds that are selected must have either a 12-Month Return greater than or equal to 5 and
Expenses equal to 0, or Open equal to Y.

 

8.9 Condition Type

An option available when adding conditions to a Filter. The Condition type specifies whether you want
to base the condition you are creating on a field, Securities Group, or Filter. To select the Condition

Type, select Add while viewing the Filter dialog box.
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Field Condition

A Field condition type uses a field from the database to form the basis of a condition. By selecting Field

as the type, you are indicating that the condition you are creating will contain a field, an operator and a
designated value. Use the field condition type when you want to test a field against a value.

To choose Field as the condition type, select the Filter toolbar icon and then select Add. Select Field as
the Condition Type and select OK, the Field Condition dialog box appears.

Field

Choose a field in the database to serve as the basis of your condition.

Operator (if the field is a text field)

A fund meets the criteria if the field...

Contains

contains the value string anywhere in the field

Excludes

does not contain the value string anywhere in the field

Exact Match

an exact match of the value

Starts With

starts with the value

Case Sensitive

is the same case as the value

Operator (numeric fields)

A fund meets the criteria if the field...

=    is equal to the value

< > is not equal to the value

>    is greater than the value

<    is less than the value

>=  is greater than or equal to the value

<=  is less than or equal to the value

The operators that you are presented with are dependent upon what type of field you chose. For
instance, the Name field is a text field, while the Expenses field is a numeric field.

Pick Value/Pick Record

Type in the value that you want to compare with the field. Or, if applicable, select Pick Value or Pick

Record to select from pre-defined choices.
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Include Blanks

If this is checked, blank values will always result in a match for this condition. If not checked, blank
values will not result in a match.

Compare To

Specifies how to compare the selected field.

Value

Compare the field to an absolute value (such as “3.0” or “A”). Use this type of comparison when
you know the level of performance you are looking for.

Security/Index

Compare the field to the current value of any fund or benchmark in the database. Use the type of
comparison when you would like to filter funds based on the performance of another fund or
benchmark.

Filter Condition

A Filter condition type uses a memorized filter to form the basis of a condition. By selecting Filter as
the type, you are indicating that the condition you are creating will test each fund to see if it either 
satisfies or does not satisfy the conditions of a memorized filter. Use the filter condition type when you
want to include a memorized filter’s parameters as a condition.

To choose Filter as the condition type, select the Filter toolbar icon and then select Add. Select Filter as
the Condition Type and select OK, the Filter Condition dialog box appears.

Security

Satisfies

Securities that match the selected filter, will satisfy this condition.

Does not

Securities that do not match the selected Filter, will satisfy this condition.

Filters

Select a previously saved filter for the condition.

Filters may be nested in complex ways with this option. Remember, that a filter may not refer to itself
(even indirectly through another filter.) The Expert will check for circular references.

Securities Group Condition

A Securities Group condition type uses a saved Securities Group to form the basis of a condition. By
selecting Securities Group as the type, you are indicating that the condition you are creating will test
each record to see if it either is included or excluded (not included) in a previously saved Securities
Group. Use the Securities Group condition type when you want to include or exclude a group of
securities.

To choose Securities Group as the condition type, select the Filter toolbar icon and then select Add.
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Select Filter as the Condition Type and select OK, the Securities Groups Condition dialog box appears.

Security

Included in

Securities included in the selected Securities Group will match the resulting condition.

Excluded from

Securities not included in the selected Securities Group will match the resulting condition.

Securities Group

Select a previously saved Securities Group for the condition.

 

8.10 Relation Selection

Relation is an option available when adding conditions to a Filter. The Relation Selection specifies how
the next condition will relate to the current condition. Notice that you are only free to choose the
relation for the second condition, since you may not mix ANDs and ORs at the same level. To display
the Add Condition dialog box, select the Filter toolbar icon and then select Add.

Relation Selection

And

Indicates that both the next condition AND the current condition must be satisfied. All conditions in a
group must be met

Or

Indicates that either the next condition OR the current condition must be satisfied. At least one
condition in a group must be met

Each condition in a filter is related to the preceding condition by an AND or an OR. These words have a
precise logical meaning. They are defined as follows:

AND All conditions in a group must be met

OR At least one condition in a group must be met

To illustrate the difference between the two relations, consider the following filter where the relation is
left open:

IF Return Rating is equal to A

[AND/OR] Expense is less than 2.0

The table below lists four funds that have various values for Return Rating and Expenses. The last two
columns place an “x” by those funds which match the conditions of the filter.

 

Name Return Rating
Expense

s
AND OR

Fund 1 A 1.6 x
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Fund 2 B 1.2 x

Fund 3 A 4.2 x

Fund 4 B 3.5

         

As you can see, only Fund 1 will make it through the filter if AND is used as the relation. If OR is used,
Fund 1, Fund 2, and Fund 3 will match the two conditions.

 

8.11 Saving Filters

Create the conditions for a filter.

Click the Save Filter button to save the conditions shown in your Filter dialog box. The Enter a Name
For This Filter dialog box appears.

Enter a unique and descriptive name for this filter.

Select OK.

Filters, Securities Groups, Notes, and Portfolios are saved in a file with extension .MEM. When you try
to exit the Expert, it checks to see if changes have been made to the Filters, Securities Groups,
Notes, or Portfolios and will ask you if you want to save your changes.

 

8.12 Open/Manage Filters

Make a selection from the Filters drop-down list or:

1. Select the Filter toolbar icon. The Filter dialog box appears.

2. Click the Open/Manage Filters button. The Open Existing Filter dialog box appears.

3. Select the filter you want to open.

4. Select OK to open that filter. The filter conditions will appear in the Filter workspace.

5. Select Run Filter.

6. A red lock appearing before a filter name indicates that it is a built-in filter.

7. A green lock appearing before a filter name indicates that it is a user-defined filter.

Here, you can also copy, rename or delete an existing filter you have created.
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9 Notebooks

9.1 Notebooks

Whenever you load the Expert and you are viewing a Page, you are using a Notebook (the name of the
Notebook appears in the title bar - such as "Notebook 1.exp").

A Notebook consists of Folders and Pages containing Database Views, Graphs, and Reports. The
Expert allows you to create new Database Views, Reports, and Graphs, and save them as Pages. In
order to access them the next time you use the Expert, you would need to save the Notebook file.

 

9.2 Create a New Notebook

Select the New toolbar icon. The Create New Notebook  dialog box appears with a list of databases.
Select the database you subscribe to and then OK.

Also see File > New notebook / Select Database...

 

9.3 Saving a Notebook

Select the Save toolbar icon. The Expert will save the current Notebook to the path shown in the
titlebar. If you are working on a new Notebook and you have not named it, the Expert will ask you to
give the Notebook a file name and it will assign the extension EXP to the file name (i.e., FILENAME.
EXP).

 

9.4 Opening a Notebook

Select the Open toolbar icon. The Open dialog box will appear listing all the files in the current directory
with an EXP extension (*.EXP). Select a file and click OK.

 

9.5 Changing the File name

Select File...Save As. The Save Notebook As dialog box appears. Enter the new file name and select
OK.

 

9.6 Closing a Notebook

Select File...Close. If you have made changes to the Notebook the Expert will ask you if you want to
save these changes to disk. Choose Yes if you want to save the changes you have made.
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10 Pages

10.1 Working with Pages

A Page is an object contained in a Notebook file. Notebook files contain database tables, reports and
graphs that allow you to view the data in the database. Your portfolios, filters, securities groups, and
notes are saved separately and are available to all notebooks.

Each "Page" object is an actual page in the Notebook with its own name that appears in the Page List.
You can create as many Pages in a Notebook as you wish, and copy, rename, and move them into
folders you create within the notebook. The user interface for organizing pages in a notebook is very
similar to Windows Explorer. Each Page contains a list of securities. There are three Types of Pages:

Database Views (tabular views)

contain all the securities in the database or some subset of the records in the database

Reports (single page reports)

contain a list of up to 16 base securities

Graphs (stand-alone graphs)

contain a list of up to 16 base securities

You’ll notice that a graphic appears to the left of the name of the Page in the Page List indicating
whether it is a tabular View, a stand-alone Graph, or a single page Report.

Every Page contains a list of securities. A View page, can show all the records in the database or
some subset of the records in the database. A single-page Report or Graph, can display up to 16
records at a time. (You would need to either tag the records in a tabular View or select the Securities
tab from the Options dialog box to set the base securities.)

When you move from one Page to another, the Expert "copies" the securities to the page and displays
the results. For instance, if you are looking at the Database View (and no securities are tagged) with
the cursor on “AIM Constellation A” and you select the "Fund Detail" Report Page, the Expert displays
that page for "AIM Constellation A".

Copying & Pasting a Page

You can copy a Page and paste it into the same Notebook at another position, or into another Expert
Notebook. To copy a Page, right-click on it on the Pages list and select "Copy" from the pop-up menu.
Then, click on the position you wish to copy the page to in the same or in other notebook, right-click
and select "Paste" from the pop-up menu.

Deleting Pages

To delete the current Page, right-click on it on the Pages list and select "Delete". The Expert will ask
for your confirmation prior to deleting the Page.

Locking Pages

Every Page contains a list of securities. Reports and Graphs can contain up to 16 securities at a time,
while tabular Views can hold any number of securities. For instance, when you move from a database
View to a Graph, the Expert transfers the current security (or the first 16 tagged records) to the Graph
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for display.

If you want to make the current list of securities unchanging in a given Page, select "Menu > Pages >
Lock Securities" (a check mark appears next to the menu item) or select the "Lock" toolbar icon (the
icon becomes highlighted). To unlock a page so it will again automatically populate with the securities
selected in the most recent tabular View, simply reverse the process.

Moving Pages

You can change the order of Pages in the Page List. To move a Page, click on the name of the Page in
the Page List and drag it to its new location. The Page will push the Page it is dropped on down one
place.

Renaming Pages

To rename the current Page, right-click on it on the Pages list and select "Rename". Enter the new
name for the Page and select OK.

Set Page for Quick Access with F7

Set any report or graph for Quick Access: Designate the current page to go to when F7 is pressed, or
when a row is double-clicked in any tabular View.  See "Set page for Quick Access ".

 

10.2 Copying a Page or a Folder

If the Pages List on the left of the display is hidden, to display it click on "Menu > Pages > Display
Pages List".

1. On the Pages List, click on the Page or Folder you wish to copy.

2. Select Edit...Copy from the menu or press Ctrl+C. The Page or Folder (and all the Pages it contains)
is copied to the Windows clipboard.

3. If you want to paste the Page or Folder into a different Notebook, open the target Notebook.

4. Click on a Page or Folder below which you want to paste the copied Page or Folder.

5. Select Edit...Paste from the menu or press Ctrl+V to paste the Page or Folder.

6. The copied Page or Folder (and all the Pages it contains) will appear in the Notebook.

You can also hold the Ctrl key down and drag a Page or Folder to the place you want the copy to
appear. If you simply drag without holding the Ctrl key down, the Page or Folder will be moved to the
new location. These drag-and-drop operations cannot be performed between Notebooks.

 

10.3 Base Securities

Base securities are the list of selected records that are available for display on a Graph or Report Page.
Graphs and Reports can contain up to sixteen base securities.

Every Page contains selected securities. When you move from one Page to another, the Expert copies
the selected securities to the next Page and displays the results. If you are in a View, with no tagged
records, the highlighted record is the selected security. If the cursor is on “FPA Capital” and you click
on the Single Fund Page, the Expert displays the Single Fund Report with the FPA Capital fund
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information.

If you are in a Database View that contains tagged records, including FPA Capital as the selected
record, and you click on the Long Term Performance Graph, the Expert displays a graph containing up
to sixteen records, including FPA Capital.

You can tag as many records as you wish in a View; but when you move to a Graph or a Report Page,
the number of selected securities is reduced to sixteen base securities.

You can also select the base securities while a Graph or a Report is on the screen. To select the base
securities while viewing a Graph or a Report Page, use one of the following methods:

select "Menu > Edit > Options",

or press Ctrl+T,

or select the Options toolbar icon, and choose the Securities tab.

When viewing a Report, if you do not get the Report Options dialog box when you select options, then
select Cancel, turn off edit mode by selecting "Menu > Edit > Design Mode" and then follow the
aforementioned instructions to view the Securities tab.

To add base securities to a Report or Graph, while viewing the Securities tab of the Options dialog box,
click the Add button, the Select Securities dialog box appears. Tag the records  you want to include in
the base securities. Select OK to close the database selection box. To remove a security, highlight the
security and click Del(ete). To replace a security with another, select the security and click Edit, for
the Select Securities dialog to appear. Choose the security you would like to add and select OK.

To reposition a base security, highlight the security and click Up to move the security up one place or
Down to move it down one place. Repositioning would come in handy if you wanted to move a security
to the first/main position.

The position of a security in the base securities list is important, especially on a Report Page. The first
base security is the current security and the default security that most tables will show. The current
security is the one whose values are shown in reports such as the Single Fund Report or the Ranks &
Averages Report. When creating a report containing a table, the base securities are numbered in the
table beginning with “Security 1.” For each table that you create, you can choose which securities
values will be shown in the table.

You can copy the base securities in a Graph or a Report to another Page using the Copy & Paste
Special commands. While viewing the Page containing the securities you want to copy, select "Menu
> Edit > Copy". While viewing the Page into which you want to paste the securities, select "Menu >
Edit > Paste Special". Choose to paste the securities into the current Page (Graph, Report, or View).

10.4 Locking Securities in a Page

The lock guarantees that when you move among different Pages on the Pages List and then return to a
locked Page, the same securities present when you locked the Page will always show on that
particular Page.  Otherwise, you would see the securities selected on the most recent Page you
worked on.

1. Select the Page that you want to lock.

2. Select the Lock toolbar icon. It will appear highlighted and the securities on that Page will be
locked.

There is no limit to the number of securities that can be tagged and locked in Database View Page.
However, there is a limit of 16 securities that can be displayed and/or locked in a Graph or a Report
Page.
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You can still make changes to the securities on a locked Page (tag other securities, add securities to
a graph, etc.).

10.5 Customizing Full-Page Reports

The Expert contains a powerful Report editor, with features similar to many desktop publishing
programs. The Expert comes standard with pre-defined Reports; these Reports appear in each newly
created Notebook. All standard Reports were created using the Expert’s Report editor features.

A Report can be thought of as a virtual “page” on which you place Graphs, Tables, and Text Boxes.
Every object on the page is independent, yet they may be grouped together visually to produce stylish
effects. Every object maintains its own options, including font, colors, and fields (for tables).

Creating a New Full-Page Report

Select Pages...New...Full-Page Report and the Report Options dialog box appears. To accept the default
settings, select OK, the Expert creates a new Page with the default name of “Report.”

Adding a Text Box

While viewing a Report in design mode, select Pages...Insert Object Text Box. The Text Box Options
dialog box appears showing the Display tab. Type in the text you would like to see appear on the
report. If you would like to use a different font, choose the Font tab and select the font, size, and
appropriate styles. When you are done select OK. The text box will appear in the center of the Report,
but you may move it to a new location by dragging it with the mouse.

Adding Tables

While viewing a Report, select one of the following:

Pages...Insert Object...Field Table to add Field Table,

...Comparison Table to add a Comparison Table,

or ...Ranks & Averages Table to add a Ranks & Averages Table.

The Table Options dialog box appears, choose the Fields tab. Click Add to add the field selected in
the Database Fields list to the Field List (the fields that will be represented in the table). Choose the
Display tab. Enter the title and choose the alignment of the field values and data (left, right or center). If
you would like to use a different font, choose the Font tab and select the font, size, and appropriate
styles. When you are done select OK to view the table in the report. The values of the first base fund
will be shown on the Report.

Adding a Portfolio Table

Select Pages...Insert Object...Portfolio Table. The Portfolio Table Options dialog box appears. The
Portfolio tab allows you to set the attributes for the Portfolio. To modify colors and presentation
options, choose the Display tab. You can select what columns to display by selecting the Columns
tab. If you would like to use a different font, choose the Font tab and select the font, size, and
appropriate styles. When you are done select OK to view the table in the report.

Values will be shown only for Portfolio records.

See Add Columns to Portfolio Table on a report .

Graph

83
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Select Pages...Insert Object...Graph. The New Graph Options dialog box appears. To accept the default
settings, select OK.

Image

Select Pages...Insert Object...Image. The Select An Image File dialog box appears. You can insert any
image file, (such as your company logo) of the following types: gif, jpg, bmp.

Editing Reports

At times, you may find you need to edit (move, resize, delete, etc.) an object you have added to a
report. (Objects in this context refer to graphs, boxes, or tables on a Report.) Editing allows you to
select objects on a Report; thus allowing you to move, delete, and resize the objects.

To put a Report in edit mode use one of the following methods.

 Select Edit...Design Mode (you should see a check next to the menu item to indicate that you are
in edit mode),

 or select the Design toolbar icon (a highlighted icon indicates that you are in edit mode).

While you are in design mode, to select an object on a Report, click on the object and you will see
eight “grips” surrounding the object. Click outside the object and the grips will disappear. To select
multiple objects use one of the following methods.

 Hold the Ctrl key and click on the objects you want to select. As you select the objects, grips will
appear around the perimeter of the selected objects.

 Or hold down the left mouse button and drag the “rubber-band” to create a rectangle enclosing
the objects. The objects inside and touching the rectangle will be selected and grips will appear on
each object.

Deleting a Selected Object

To delete a selected object or objects, use one of the following methods.

Select Edit...Delete Selection,

or press the Delete key.

or right-click on the object and select “Delete Selection” from the pop-up menu.

You will be asked to confirm the deletion. Choose Yes to delete all selected items.

Moving a Selected Object

To move a selected object or objects, left click on a selected object and hold down the mouse button
as you drag the outline of the object(s) to the new position. To make minor movements, select the
object(s) and use Ctrl+Shift+Arrow keys to reposition the object(s).

Resizing a Selected Object

To resize a selected object or objects, position your cursor on one of the grips. The cursor will change
to a two way arrow. Hold down the left mouse button and drag to resize the object(s). To make minor
adjustments in size, select the object(s) and use Shift+Arrow keys to resize the object(s).

Foreground/Background

All objects on the Report have a top-to-bottom order (or z-order). Objects retain their z-order, even after
being moved. You can move an object to the foreground or background by selecting the object(s) and
selecting Edit...Move To Foreground or Edit...Move To Background. Foreground is the top layer an object



STEELE Mutual Fund Expert76

© 2024 Steele Systems, Inc.

can be at in relation to other objects on the page, and background is the bottom-most layer.

Edit Window

Sometimes you may find it necessary to edit the individual items of an object (a Table or Text Box) on
your Report. You can edit the items within an object by selecting Edit...Edit Window or Ctrl+E.

When you are in edit window mode, the cursor appears within the selected object. You can rename an
item within a window by selecting the item and entering a new name (you can rename row headings but
not column headings). You cannot enter new values for field data.

You can reposition a selected row by holding Ctrl+Shift and using the Up or Down Arrow. You can
reposition a selected column by holding Ctrl+Shift and using the Right or Left Arrow.

You can hide columns by selecting Hide Columns from the Shortcut menu or Ctrl+H. You can reset the
columns to their original order by selecting Reset Columns from the Shortcut menu.

To end window editing of a selected object, click anywhere outside of the selected object.

Show Shadow

You can add shadow to objects on a report giving the report a more professional look. To add shadow
to a selected object or objects, select Edit...Show Shadow. To remove the shadow for an object or
objects, select Edit...Clear Shadow.

 

Converting Graphics Files for Inserting into a Custom Report

Click "Start/All Programs/Accessories/Paint".

Choose Open and locate the file to convert and insert. The Paint program can import the following file
formats:

 *.tif, *.tiff, *.jfx

 *.bmp

 *.jpg, *.jpe, *.jpeg

 *.pcx, *.dcx

 *.xif

 *.gif

 *.wif

Click "Menu/File/Save As...", name the file, and save it as a file of one of the following types: *.gif, *.
jpg, *.bmp.

In the Expert program, to edit the report, click "Menu/Pages/Design Mode".

Click on "Menu/Pages/Insert Object/Image (Logo)..." and choose the file to insert.

Save the notebook (.exp file).

 

10.6 Fonts to use on Reports & Graphs

You can use any font installed on your computer.

However, if you are planning on sharing reports with other users, the following fonts are always present
in Windows versions 2000, XP, Vista, 7 and later, and can be used anywhere in the program and on
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reports/graphs in any combination:

Tahoma
Verdana
Arial
Arial Black
Courier New (monospace)
Impact
Georgia
Palatino Linotype
Lucida Console (monospace)
Lucida Sans
Times New Roman
Trebuchet
Webdings
Wingdings
Wingdings 2
Wingdings 3

If a report contains a font that is not present on a given computer, the Expert will automatically
substitute it with a similar basic font such as Arial.

The recommended font is Tahoma in font sizes of 7.5pt for reports, 7pt for graphs on reports, and 8.5pt
for Database views.

You can use fonts such as Calibri that are only present on Windows Vista, 7 and later, or when
Microsoft Office 2007 or later has been installed.

10.7 Full Page Report Objects

Designing a new Report consists of adding objects to a virtual “page.” The objects featured in the
Expert include Graphs, Text Boxes, Tables, and Images (such as logos, etc).

There are four types of Table objects that can be added to a Report.

Comparison Tables

for comparing data of up to sixteen funds,

Field Tables

for displaying the data values for the first base fund,

Ranks & Averages Tables

for comparing the Ranks & Averages of the first base fund against the averages and rankings of a list of
funds,

Portfolio Tables

for including a Portfolio listing of funds on a Report.
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Display

Display tabs for Report objects vary depending on the type of object.

 

Fields Tab

Available for tables.

Field List

Enter the database fields for which you want values displayed in the table. The fields appear in the table
in the same order as they are listed in the Field List selection box.

Database Fields

Database Fields available to add to the Fields List.

Add

To add the selected Database Field to the Field List select Add or just double-click on the field in the
Database Field.

Del

Delete the selected field from the Field List.

Up

Move the field selected in the Field List up one position.

Down

Move the field selected in the Field List down one position.

Alias

Enter an alias for the field selected in the Field List. You may enter a space in the box if you do not
want the field names to appear in the table.

Show Fund

You can choose which fund’s values you want to show in a field table. The funds are numbered in the
order they appear in the Funds Option box. The default is Fund Number 1.

 

Font Tab

Face Name

Enter the font name or leave blank for default font of Arial.

Size

Enter the size or leave blank for default value of 10 point.
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Bold

A clear box indicates not bold, a checked box indicates bold, and a grayed box indicates the default
value of not bold.

Italic

A clear box indicates not italic, a checked box indicates italic, and a grayed box indicates the default
value of not italic.

To make changes to a table at a later time, double-click on the table and the Edit Table Data dialog
box appears.

 

10.8 Field Codes: Placing variables on reports

One of the features of the Expert Report editor is the option to use codes in order to display variable
information on a Report (such as the database date or the current date).These codes must be used
within a Text Box.

The Expert codes use certain conventions which must be followed or else the Text Box will display the
literal characters that you input.

All Expert codes must be enclosed in parentheses ({}) - parentheses must precede and follow the code
(i.e., {DBMON}).

All codes must be in upper case letters (i.e., {DBYR}).

Allow for proper spacing between codes, and enter any special characters that you want shown, just as
you would if you were inputting the actual words (i.e., {DBMONTH} {DBDAY}, {DBYEAR}).

The following Expert codes are available for use:

DBMON

Displays the month of the database edition in use in abbreviated form (for example, Mar or Dec).

DBMONTH

Displays the month of the database edition in use (for example, March or December).

DBDAY

Displays the numerical day of the database edition in use (for example, 10 or 31).

DBYR

Displays the year of the database edition in use in abbreviated form (for example, 08).

DBYEAR

Displays the year of the database edition in use (for example, 2008).
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11 Portfolio

11.1 Creating a Portfolio

The Expert allows you to create Portfolios containing any number of securities. User-created portfolios
behave like any other security record in the database and can be graphed, compared, ranked with other
securities, filtered, etc.

You will need to supply the dollar amount of each of the securities, the number of shares held in each
security, or the percentage of each security (along with a total dollar amount).  Dollar amounts are best
suited for analyzing existing and portfolios, while percent weights are best for recommended model
portfolios.

A “composite” portfolio record will be added to the database for each portfolio you create and will be
inserted in the current view. The security name will be the portfolio name you enter preceded by an
asterisk (*) and will be conveniently listed at the top when the database view is ranked by the Name
column. The values in the resulting portfolio record are the weighted average of every security in the
Portfolio with a non-zero percentage. For instance, for a Portfolio consisting of two funds, Fund A with a
25% share and Fund B with a 75% share, the system will compute the various returns and statistics
using the appropriate weighted averaging methodology based on the user-specified percentages.

(The securities in a portfolio may have different inception dates and have been in existence for different
periods of time.  Statistics for periods during which some of the securities in the portfolio did not exist
are computed by assuming that for each data point in the computation the portfolio only contained
those funds that did exist for that data point. Rebalancing to the original portfolio percentages occurs in
a computation each time a new security comes into existence and is, therefore, added to the portfolio
at that point.

Portfolio returns for the various periods are computed as follows: The assigned weight of a security that
has no data for a given data point is assumed to be allocated equally to the securities that do have
data for that given data point. Each time a security with no prior data starts having data in a series of
the underlying monthly returns, the portfolio is rebalanced to the original applicable weights at that data
point.)

To create a portfolio:

1. Select the securities that you wish to put in the Portfolio (typically by tagging them in Database
view). If you are on a Database view, the record currently selected or the tagged records will be put
automatically in the new Portfolio. If you are viewing a Report or Graph Page, the records displayed
will be included.

2. Select "Menu > Portfolio > Create New Portfolio..." and enter a unique name for this Portfolio.

3. Portfolio names are preceded by an asterisk (i.e., “*John Client recommended portfolio”) and will be
conveniently listed at the top when the Database view is ranked by Name.

4. Select OK. The Portfolio box appears on the screen and the Portfolio record is added to the
database. When values are entered in the Portfolio dialog box, the system will calculate the data for
the Portfolio.

5. The Portfolio will be inserted on the Page you are currently viewing: - a table view, report, or graph. If
your view is ranked by Name then the Portfolios will be listed first.

6. Select the Portfolio Options button. The Portfolio Options dialog box will appear.

7. Choose one of the methods under the heading “Compute Using” based on the data you will input -
the amount of each security, the number of shares of each security, or the percentage of each
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security, and a total value.

8. If you chose Percentage as the computing method, you must enter the Total Value of the Portfolio.

9. Choose an investment Category and/or Objective for the Portfolio (these are listed below the heading
“Category for Portfolio Comparisons”). The Category and Objective you assign are used by the
Expert to determine which Investment Category and Objective Averages are automatically added for
comparison on Graphs.

10.Select OK to close the Portfolio Options dialog box.

You can still switch to other pages while the Portfolio dialog is on the screen. As you change the
numbers in the portfolio, you can see the results reflected immediately on the current page.

11.2 Based on Dollar Amount

1. Select the Portfolio Options button and the Portfolio Table Options dialog box appears. Select the
Portfolio tab.

2. Select Amount under the heading “Compute Using” and select OK to close the Options box. The
cursor appears in the Amount column of the first fund in the Portfolio.

3. Enter an amount for the funds in the Portfolio. After each entry, press Enter, this lets the program
know that you have completed an entry. The Expert uses the listed NAV to calculate the number of
shares you can purchase for the amount you entered. The figures in the Percent column represent
the weighted percent of each fund based on the dollar amount input.

 

11.3 Based on Shares

1. Select the Portfolio Options button and the Portfolio Options dialog box appears. Select the
Portfolio tab.

2. Select Shares under the heading “Compute Using” and select OK to close the Options box. The
cursor appears in the Shares column of the first fund in the Portfolio.

3. Enter the number of shares for the funds in the Portfolio. After each entry, press the down arrow key,
this lets the program know that you have completed an entry. The Expert calculates the dollar
amount and percent of each fund, and the total value of the Portfolio.

 

11.4 Based on Percentage

1. Select the Portfolio Options button and the Portfolio Options dialog box appears. Select the
Portfolio tab.

2. Select Percentage under the heading “Compute Using.” Enter a total amount for the portfolio in the
Total Value box. Select OK to close the Options box. The cursor appears in the Percent column of
the first fund in the Portfolio.

3. Enter the percentages for the funds in the Portfolio. The sum of the percentages is listed in the box
labeled “Percent.” After each entry, press the Down Arrow, this lets the program know that you have
completed an entry. The Expert calculates the dollar amount and shares of each fund, based on the
percentages of the total value you inputted.
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11.5 Adding New Securities

1. Select Add Security. The Select Securities dialog box appears.

2. Select the records you wish to add to the Portfolio (you can tag multiple records). The Expert
provides the ability to rank securities in the Select Securities dialog box and the option of showing
benchmarks only.

3. Select OK. The records you selected are added to the Portfolio.

 

11.6 Open/Manage Portfolios

1. Select Portfolio...Open/Manage Portfolios.

2. Select the Portfolio you wish to open.

3. Select OK. The Portfolio you selected appears on-screen.

Here you can also copy, rename and delete portfolios you have created.

 

11.7 Add Columns to Portfolio Table on a report

You can add or remove columns to a portfolio table on a report as follows:

1. Put the report in Design Mode by first clicking on the report and then selecting “Menu > Pages >
Design Mode”.

2. Right-click on the portfolio table and select from the popup menu “Edit Window…”, or just hold down
the Ctrl key and double-click on the portfolio table.

3. Then, right-click again on the portfolio table and select from the popup menu “Add Database
Column…”.

4. Select the column you want from the dialog box showing all the columns in the database.  The
column will be added to the portfolio table to the right of the existing columns.

5. If necessary, expand the portfolio table towards the right to show the newly added column.

6. If desired, drag the newly added column to another place on the portfolio table and resize its width.

7. Exit Design Mode by selecting “Menu > Pages > Design Mode” and save your notebook (“Menu >
File > Save notebook…”).



STEELE Mutual Fund Expert84

© 2024 Steele Systems, Inc.

11.8 Combine securities from multiple portfolios

There are situations when you may want to view and compare the combined performance and statistics
of more than one portfolio.

The best way to combine securities from multiple portfolios into another portfolio is as follows:

1. Create a new empty portfolio, or make a copy of an existing portfolio, and give it a name reflecting
your intended purpose.

2. Then, open this new portfolio and click on "Add Security" to view all the records in the database,
including existing portfolios.

3. From the "Filters" drop-down list, select an existing portfolio whose securities you want to include.
This will display only the securities in that portfolio.

4. Tag all or some of the displayed securities you want to include by clicking on their row number, and
then select "OK".

5. You can repeat steps 2-4 to add the securities of another portfolio.

11.9 How to share portfolios, filters, securities groups, user notes

Now that you can select different folders for the .mem file (that holds the portfolios, filters, fund groups
and user notes), users can employ the following procedure to create additional .mem files for sharing
these objects: 

1. Use Windows Explorer to create a folder (different from the current User Data Folder) and copy into it
the .mem file from the User Data Folder. This folder can be dedicated to hold notebooks (.exp) and .
mem files for sharing, and it can be named accordingly, for example "Expert Shared Data" . You
only need to perform this step once. 

2. Start the Expert and change the User Data Folder to the "Expert Shared Data" folder holding the
copy of the original .mem file (and/or notebooks for sharing). 

3. Modify the portfolios, filters, securities groups and user notes and save the .mem file. (For example,
you may want to add or delete portfolios, filters, etc). 

4. Then, change back to the main User Data Folder (by clicking "Menu/Pages/Global Options/Settings/
Change the User Data Folder") to work with your own portfolios again. Now, you can easily change
back and forth between your Expert data folder and the "shared" one. 

5. To share the data, the shared data folder could be on a network drive, or it can be copied to another
computer.
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12 Menu Commands

12.1 File

12.1.1 New notebook / Select Database...

Displays the Create New Notebook  dialog box. You will need to choose a database with which the
Notebook will be associated.

You can create a new Notebook which will contain the standard template Pages that come with the
program. The Notebook is automatically assigned a file name of "Notebook n.Exp" (where n is a
number). To save the Notebook under a different name of your choice, select File...Save As... .

12.1.2 Open notebook...

The standard Open dialog box will appear listing all the files with the *.Exp extension. Simply choose a
file and click OK, or double-click on the file to open it.

To open an existing Notebook you can:

Select File...Open...

  or

Click the open button on the tool bar.

 
See Also:

 Import a Symbols text file

 File...New...

 File...Save As...

 

12.1.3 Save notebook...

To save changes that you have made to the current notebook affecting the appearance of reports,
graphs, and database views:

Select File...Save...

  or

Click the save button on the tool bar.

  or

Press Ctrl+S  .

The Expert will save the current notebook in the folder you choose or create. If you are working with a
new notebook and you have not renamed it, the Expert will ask you to give the notebook a file name.

 
See Also:

 File...Save As...
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12.1.4 Save notebook As...

Displays the Save As dialog box to save the current Notebook with a name you enter. A default .Exp
extension is attached to the file name.

To change the file name of the current notebook:

Select File...Save As...

You will be presented with the standard Windows File Save dialog box. Simply type in the new file
name and hit return. If you do not provide an extension for the name, ".Exp" will be automatically added
to the end of the name.

 
See Also:

 File...New...

 File...Open...

 File...Save...

 

12.1.5 Close notebook

Closes the current Notebook. If any changes were made to the current Notebook, you are first
prompted to save the Notebook before closing.

To close the current notebook:

Select File...Close

  or

Press Ctrl+F4 .

 

See Also:

 File...Open...

 File...Save...

 

12.1.6 Save Portfolios/Filters/Global Options

Saves all changes made to portfolios, filters, securities groups, user notes, and global option settings.

12.1.7 Print...

Prints the current page. Displays the Print dialog box.

When selected while the current Page is a Database View, the Expert will calculate the number of
pages needed to print all data that is in the current View (can be more than 10,000 pages). It may be
wise to adjust the number of funds and columns prior to printing a View.

To print the current page:

Select File...Print...

  or
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Click the print button on the tool bar.

  or

Type Ctrl+P .

 
You will see the standard print dialog box. Select OK to print the entire page.

You can change the orientation or paper settings with the File...Page Setup...  dialog box.

If the current page is a Database View, printing is somewhat more involved. The Expert will calculate
the number of pages that will print before showing the print dialog box. If the number of pages exceeds
20, the Expert will warn you before continuing since printing the entire database could take thousands
of pages. You may enter the page range in the dialog if you only wish to print certain pages.

If the print job contains too many pages, consider reducing the number or columns or rows in the
Database View. See Database Views .

 

12.1.8 Printer Setup...

Printer Setup allows you to change your printer, paper orientation, paper size, or paper source. The 
Print Setup dialog box appears.

Printer

Specify the printer you want to use, either the default printer or specify a different printer already
installed on your system.

Orientation

Choose portrait to orient the paper long-side top-to-bottom and landscape to orient the paper long-side
left-to-right.

Paper Size

Choose letter for 8½ x 11 inch paper or legal for 11 x 14 inch paper.

 

12.1.9 Page Setup...

You can change the header, footer, and/or margins for the current Page, as well as the paper offset for
all Pages from the Page Setup dialog box. To display the Page Setup dialog box select File...Page

Setup... or select the Page toolbar icon.

Header & Footer

These will appear centered at the top and bottom of the printed page inside the margins. You may enter
more than one line of text.

Orientation

Choose portrait to orient the paper long-side top-to-bottom and landscape to orient the paper long-side
left-to-right.

Paper Size

Choose letter for 8½ x 11 inch paper or legal for 11 x 14 inch paper.
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Margins

Enter the top, left, right, and bottom margins in inches from the edge of the paper (up to 4 inches).

Paper Offset

You can use the paper offset to adjust a where a report prints on a page. This setting is global and it
will affect all Pages.

Each Page maintains its own page setup information. For example, changing the page orientation in
the Database View will not effect the settings in the Fund Detail Report. The exception to this is the
paper offset which is a global setting.

You can use the paper offset to adjust how a report prints on a page. If you are printing a report and the
report is not centered, or is being cutoff on the bottom or top, try adjusting the paper offset. Select the 
File...Page Setup... or the Page toolbar icon and adjust the paper offset.

These two values indicate the X and Y origin of the top left corner of the paper. If your printout is offset
on the page, you can adjust these values (in inches) until the printout is correct. Increasing the X origin
shifts the print to the left of the page. Increasing the Y origin shifts the print closer to the top of the
page.

 

12.1.10 Exit

To exit the Expert:

Select File...Exit.

  or

Type ALT-F4 .

If you have any unsaved Notebooks open, the Expert will ask you to if you want to save them. Answer
YES if you want to preserve your changes for the next session.

The next time you run the Expert, the same files that you had open this time will be reopened for you
automatically.

 

12.2 Edit

12.2.1 Options...

Applies to the current Page only. Displays the Options dialog box, on which you can change the
display settings for the current Page.

The Options command allows you to modify the style and content of a Page. Use one of the following
methods to display the Options dialog box.

Select "Menu > Edit > Options",

or press Ctrl+O,

or select the Options toolbar icon.

and then choose one of the tabs. The changes that you make to the options, will only affect the
currently selected Notebook Page. Once you have completed making changes, select OK to accept
the changes and close the Options dialog box. Or choose another option tab to edit. If you do not want
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the Expert to accept the changes that you have made, select Cancel.

Data Tab

Only available for Graphs. Allow you to edit the data options for a Graph.

Display Tab

Allows you to edit the style of a Page.

Securities Tab

Allows you to select the securities for a Page.

Font Tab

Allows you to make changes to the font for a Page.

For detailed information see Graph Options , Report Options , Database View Options

 

12.2.2 Find...

In Database view it displays the Find Value  dialog box, which you can use to find any value in the
current column of the View. When viewing a page, it will allow you to search for a fund by name.

 

12.2.3 Cut

The cut command first copies the selected item to the clipboard and then deletes the selected item
from the Notebook.

 

12.2.4 Copy

The copy command copies data from the Expert to the clipboard—this data can be pasted either into
another Page in the Expert or in another Windows application. You can copy records in a View to
another application, you can copy funds, you can copy an entire Page for insertion in another Expert
Notebook, or you can copy objects (tables, boxes, or Graphs) and place them on a Report Page.

To copy select Edit...Copy or press Ctrl+C. The data is stored in the clipboard and may be pasted in
another Page, Notebook, or Windows application.

 

12.2.5 Paste

Choosing the paste command pastes the default format from the clipboard into the Expert. The default
format will paste the page from the clipboard into the current Notebook.

To paste the default format in the Expert, select Edit...Paste or Ctrl+V. If the format you want to paste is
not the default for the current Page type or Portfolio box, choose Edit...Paste Special...  for other
formats.
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12.2.6 Paste Special...

Choosing Edit...Paste Special allows you to choose from a list of formats available for pasting. These
include pasting funds into a Page, report objects in a Report, and graph objects into a Report.

 

12.2.7 Hide Column

To hide a column, move the cursor to the column you want to hide and use one of the following
methods.

select Edit...Hide Column,

press Ctrl+H,

or drag the column border all the way over to the left.

The column will disappear from the Database View. To retrieve the column, choose Edit...Reset
Columns  or select the column in the Column tab of the Database View Options  dialog box.

You can use the same method to hide columns in an edit window on a Report.

 

12.2.8 Reset Columns

A menu item is available to reset all columns in the View to their original database order and size.
Select Edit...Reset Columns from the menu. The Expert will confirm that you want all columns reset to
their original order and size. Select OK to reset the columns.

 

12.2.9 Show Popup Hints

Enables popup hints to appear when the mouse cursor rests on an object (e.g. toolbar button, column
header, etc.)

 

12.2.10 Lock/Unlock Column

Locking a column ensures that the column will remain on-screen as you scroll to the right. When you
print a Database View that contains locked columns, the locked columns appear on the left side of
each printed page.

To lock a column, select the column, and then select Edit...Lock Column. Locked columns are placed
to the left of the first unlocked column and a darker column grid appears to delineate between columns
that are locked and those that are not. To unlock a column, select the column and select Edit...Unlock

Column from the menu.

 

12.2.11 Primary Rank

Ranking is sorting the database (in ascending or descending order) based on the selected column. You
may rank up to five columns at one time. Additional rankings are based on the sorting order of the
Primary Rank— the first column sorted.

Use one of the following methods to perform a Rank.

Select the column and then select Edit...Primary Rank (or Primary Rank [Ascending/
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Descending]).

Double-click on the column header.

Select the column and then press Ctrl+R.

 
See Ranking

12.2.12 Primary Rank (Ascending/Descending)

Primary ranks in ascending or descending order. See Ranking

12.2.13 Add Rank

The Add Rank command sorts the selected column within an already existing rank. You may rank up
to five columns in a View at one time. Once you have performed the primary rank, you will need to
perform an Add Rank on the additional columns. Any column can be ranked (sorted) in ascending or
descending order. Available in Database View Pages only.

Use one of the following methods add additional ranking to a column:

select the column and then select Edit...Add Rank or Add Rank [Ascending or Descending],

or press Ctrl+double-click on the column header,

or select the column and then press Ctrl+Shift+R,

or select the column and then select Rank+ toolbar icon.

See Ranking

12.2.14 Add Rank (Ascending/Descending)

Adds ranks in ascending or descending order. See Ranking

12.2.15 Edit Portfolio...

Displays a dialog box to select a portfolio. Once selected, the Portfolio Options  dialog box appears.

 

12.2.16 Edit Window...

While in Design Mode , you chose a specific object on the report to edit.

 

12.2.17 Delete Selection...

While in Design Mode , you chose a specific object on the report to delete.
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12.2.18 Selection Font...

While in Design Mode , you set the font for a specific object on a report.

 

12.2.19 Move To Foreground

Objects on a report page can overlap on each another. You choose a specific object on a report so that
it lies on top of the other objects in the report.

 

12.2.20 Move To Background

Objects on a report page can overlap on each another. You choose a specific object on a report so that
it lies under (behind) the other objects in the report.

 

12.2.21 Show Shadow

Gives the currently selected object in a Report View, a 3-D appearance with a shadow while in Design
Mode.

 

12.2.22 Clear Shadow

Clears the shadow appearance of the currently selected object in a Report View, while in Design Mode.

 

12.2.23 Add Database Column...

Available only for portfolio tables within a Report View. Edit...Add Database Column... appears only
when:

1. The Report View is in Design mode and

2. A portfolio table has been activated with Edit...Edit Window... (or Ctrl+Double-Click). If the portfolio
table contains a portfolio, Edit...Add Database Column... will allow you to add a database field to
that portfolio table after the rightmost column. You can drag the newly added column to any other
position in the portfolio table you want.

12.2.24 Remove Current Database Column

Available only for portfolio tables within a Report View. Edit...Remove Current Database Column...
appears only when:

1. The Report View is in Design mode and

2. A portfolio table has been activated with Edit...Edit Window... (or Ctrl+Double-Click).

If the portfolio table contains a portfolio with at least one security, Edit...Remove Current Database
Column... will allow you to remove database fields displayed in that portfolio table.  It will only
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remove columns included in the database, not the basic portfolio table columns (Security, Price,
Amount, Shares, Percent).Those can be removed or added back via the Options dialog of the
portfolio table.

12.2.25 Add Securities...

Available only for portfolio tables within a Report View. Edit...Add Securities... appears only when:

1) The Report View is in Design mode and

2) A portfolio table has been activated with Edit...Edit Window... (or Ctrl+Double-Click). If the portfolio
table contains a portfolio, Edit...Add Securities... will allow you to add  securities to that portfolio.

12.2.26 Delete Selected Security

Available only for portfolio tables within a Report View. Edit...Delete Selected Security appears only
when:

1) The Report View is in Design mode and

2) A portfolio table has been activated with Edit...Edit Window... (or Ctrl+Double-Click). If the portfolio
table contains a portfolio, Edit...Delete Selected Security will allow you to delete the current security
in that portfolio.

12.2.27 Delete All Securities...

Available only for portfolio tables within a Report View. Edit...Delete All Securities... appears only
when:

1) The Report View is in Design mode and

2) A portfolio table has been activated with Edit...Edit Window... (or Ctrl+Double-Click). If the portfolio
table contains a portfolio, Edit...Delete All Securities... will allow you to delete all funds in that
portfolio.

 

12.2.28 Design Mode

Being in Design Mode while viewing a single-page report refers to the ability to edit (move, resize,
delete, etc.) objects (text boxes, tables, or graphs) on that report. To put a report in this editing mode,
first select it in the Pages List, then use one of the following methods:

Select "Menu > Edit > Design Mode", or "Menu > Pages > Design Mode"
(You should see a check mark next to the Design Mode menu item to indicate that you are in
Design mode.),
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or select the Design Mode toolbar icon

(A highlighted icon indicates that you are in Design Mode.)

When you click once on an object on the report while in Design Mode, eight “grips” appear along the
border of the object. When you double-click on an object in Design Mode, the Options...  dialog box
for that specific object appears on-screen.

12.3 Database

12.3.1 Find Winners...

Available in Database view Pages only. Opens the Winners Wizard  dialog box.

The Winners command allow you to easily view the top performers of an objective category based on a
numerical performance field and a percentage. The Expert uses your selections to perform a filter of
only those funds that match the selected objective, ranks the securities by the field you have chosen,
and then displays the top performers based on the percentage of the securities that you requested.

Use one of the following methods to find the winners:

select Database...Find Winners... from the menu,

or press Ctrl+W,

or select the Winners toolbar icon.

See Winners Wizard

12.3.2 Filter the Database...

Filtering is available only when the current page is a Database view. Displays the Filter  dialog box
on which you can set multiple selection criteria for the current view.

See Filtering .

12.3.3 Tag Single Record

Available in a Database views only. Toggles between tagging or untagging the currently selected
record. See Tagging Records .

 

12.3.4 Tag All Records

Available in a Database views only. Tags all the records in the current Database view. See Tagging
Records .

12.3.5 Untag All Records

Available in a Database views only. Removes the tags on all the records in the current Database view.
See Tagging Records .

89

128

128

111

111

51

51

51



STEELE Mutual Fund Expert96

© 2024 Steele Systems, Inc.

12.3.6 Previous Tagged Record

Moves to the previous tagged record in the database view, or to the previous record, if no records are
tagged. See Tagging Records  and Securities Groups .

12.3.7 Next Tagged Record

Moves to the next tagged record in the database view, or to the next record, if no records are tagged.
See Tagging Records  and Securities Groups .

12.3.8 Show All Records

Shows all the records in the current Database view whether they are tagged or not.  This removed the
effect of any kind of filtering that may have been applied to the Database view.

Hotkey: Ctrl+A

 

12.3.9 Show Only Tagged Records

Shows only the tagged records in the current Database view.

Hotkey: Ctrl+Shift+A

12.3.10 Hide Tagged Records

Hides the tagged records in the current Database view.

12.3.11 Save Tagged Records to Securities Group...

A dialog box appears to save the tagged records in the current Database view to a Securities Group
under a name you supply.

See Securities Groups .

12.3.12 Open/Manage Securities Groups...

You can open a Securities Group and display only the records it contains in the current Database view.

See Securities Groups .

12.3.13 Export Tagged Records...

You can export data from Steele Expert into a file and import it into your spreadsheet, database,
graphing, or word processing program. Any selection of records and columns can be exported to a tab-
delimited text file.

Only the tagged records in a Database View will be copied to the export file. All columns in the current
View are exported, therefore you should display in the View only those columns that you want to
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export. Use the View Options to select the columns you want to export, or create a copy of the
Database view and customize it with only the columns and rows (via Filtering) that you need.

Once you have chosen the columns and records to export, select "Menu > Database > Export
Tagged Records...". The "Export Tagged Records  to file" dialog box appears.

Enter a file name for the exported file.

Select the file type (format) to which you want the data saved. The choices are as follows:

Tab-delimited (*.txt) format (recommended format as the most compatible and most accurately
imported by most programs),

Comma-separated (*.csv) format,

or Space-delimited (*.prn) format (for specialized application).

Select OK.

TIP: If you are exporting to another Windows application, you can use the Copy command ("Menu >
Edit > Copy" or press Ctrl+C) to copy the data from the Expert, and the Paste command (Ctrl+V) in the
receiving Windows application to paste the data.  See Export data to Excel or other software .

If you have tagged any records, they will be copied with the Copy command. If there are no tagged
records, the Copy command will only copy the current cell of the data table.

 

12.3.14 Print Reports for All Tagged Records...

Available only in Database views. The Expert will print a copy of the selected Report for each of
the tagged records. This option is only available for printing Graphs and Reports and must be invoked
from a Database view.

12.3.15 Create a User Column...

A dialog box appears where you can enter a name (e.g., Comments) for your user column. Then, a
column is created in the current Database view. You can now enter your own notes or comments for
any given record in the Database view.

You can save the column and any data you enter by selecting "Main menu > File > Save Portfolios/
Filters/Global Options".

12.3.16 Edit a User Column...

A dialog box appears where you can rename, copy, or delete your user columns.

You can save the column and any data you enter by selecting "Main menu > File > Save Portfolios/
Filters/Global Options".

12.4 Pages

12.4.1 Design Mode

Being in Design Mode while viewing a single-page report refers to the ability to edit (move, resize,
delete, etc.) objects (text boxes, tables, or graphs) on that report. To put a report in this editing mode,
first select it in the Pages List, then use one of the following methods:
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Select "Menu > Edit > Design Mode", or "Menu > Pages > Design Mode"
(You should see a check mark next to the Design Mode menu item to indicate that you are in
Design mode.),

or select the Design Mode toolbar icon

(A highlighted icon indicates that you are in Design Mode.)

When you click once on an object on the report while in Design Mode, eight “grips” appear along the
border of the object. When you double-click on an object in Design Mode, the Options...  dialog box
for that specific object appears on-screen.

12.4.2 Cut

Cuts the currently selected page or folder from the page list and places it on the clipboard.

 

12.4.3 Copy

Copies the currently selected page or folder from the page list and places it on the clipboard.

 

12.4.4 Paste

You can insert a page or folder from the clipboard AFTER the currently selected page or folder, provided
an Expert page or folder has been previously placed on the clipboard.

 

12.4.5 Delete

Deletes the currently selected page or folder from the page list.

 

12.4.6 Rename

Allows you to directly edit the currently selected page or folder name in the page list.

 

12.4.7 Set for Quick Access with F7

Designate the current page to go to when F7 is pressed, or a row is double-clicked in table (database)
view.  (Also when the Enter key is pressed in table view).

With this feature, you can select a report or graph you need to use a lot, and view it instantly from
anywhere by pressing the F7 key.  Pressing the F7 key a second time returns you to the page you
were viewing before.  That way, you can go back and forth between your favorite page and any other
page simply by pressing F7.  You can easily change the page you designate for quick access as often
as you need.

This setting is saved in the notebook file.  Therefore, each notebook can have a different quick access
report, graph or table report.
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12.4.8 Lock Securities

Applies to the current Page only. Locks the current Page so that the selected securities for the Page
remain unchanged during switching from Page to Page.

See Locking Securities on a Page .

12.4.9 Auto Size Page List

Resizes the Page List window so that all the items are entirely visible.

 

12.4.10 Hide Page List

Hides the Page List from view.

 

12.4.11 Page List Font...

Displays a Font Dialog box to select the font for the Page List.

 

12.4.12 Global Options...

Sometimes you may want to make changes that affect more than just the current Page. Perhaps
you’ve grown particularly fond of a font or you want to use different patterns or colors in your Graphs.
Global options allow you to make changes that affect all Pages.

Graph Colors Tab:

One of the global options available allows you to customize the colors and patterns of the bars (or
lines) used in Graphs. These changes will affect all Graphs in all Notebooks. Select Page...Global

Options..., the Global Options dialog box appears, choose the Graph Colors tab.

The Expert uses different sets of colors and patterns for displaying graphs on monochrome (black and
white) devices than for color devices (for most users the printer uses the monochrome settings while
the monitor uses the color settings). Additionally, there are different sets of colors and styles for line
charts than for bar and pie charts.

Settings

Choose the fund position whose style you would like to change. Styles are listed for each of the 16
possible funds in a graph.

Graph Type

Choose to modify the styles for either line or bar and pie charts.

Output Device

Choose either the monochrome or color settings. Most laser printers are monochrome (black and
white) and most screen displays are color.

Color

Change the color of the current setting.
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Pattern

Change the pattern of the current setting.

Once you have completed editing the Graph colors and patterns, select OK to accept the changes
and close the Graph Options dialog box, or edit another tab and then select OK. Choose Cancel to
lose all changes made.

Font Tab:

To change the font used in all Pages of the current Notebook, select Page...Global Options and choose
the Font tab.

Face Name

Type or select a font name. The Expert lists the fonts available with the current printer driver and
additional fonts installed in your system.

Size

Type or select a size. The sizes available depend on the printer and the selected font.

Bold

A checked box indicates bold style. A blank box indicates not bold style. And a grayed box
indicates the default value of no bold.

Italic

A checked box indicates italic style. A blank box indicates not italic style. And a grayed box
indicates the default value of no italic.

Once you have completed making font changes, select OK to accept the changes and close the
Global Options dialog box. Or edit another tab and then select OK. The font used in all Pages will
be changed, but the objects on the Report Pages will not be resized to fit the new font.

Settings Tab:

To change miscellaneous program settings, select Page...Global Options and choose the Settings tab.

Change the User Data Folder

The Steele Expert program needs a dedicated folder where the data files created by the user are
stored.  These files include notebook files containing reports, graphs and database views (with file
extension .exp), files that store the user's portfolios, filters and securities groups (with extension .
mem), etc.

Here you can change, move, create or rename that folder, although it is recommended you keep
the default folder originally created by the program.

If you change the user data folder, all your notebooks will be closed and you will have to open a
notebook again or create a new one by clicking "Menu/File/New notebook / Select Database...".

Allow Duplicate Funds In Portfolios

This setting allows you to enter the same fund more than once in a portfolio, which may be
necessary in certain situations to reflect positions that may be in the same security, but need to
be shown separately.
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12.4.13 New

12.4.13.1 Folder

Creates a new Folder in the page view. The Folder is placed below the item which is currently selected.
If the currently selected item is a Folder, you will be asked if you would like to insert the new Folder
within the currently selected Folder. After the Folder has been created, the Folder is given a default
name which you can edit.

12.4.13.2 Graph...

Creates a new Graph in the page view. The Graph is placed below the item which is currently selected.
If the currently selected item is a Folder, you will be asked if you would like to insert the new Graph
within the currently selected Folder. The Graph Options  dialog box appears. If you click OK, the
Graph is inserted in the page view and given a default name which you can edit.

12.4.13.3 Full-page Report...

Creates a new Report in the page view. The Report is placed below the item which is currently
selected. If the currently selected item is a Folder, you will be asked if you would like to insert the new
Report within the currently selected Folder. The Report Options  dialog box appears. If you click OK,
the Report is inserted in the page view and given a default name which you can edit.

12.4.13.4 Database View/Tabular Report...

Creates a new Database View in the page view. The Database View is placed below the item which is
currently selected. If the currently selected item is a Folder, you will be asked if you would like to insert
the new Database View within the currently selected Folder. The Database View Options  dialog box
appears. If you click OK, the Database View is inserted in the page view and given a default name
which you can edit.

12.4.14 Insert Object

12.4.14.1 Graph...

The Graph Options  dialog box appears. If you click OK, the Graph is placed on the currently
selected Report.

See Report Objects

12.4.14.2 Text Box...

A Text Box is a type of box that you can create on a Report in which text is placed. You can type
either literal text that you want to appear on the Report, or you can use Expert codes to make items
such as the current date or database date appear on the Report.

See Report Objects

To create a Text Box the current tab must be a Report Page. Select Pages…InsertObject...Text Box…,
the Text Box Options dialog box appears.
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12.4.14.3 Field Table...

A Field Table is a type of data table that you can create on a report that shows the field values for the
current fund. The table lists the values for the selected fund in the Field Table Options dialog box. The
field values that appear in the table are dependent upon the current fund. Use a Field Table when you
want to display only the data values for chosen fund.

Select Pages…Insert Object...Field Table. The Field Table Options dialog box appears showing the
Fields tab.

Double-click on any of the folders in the Database Fields list and check the check box of a field to add
it to the Field List (the fields that will be represented in the field table). If you want to show the values for
a fund other than fund number 1, choose the fund from the Show Fund list box.

Choose the Display tab. Enter the title and choose the alignment of the field headers and data (left,
right or center).

If you would like to use a different font, choose the Font tab and select the font, size, and appropriate
styles.

When you are done select OK to view the table in the report. The current fund values for the chosen
fields will be shown on the Report.

 
See Report Objects

12.4.14.4 Risks & Averages Table...

A Ranks & Averages Table is a type of data table that you can create on a Report that combines
averages and ranking information. Like the Ranks & Averages Report, the selected funds for this report
include all funds listed in the last View that was on-screen (not just base funds or tagged funds). The
following information is provided for each data field:

Value

The value of the current fund.

Avg

The average of the selected funds.

Rank

The relative position of the current fund when the selected funds are sorted by the data field. A “t” next
to the rank indicates that another selected fund has the same value and therefore the same rank
position.

Count

The number of selected funds that have a value for the data field.

Decile

Reflects groupings of percentile rankings. Thus a fund with a decile rank of 1 is in the top 10 percent of
all records within the selected group whereas a fund with a decile rank of 10 is in the bottom 10 percent
of the group.

The data that appears in the table is dependent upon the fields chosen in Edit Ranks & Averages
Table Data dialog box. To create a Ranks & Averages Table the current tab must be a Report Page.
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Select Pages…Insert Object…Ranks & Averages Table…. The Ranks & Averages Table Options dialog
box appears showing the Fields tab. Click Add to add the field selected in the Database Fields list to
the Field List (the fields that will be represented in the table). If you want to show the values for a fund
other than fund number 1, choose the fund from the Show Fund listbox.

Choose the Display tab. Enter the title and choose the alignment of the field values and data (left, right
or center). If you would like to use a different font, choose the Font tab and select the font, size, and
appropriate styles. When you are done select OK to view the table in the report. The values of the
chosen base fund will be shown in the table.

The section entitled “Report Tables” gives a detailed description of all the tab options available. To
make changes to a table at a later time, double-click on the table in Edit Mode and the Edit Data dialog
box appears.

See Report Objects

12.4.14.5 Comparison Table...

A comparison table is a type of Report table that shows up to sixteen field values. The table lists the
base funds’ as “Fund 1”, “Fund 2”, “Fund 3”, etc., respectively, followed by the value for each fund. Use
a comparison table when you want to see comparative values of the base funds.

Select Pages…Insert Object...Comparison Table… while viewing a Report. The Comparison Table
Options dialog box. To add a field to the table, choose the Fields tab. Highlight a field in the Database

Fields list and then select Add to add the field to the Field List (the fields that will be represented in the
table).

Choose the Display tab. Enter the title and choose the alignment of the field values and data (left, right
or center). If you would like to use a different font, choose the Font tab and select the font, size, and
appropriate styles. When you are done select OK to view the table in the report. The values of the base
funds will be shown on the Report.

 
See Report Objects

12.4.14.6 Portfolio Table...

A Portfolio Table is a type of data table that you can create on a Report that displays a Portfolio. The
table lists the funds for the Portfolio fund you specify. The values that appear in the table are dependent
upon the funds that make up the Portfolio fund.

To create a Portfolio Table the current tab must be a Report Page. Select Pages…Insert Object...

Portfolio Table. The Portfolio Options dialog box appears presenting four tabs - Portfolio, Columns,
Display, and Font. Make the necessary changes to the tabs and then select OK to accept all changes
or Cancel to cancel all changes.

 
See Report Objects

12.4.14.7 Image (Logo)...

The "Select An Image File" dialog appears with which you can choose an image file (.gif, .jpg, .bmp) to
place on the current report.

Its aspect ratio will be preserved automatically as you resize it.

Such an image may be a firm's logo, or any other graphic image that may enhance your reports or
presentations.

77

77

77



STEELE Mutual Fund Expert104

© 2024 Steele Systems, Inc.

We recommend that you keep all your report images in your "User Data Folder".  The Expert will first
look in the location stored for the image in the report, and if not found, it will look in the "User Data
Folder", and finally in the Expert program folder.  If the Expert cannot find a specific image file that is
referred to on a report, the image cannot be displayed.

 
See Report Objects

12.5 Portfolio

12.5.1 Create New Portfolio...

Creates a portfolio from the tagged funds in the currently selected Database View. You will be
prompted to name the newly created portfolio.

See Portfolio...Open Existing Portfolio...  , Portfolio Table Options

12.5.2 Open/Manage Portfolios...

Displays the Portfolio dialog box where you can enter data about the securities in your portfolio.

The Expert allows you to create a weighted average of any number of securities by creating a Portfolio.
You must supply either a dollar amount of each of the securities, the amount of shares held in each
securities, or the percent holdings of each securities (along with a total dollar amount). When you
create a Portfolio, a Portfolio record is added to the database and the portfolio’s performance numbers
are computed using the weighted average of the numbers in each of the securities.

Select the securities that you want to put in the Portfolio. If you are looking at a Database View, the
current record or the tagged records will be included. If you are viewing a Report or Graph Page, the
base securities will be included.

Select Portfolio...Create New Portfolio... from the menu. The Enter a Name for This Portfolio dialog box
appears. Enter a unique name for this Portfolio. Select OK. The Portfolio appears on-screen and the
Portfolio record is added to the database.

Portfolio Options

Allows you to modify all the options for this portfolio.

Add Security

Displays the "Select Securities" dialog box. Tag the securities you want to include in the portfolio. You
can rank any column in the "Select Securities" dialog box (see Ranking).

Delete Security

Deletes the current security from the portfolio.

Clear All

Erases all securities from the portfolio.

Copy All To Clipboard

Makes a copy of the current portfolio.
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Paste From Clipboard

Pastes the securities from the clipboard into the portfolio.

Print Portfolio

Prints the current portfolio.

Help

Displays Help about the Portfolio environment operations.

Close

Closes the Portfolio dialog box.

Security

The name of the securities included in the Portfolio.

Price

The price (NAV for mutual funds) is based on the date of the database in use.

Amount

Select Amount as the computation category and enter the dollar amounts in this column.

Shares

Select Shares as the computation category and enter the number of shares in this column.

Percent

Select Percentage as the computation category, enter a value in the Total Amount box and the
percentage for each security in the Percent column.

Enter the amount, the shares, or the percent and the total value for each security and press the Down

Arrow after each entry. To add more securities to the Portfolio, select Add and choose the desired
securities from the Select Securities dialog box.

You can reposition a selected row by holding Ctrl+Shift and using the Up or Down Arrow. You can
reposition a selected column by holding Ctrl+Shift and using the Right or Left Arrow.

To recall a Portfolio, select Portfolio...Open/Manage Portfolios. The Open/Manage Portfolios dialog box
appears. Select the name of the Portfolio. To delete a Portfolio, highlight the name of the Portfolio in
the Open/Manage Portfolios dialog box and select Delete from the Open/Manage Portfolios dialog box.
To copy a Portfolio, highlight the name and select Copy. After you enter a new name for the Portfolio, a
duplicate of the original is added to the Portfolio listing. To rename a fund, highlight the fund and select 
Rename.

See Portfolio Table Options
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12.6 Window

12.6.1 Cascade

Arranges all the opened active Notebooks in a cascaded format.

 

12.6.2 Tile

Arranges all the opened active Notebooks in a tiled format.

 

12.6.3 Arrange Icons

Arranges all the opened minimized Notebooks in an ordered format.

 

12.6.4 Close All

Closes all opened Notebooks.

 

12.6.5 1, 2, 3,..

This is a list of opened Notebooks by which you can choose one to become active.

 

12.7 Help

12.7.1 Help With This Page

Displays the help page associated with the currently selected page.

See Help

12.7.2 Online User's Guide

Invokes the Help System of the program.

 

12.7.3 Go to www.MutualFundExpert.com

Connects you directly to the Steele Mutual Fund Expert web site where you can download data and
program updates, find out about our latest development and features, get customer and technical
support, and, of course, provide us with feedback via e-mail.

 

12.7.4 Expert Tips

Displays a dialog box with frequently changing useful tips on the features of Steele Mutual Fund
Expert.
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12.7.5 License Agreement

Displays the help page associated with the License Agreement .

 

12.7.6 About STEELE Mutual Fund Expert...

Displays company and copyright information.

See Introduction to Steele Mutual Fund Expert   License Agreement
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13 Dialog Boxes

13.1 Database View Options [Columns]

All Columns In Database Order

Displays all the columns in the selected database in the original order.

Selected Columns

This tree view contains all the fields in the selected database grouped in folders. To open a folder,
simply double-click on the folder or press the Spacebar key after clicking once on it. The currently
displayed fields are marked with a check. Click to check or uncheck the columns you wish to appear in
the view, or use the Spacebar and arrow keys for rapid checking/unchecking. For detailed instructions
see Choose Columns to display .

None

Click this button to uncheck all columns before choosing the ones you want.

All

Click this button to check all columns.

 
Remember, you must have at least one column checked before you may choose OK. The new
columns will be inserted in the view at the location of the cursor.

13.2 Database View Options [Display]

Show:

Column Grid

Show the vertical lines that separate each column.

Row Grid

Show the horizontal lines that separate each row.

Row Numbers

Show the number bar in the left side.

Column Headers

Show the column header bar at the top of the view.

Column Headers:

Minimal

The smallest headers. Many are not wider than a few characters. Use this setting when printing to
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get the highest "density" of data on the page.

Short

Use these headers to get extra room on the screen and on reports where fund names need to be
column headers.

Descriptive

Full database field names. (the default)

Cell Margin

The inside margin of the cells and headers in points. Increase this value to have more room between
the text and the cell border.

Row Height

The height or all the cells in points. Its value is set automatically based on the font size you choose.
You can, however, increase this value (for example, to have more room for comment text) by holding
the Ctrl key down and placing the mouse pointer between rows in the row number column, then
dragging when the sizing cursor appears.

Colors:

Grid

The horizontal and vertical grid lines. (default Light Gray)

Text

The text inside each cell. (default Black)

Background

The color behind the cells. (default White)

Header

The background color of the column headers and number bar. (default Gray)

Cursor

The movable bar that show the current fund. (default Black)

Tag Marker

The markers that indicate a tagged fund. (default Red)

Fast Column Alignment

Aligns the column widths on an 8-pixel boundary. This will speed up horizontal scrolling greatly. You
should keep this checked unless you must precisely align the columns for printing.
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13.3 Filter Dialog Box

To view the filter for the current Database View page:

Click "Menu/Database/Filter the Database".

  or

Click the Filter button on the tool bar, or press (F8).

Filtering is a powerful way of isolating the funds that you are interested in seeing. Each Database View
 has its own filter, which contains a list of conditions that apply to the funds you are interested in.

The filter dialog box contains a list of all the selection conditions in the filter.

Add Condition

Add a condition  to the filter.

Delete Condition

Deletes the current condition. If you delete the last condition on a level, the Expert will reduce the entire
expression to the previous level.

Edit Condition

To edit the current condition.

Clear All Conditions

Deletes all current conditions.

Switch All And/Or

Changes all the ANDs to ORs and all the ORs to ANDs.

Undo Action

Undoes the most recent action.

Redo Action

Cancels the effect of the last undo.

Open/Manage Filters

Open any previously saved filter, including the ones build into the Expert. This will overwrite the
currently visible filter.  Here you can also copy, rename and delete filters you have created.

Save Filter

At any time, you may save a filter by clicking and entering a name. The saved filters are stored globally
and are accessible from any Database View or Notebook. Once you have memorized a filter, you may
use it in a another filter condition. See Adding A Condition To A Filter .

Print Filter

Print the current filter.

Stay On Screen
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Check this box to keep the filter dialog box visible after running the filter.

Long Descriptions

You may view the conditions in English or using mathematical symbols (>, <, =, etc.).

13.4 Filter Dialog Box [Add Condition]

Add Condition:

This specifies how the condition you are about to enter relates to the condition you are currently on.

Same Level: The next condition should have the same precedence (or weight) as the current
condition. If you are creating a simple filter, you may want to choose this setting (the default).

Subordinate: The next condition will be combined with the current condition into a nested
statement, equivalent to logical parentheses. The power of the combined statement will be the
same as that of the current condition.

Versus All: The next condition will be combined with the entire filter in parentheses. In other words,
the next condition will have as much weight as the whole current filter taken as one statement.

Relation:

This specifies how the next condition will relate to the current condition. Notice that you are only free to
choose the relation for the second condition, since you may not mix ANDs and ORs at the save level.

OR: Indicates that either the next condition OR the current condition must be satisfied.

AND: Indicates that both the next condition AND the current condition must be satisfied.

Type:

Specifies the type of condition you wish to create:

Field: The condition will contain a field, operator and value. See Adding A Field Condition .

Security Group: The condition will either include or exclude a previously memorized Security Group.
Use this condition if you would like each filtered security to have a relationship to an entire group of
securities.

Filter: (Advanced) The condition will either satisfy or not satisfy a previously saved filter. Filters may
be nested in complex ways with this option. Remember, that a filter may not refer to itself (even
indirectly through another filter.) The Expert will check for circular references.

 

13.5 Filter Dialog Box [Edit Field Condition]

Here you must specify a condition relating to a field of the database. The field belongs to the fund.
The value is what you specify.

 
Field: Choose a field in the database to serve as the basis of your condition.

 
Operator: The choices will depend on your choice of field.

 Text fields will have the following (including a choice of case sensitivity):
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Contains: Is the field contained anywhere in the value

Excludes: Is the field NOT contained anywhere in the value

Exact Match: Does the field exactly match the value

Starts With: Does the field start with the letters of the value

 Numeric fields will have the following operators:

=    Is the field exactly equal to the value

<>  Is the field not exactly equal to the value

>    Is the field greater than the value

<    Is the field less than the value

>=  Is the field greater than or equal to the value

<=  Is the field less than or equal to the value

Value:

Type in the value you wish to be compared with the field. For some fields you must select the value
from pre-defined choices. In this case, type ALT-S to select a value.

Include Blanks:

If this is checked, blank values will always result in a match for this condition. If not checked, blank
values will never result in a match.

Compare To:

Specifies how to compare the selected field:

Value: Compare the field to an absolute value (such as "3.0" or "A"). Use this type of comparison
when you know the level of performance you are looking for.

Security/Index: Compare the field to the current value of any other security or benchmark in the
database. For example, you can use this type of comparison when you would like your selection to
include securities with better performance than a certain benchmark.

 

 See Also: Adding A Condition To A Filter .

13.6 Find Value

You can perform a Find Value on any column in the database. You must first specify what column you
want to search. You do this by selecting the column (clicking on the column header). This moves the
cursor into the selected column.

Use one of the following methods to display the Find Value dialog box:

select Edit...Find (also available in the Shortcut Menu),

or press Ctrl+F,

or select the Find toolbar icon.

The Find Value dialog box appears.
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Value

Enter the value that you want to search for. The Expert searches for the first occurrence of the value
you enter (unless you specify the operator as “excludes”).

Operator (text fields)

Text fields will have the following operators

Contains 

Search for the first instance that contains the value.

Excludes

Search for the first instance that does not contain the value.

Exact Match

Search for the first instance that matches the value exactly.

Starts With

Search for the first instance that starts with the value.

Operator numeric fields)

Numeric fields will have the following mathematical operators:

=     Equal to

< >  Not equal to

>     Greater than

<     Less than

> =  Greater than or equal to

<=   Less than or equal to

Search From:

Top

Start search at the top of the database.

Cursor

Start search from the position where the cursor is located.

Find/Find Next

Find Next appears after the first search is completed. You can use the Find Next button to locate the
next instance of the search value.

When you select Find (or Find Next), the Expert finds and highlights the first (or next) instance of the
value that meets the criteria.
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13.7 Graph Options [Data]

Graph Type

Performance Graphs show returns for each time period.

Growth - Hypothetical Illustration Graphs show the growth of a hypothetical investment (the
default amount is $10,000).

Risk-Return shows the risk return profile of each fund in the group. The selected relative
benchmark is shown with “cross-hairs” through it for comparison. The securities in the upper left
corner tend to be the better performers since they have lower risk  (low volatility) and higher return
over the designated time period.

Rolling Returns shows a comparison of the 1, 3, 5, and 10-year returns. You can select to display
either Average or Total returns.

Rolling Returns - Short-Term shows a comparison of the 1, 3, 6, 9, and 12-month returns.

Portfolio Allocation shows the breakdown of the fund as a percentage of the portfolio.

Top-10 Sectors shows the top ten sectors of the fund.

Top-10 Securities shows the top ten securities of the fund.

Top-10 Countries shows the top ten securities of the fund.

Equity Sectors shows all the Equity Sectors of the fund portfolio.

Equity Super Sectors shows all the Equity Super Sectors of the fund portfolio.

Fixed-Income Sectors shows all the Fixed-Income Sectors of the fund portfolio.

Fixed-Income Super Sectors shows all the Fixed-Income Super Sectors of the fund portfolio.

Equity Style Breakdown - Detail shows complete breakdown by Capitalization/Value/Blend/
Growth.

Equity Style Breakdown - Market Capitalization shows breakdown by Large-Cap, Mid-Cap,
Small-Cap.

Equity Style Breakdown - Growth / Value shows breakdown by Value/Blend/Growth.

Up Market shows the Up Market Performance for the security.

Down Market shows the Down Market Performance for the security.

Full Cycle shows the Full Market Cycle Performance for the security.

Interval

- Monthly
- Quarterly
- Annual

Growth graphs only:

Growth graphs provide Hypothetical Illustrations of performance.
The horizontal axis labels in Growth graphs represent points in time as of the end of the stated
period. In other words, a "2015" label means 12/31/2015 11:59:59 pm.

Portfolios using monthly or quarterly intervals are not rebalanced to their original specified security
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weights. Portfolios using annual intervals are rebalanced to their original specified security weights
at the beginning of each year.

Initial Amount

Enter the initial amount to be invested.

Interval Amount

Enter an optional fixed amount to be added to the investment at each interval (yearly, quarterly,
monthly) in order to simulate systematic investment/savings.  A negative amount can be entered to
simulate systematic withdrawal.

Annual Rate

Enter an annual rate to be applied to the investment each interval (yearly, quarterly, monthly). This
rate can represent additional investing based not on a fixed amount, but on a rate such as the rate
of inflation. It can also be negative to represent management fees of an advisor or the erosion of a
forecast inflation rate. The annual rate will be automatically converted to quarterly or monthly based
on the selected interval, if the interval is other than yearly.

Subtract Front Load

Check  this if you want any front loads subtracted from the initial investment amount. For example,
a $10,000 investment with a 5% front-load will provide only $9,500 for investment. This is a more
realistic illustration of the return of front-loaded funds.

Start Date

Earliest Possible

This is the first date for which there is information available in the selected Database.

Newest Security In The List

The starting date of the youngest security in the list. Use this option for long-term growth graphs.

Oldest Security In The List

The starting date of the oldest security in the list (excluding benchmarks).

Other

Choose any date available in the selected Database.

End Date

Latest Possible

This is the latest date for which there is information available in the selected Database.

Other

Choose any date available in the selected Database.

Pick Main Benchmark allows you to select any record as a Main Benchmark to be used on the graph
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and with "Show Relative To Main Benchmark".

Show Relative To Main Benchmark subtracts the selected Benchmark data from the securities data
on the graph and shows the difference in performance.

Show Average instead of Total Returns When checked, it displays average (annualized) returns
instead of total returns. (Applies to Up Market, Down Market, Full Cycle, and Rolling Return graphs
only.)

Sort Securities By Performance
Check this box to show the securities in order of highest to lowest return.

See Also

Graph Options [Display]

Graph Options [Securities]

13.8 Graph Options [Securities]

Main Benchmark

Automatically adds the Main Benchmark to the list of securities. The Main Benchmark can be changed
for each graph in the Data tab of the Graph Options dialog.

Objective Average

Automatically adds the Objective average (matching the first security in the list) to the list of securities.

Category Average

Automatically adds the Category average (matching the first security in the list) to the list of securities.

Display them last will place the selected data series above last in the securities list.

Base Securities

The list of securities to be graphed. You can have up to 16 securities in the list, including the
automatically added benchmarks discussed above. If the graph is on a Report, this is the list of
securities to be added on top of the list of securities in the Report. Note that the total number of
displayed securities cannot exceed 16.

From Security

Display the securities starting at this number in the list.

To Security

Display the securities up to this number in the list.

Add
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Pick from a list of all the securities in the Database. You may tag securities in this list to add more
than one at a time. Press the INSERT key.

Del

Delete the highlighted security in the list. Press the DELETE key.

Edit

Change the highlighted security. Double-Click the security name.

Up

Move the highlighted security up. Press Ctrl+Shift+Up.

Down

Move the highlighted security down. Press Ctrl+Shift+Down.

 

See Also

Graph Options [Data]

Graph Options [Display]

13.9 Graph Options [Display]

Titles

Choose the titles for you graph. Click the AUTO checkbox to have the Expert choose for you. Title1 will
be the name of the graph type (e.g. “Performance”) and Title2 will be the name of the first security in
the securities list.

Type

Line

Markers connected with lines

Bar 

Flat vertical bars

3-D Bar

Solid vertical bars

Horizontal Bar

Flat horizontal bars

Pie

Flat pie with wedges representing percents. (Portfolio allocation graphs)
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3-D Pie

Solid pie (Portfolio allocation graphs)

Colors

Grid

The lattice of lines and tics that demark the numbers and categories on the graph.

Title

The top title line (Title 1)

Background

The area inside of the graph itself where the bars and lines are displayed.

Text

The Title2, legends and numbers.

Show Legend

Shows the legend at the bottom of the graph.

Logarithmic Scale

Shows the data on a logarithmic scale. This scale emphasizes relative changes in the data. For
example, the graph spacing from $20,000 to $50,000 is seen to be the same as that from $200 to
$500. The logarithmic scale is only available for growth line graphs.

Line Size

The size of the line connection markers (on a line graph) in typographic points.

Marker Size

The size of the markers (on a line graph) in typographic points.

See Also

Graph Options [Data]

Graph Options [Securities]

13.10 Graph Options [Graph Colors]

The Expert automatically uses different sets of colors and patterns for graphs on "Color/Grayscale"
devices than on "Black & White" (monochrome only) devices. There are also different settings for colors
and patterns for Bar & Pie charts than for Line charts.

Use Global Colors & Patterns

If checked, the selected graph uses the colors and patterns set within the Global Options [Graph
Colors]  dialog tab. If unchecked, the options below are enabled to allow the selected graph to have
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its own settings of colors and patterns. To change colors and patterns for all graphs, use the Global
Options dialog box.

Output Devices

Choose the colors and patterns that the program will use for "Color/Grayscale" and "Black & White"
modes of printers, plotters, PDF printers, etc. The program detects automatically whether an output
device is set to "Color/Grayscale" or "Black & White" only mode.

Black & White (monochrome) mode of a device uses only two "colors", black (ink or toner) and white
(no ink or toner, the color of the paper). Grayscale uses shades of gray and is better for reproducing
images by simulating colors. On laser and inkjet printers, the printer creates many shades of gray
using patterns of micro-dots of varying density. Most laser printers are either grayscale or color, not
black & white as some older printers.

If you want to print with your Black & White program settings on a color or grayscale printer, you
need to set the printer to "Black & White" mode in the Properties of the Print dialog box before you
print, or in that printer's Properties dialog in the "Devices and Printers" environment of Windows. This
way, the program will detect that the printer is in B&W mode.

If your printer is color or grayscale and does not have a "Black & White" setting in its Properties, you
can first print to a PDF file after changing the PDF printer properties to "Black & White", then print
the black and white PDF file.

If you want certain graphs to always be black and white, not color/grayscale, you can change all the
individual colors for "Color/Grayscale" to black  and differentiate each security by choosing different
patterns. This will achieve black & white graphs both on screen and on paper on any printer. With
grayscale-only printers, you can leave the colors unchanged and modify just the patterns for
interesting grayscale effects.

Colors & Patterns

You can specify color and pattern for each of the 16 possible securities on a graph. First, select the
security number whose color and pattern you would like to change.

Color  Change the color of the selected security number.

Pattern  Change the pattern of the selected security number.

13.11 Global Options [Graph Colors]

The Expert automatically uses different sets of colors and patterns for graphs on "Color/Grayscale"
devices than on "Black & White" (monochrome only) devices. There are also different settings for colors
and patterns for Bar & Pie charts than for Line charts.

Graph Types

Choose to modify the colors and patterns for Bar & Pie or Line charts.

Output Devices

Choose the colors and patterns that the program will use for "Color/Grayscale" and "Black & White"
modes of printers, plotters, PDF printers, etc. The program detects automatically whether an output
device is set to "Color/Grayscale" or "Black & White" only mode.

Black & White (monochrome) mode of a device uses only two "colors", black (ink or toner) and white
(no ink or toner, the color of the paper). Grayscale uses shades of gray and is better for reproducing
images by simulating colors. On laser and inkjet printers, the printer creates many shades of gray
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using patterns of micro-dots of varying density. Most laser printers are either grayscale or color, not
black & white as some older printers.

If you want to print with your Black & White program settings on a color or grayscale printer, you
need to set the printer to "Black & White" mode in the Properties of the Print dialog box before you
print, or in that printer's Properties dialog in the "Devices and Printers" environment of Windows. This
way, the program will detect that the printer is in B&W mode.

If your printer is color or grayscale and does not have a "Black & White" setting in its Properties, you
can first print to a PDF file after changing the PDF printer properties to "Black & White", then print
the black and white PDF file.

If you want certain graphs to always be black and white, not color/grayscale, you can change all the
individual colors for "Color/Grayscale" to black  and differentiate each security by choosing different
patterns. This will achieve black & white graphs both on screen and on paper on any printer. With
grayscale-only printers, you can leave the colors unchanged and modify just the patterns for
interesting grayscale effects.

Colors & Patterns

You can specify color and pattern for each of the 16 possible securities on a graph. First, select the
security number whose color and pattern you would like to change.

Color  Change the color of the selected security number.

Pattern  Change the pattern of the selected security number.

13.12 Global Options [Settings]

Change the User Data Folder

The Steele Expert program needs a dedicated folder where the data files created by the user are
stored.  These files include notebook files containing reports, graphs and database views (with file
extension .exp), files that store the user's portfolios, filters and securities groups (with extension .
mem), etc.

Here you can change, move, create or rename that folder, although it is recommended you keep the
default folder originally created by the program.

Allow Duplicate Securities In Portfolios

This setting allows you to enter the same security more than once in a portfolio, which may be
necessary in certain situations to reflect positions that may be in the same security, but need to be
shown separately.

13.13 Options [Font]

The font selection box allows you to put in blank values for the following items. A blank indicates the
default value. The default value is the value of the font at the next higher level. For instance, the font for
a table on a report will default to the font of the report itself. The default for the report is the font for the
Notebook. In this way, you may change the font independently for each item or Page, yet still maintain
the ability to change them all at once.

Face Name
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Type in the name of the face you would like to use or choose from the list. A blank in the name
indicates you would like to use the default.

Size

Type in the size of the font in points or choose from the list. A blank in the size indicates you would
like to use the default.

Bold

Check here for bold, uncheck for not bold, grayed for default.

Italic

Check here for italic, uncheck for not italic, grayed for default.

13.14 Page Setup Dialog Box

See Page Setup...

13.15 Portfolio Dialog Box

Portfolio Options

Shows the Portfolio Options  dialog box which will allow you to change the properties of the portfolio.

Add Security

Choose any number of securities from the selection dialog box. You can tag multiple records to add to
the portfolio clicking on the row number or by pressing the space bar on the keyboard.

Delete Security

Delete the highlighted row in the portfolio.

Clear All

Clear all securities in the portfolio.

Copy All To Clipboard

Copy the securities in this portfolio to the clipboard.

Paste From Clipboard

Paste securities from the clipboard into the portfolio. The Expert will remove any duplicate records or
portfolio records from the list automatically.

Print

Print the portfolio as it is shown on screen.

Help
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Get Help on the Portfolio environment.

Close

Close the Portfolio environment.

 

13.16 Portfolio Table Options [Portfolio]

Compute Using

Amount

Input security holdings in dollars. The number of shares and percent holding will be computed using
the current price (NAV for mutual funds) of the security. A total dollar amount of the portfolio will be
computed.

Shares

Input the amount of shares in each security. The dollar amount and percent will be computed using
the current price of the security. A total dollar amount of the portfolio will be computed.

Percent

Input the percent holding of each security and the total dollar amount of the portfolio. The dollar
amount and number of shares for each security will be computed using the current price.

Total Value

If you chose Compute Using “Percent” then you must supply a total value of the portfolio so that the
Expert may compute the Amount and Shares columns. Otherwise, this box will show the computed
total value.

Objective & Category

Choose the Objective & Category you would like the portfolio record to have. By default, the Objective
of the portfolio is “Portfolio”. Choose another objective if you would like your portfolio to be compared
with an appropriate Objective and Category Average in graphs.

See also Portfolio Dialog Box

13.17 Portfolio Table Options [Display]

Show:

Column Grid

Show the vertical lines that separate each column.

Row Grid

Show the horizontal lines that separate each row.
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Row Numbers

Show the number bar in the left side.

Column Headers

Show the column header bar at the top of the view.

Column Shading

Show the active (editable) column in white and the other columns in yellow

Cell Margin

The inside margin of the cells and headers in points. Increase this value to have more room between
the text and the cell border.

Colors:

Grid

The horizontal and vertical grid lines.

Text

The text inside each cell.

Background

The color behind the cells.

Header

The background color of the column headers and number bar.

Frame

The outside frame of the table.

 

13.18 Report Options [Securities]

Base Securities

The list of securities to be available to the items on the report. You can have up to 16 securities in the
list.

Add

Pick from a list of all the securities in the Database. You may tag records in this list to add more than
one at a time.

Del

Delete the highlighted security in the list.
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Edit

Change the highlighted security.

Up

Move the highlighted security up.

Down

Move the highlighted security down.

 

13.19 Report Options [Display]

View:

100%

Show the report at it full width and height. Some monitors may not be able to fully display the
report horizontally.

Page Width

Compress the report so it fits width-wise.

Full Page

Compress the report so that it fits onto the screen. The text may be difficult to read.

Show a Border

Show a thin gray border around the report.

Editing Options:

Show Ruler

Show the ruler along the top and left margin of the report. This can help in setting up a page.

Show Margins

Show black lines where the margins are placed. You may move the margins with the mouse while
in design mode.

Grid Settings:

Show Grid

Display the snap-grid on the page.

Snap To Grid

Constrain movements to a grid whose size is determined below.
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Horizontal, Vertical

Indicate the size of the snap-grid in inches.

 

13.20 Table Options [Display]

Alignment

Choose an alignment for the field value (second column).

Show:

Column Grid

Show the vertical lines that separate each column.

Row Grid

Show the horizontal lines that separate each row.

Row Numbers

Show the number bar in the left side.

Column Headers

Show the column header bar at the top of the view.

Cell Margin

The inside margin of the cells and headers in points. Increase this value to have more room between
the text and the cell border.

Row Height

The height or all the cells in points. Increase this value to have more room for comment text.

Orientation:

Columns

Field names are shown in the column headers and the values are shown in row 1.

Rows

Field names are shown in column1 and the corresponding values are shown in column2.

Colors:

Grid

The horizontal and vertical grid lines.

Text
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The text inside each cell.

Background

The color behind the cells.

Header

The background color of the column headers and number bar.

Cursor

The movable bar that show the current fund.

Frame

The outside frame of the table.

 

13.21 Table Options [Fields]

Field List

The list of database fields to show in the table.

Database Fields

This tree view contains the fields that you may add to the Field List above. These fields are grouped in
folders To open a folder, simply double-click on the folder. The fields which currently belong to the Field
List are checked. Click with the left mouse button to check or uncheck all the fields you wish to add or
remove in the Field List.

Show Security

Pick which of the securities in the report you would like to show. For instance, to create a comparison
Report you might want to set the tables on one side of the Report to show fund 1 and those on the
other side to show fund 2.

Alias

You may provide another name for the field by typing it here.

Omit Label for this Field

You may omit the field label with this option set.

Up

Move the highlighted field up. Type Ctrl+Shift+Up arrow.

Down

Move the highlighted field down. Type Ctrl+Shift+Down arrow.
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13.22 Text Box Options [Display]

Text

Type in the text you would like to display.

Horizontal

Choose a horizontal alignment: Left, Center or Right.

Vertical

Choose a vertical alignment: Top, Middle or Bottom.

Colors

Text

The color of the text itself.

Background

The color behind the text.

Border

The color of the line surrounding the text box.

Inner Margin

The amount that the text is inset from the edge of the box.

 

13.23 Winners Wizard

The Winners dialog box provides a quick way of choosing the top performers in several sub-categories
at once without having to create a filter, rank and then hide funds.

Main Category

Choose the category from which you would like to differentiate your funds. Some categories provide
more detailed information about a fund than others.

Performance Measure

This is the numeric field that is used to find the top performers. Choose 1 Month Return if your would
like to see this month’s winners. Choose 1-Year or 3-Year Return for a less volatile measure, or choose
Year-to-Date and create your own scorecard. The Winners Wizard will automatically rank the database
view by this measure you choose.

Show Only Top

Pick the percentage of funds that make the cut. For instance, if you choose 5%, only the top 5% of the
funds (as indicated by the Performance Measure) will be shown.

Method:
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Combine All Sub-Categories

Funds from all the checked sub-categories will be considered as a group The top funds will be chosen
from this group. This means that some sub-categories may have more funds than others in the final list.

Best from each Sub-Category

Top funds are chosen from each of the checked sub-categories first and then added to the final list.

Select One Or More Sub-Categories

Choose the sub-categories of funds that you want included in the final list.

Set Filter

Choose a memorized filter to add selection criteria. This ensures that the results of the winners search
will also match the conditions of the filter. If you want all your winners to have no load, choose the “No
Load Funds” filter.
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14 Shortcut Keys

14.1 Key Search

KeySearch movement allows you to move to any column in the View quickly. Pressing any individual
letter or number moves the cursor to the next column header that begins with that letter or number. If
there is more than one column header beginning with that character, subsequent key presses move the
cursor through all of them, in a circular manner.

For example, if you want the “3-Year Average” column shown on-screen, type the number 3. If the
cursor first moves to a different column that begins with the number “3”, press 3 again, and again if
necessary, until the cursor is moved into the desired column.

 

14.2 Page List Commands

You can drag-and-drop with the mouse any page or folder into any other to better organize your mutual
fund information to suit your exact purposes.

You may right-click on a page to get a shortcut menu of page commands.

Hot Keys

F1 Displays this Help topic.

F2 Renames the currently selected page or folder.

Ctrl+X, Del Cuts the currently selected page or folder and places it on the clipboard.

Ctrl+C Copies the currently selected page or folder to the clipboard.

Ctrl+V Pastes a page or folder, if available, from the clipboard after the currently selected page or
folder.

 

14.3 Hot-Keys

The Expert uses short-cut keys which correspond to the most frequently used menu items. Some hot-
keys are global and work with the Expert (and all other Windows applications). Some hot-keys work
with all pages (Databases, Reports and Graphs) and some are specific to each type of page. The hot-
keys are shown to the right of the menu-item they represent.

Global

Ctrl+TAB  Switch among open Notebooks

Ctrl+F4  Close an open Notebook

Alt+F4  Close the program

Current Notebook

Ctrl+S  Save the current Notebook to disk

Ctrl+O  Open an existing Notebook

Ctrl+P  Print the current Page
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Ctrl+T  Set options for the current Page

Ctrl+Bksp Return to the previous Page

Ctrl+Up  Go to the previous record in the Page

Ctrl+Dn  Go to the next record in the Page

Ctrl+X  Copy selection to the clipboard, and delete it

Ctrl+C  Copy selection to the clipboard

Ctrl+V  Paste the items from the clipboard into the Notebook

Database Page

F7  Toggle between the current page and the Fund Detail Report page

F5  Toggle between the current page and the Database page

F8  Filter the database

Ctrl+A  Show All Records in the database

Ctrl+Shift+A  Show Only Tagged Records

Ctrl+R  Change primary ranking  to the current column

Ctrl+Shift+R  Add current column to the ranking hierarchy

Ctrl+F  Find a value in the specified column

Ctrl+H  Hide the current column

Ctrl+W  Winners  dialog box

Ctrl+Shift+Right  Move current column to the right

Ctrl+Shift+Left  Move current column to the left

Space  Tag  the current record

Report Page

Ctrl+E  Enter edit mode for the currently selected table

DEL  Delete all selected items

Ctrl+Shift+Arrow  Move the current selection up, down, left or right

Shift+Arrow  Make current selection larger or smaller
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15 Data Definitions

15.1 Database Fields

The following is a list of definitions for the Database fields:

General Fund Information

Investment Objective

Investment Category

Star Rating

ABCDE Ratings

Other SEC Data Fields

Management

Senior Portfolio Manager

Management Company Code

Management Company Name

Date portfolio manager started

Portfolio Information

Net Asset Value

Portfolio Turnover Rate

Weighted Average Maturity

Portfolio Allocation Breakdown

Total Net Assets

Fees and Expenses

Expense Ratio: Management Fees

Purchasing Information

Open - Accepting New Funds?

Minimum Purchase Amounts

Minimum IRA Purchase Amounts

Telephone Switching

MaxLoad, MinLoad - Maximum, Minimum Sales Charges

Toll-Free & In-state Telephone Numbers

Short-Term Performance

1, 3, 6, 9 and 12 Month Returns

12-Month Yield

Year-To-Date Return

135

138

142

164

165

195

177

178

177

177

180

180

191

180

180

191

193

193

193

194

192

194

194

195

194
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Long-Term Performance

SEC Returns

Calendar Year Returns

Annualized Returns: 3, 5, 10, 15, & 20-Year

Total Returns: 3, 5, 10, 15, & 20-Year

Risk and Statistics

Beta

Alpha

r²

Monthly Mean

Monthly Standard Deviation

Volatility Group

Sharpe Measure of Performance

Treynor Measure of Performance

Annualized Standard Deviation

Number of Months Used

 

15.2 General Fund Information

Name

The name of the investment product, or benchmark (including investment objective or category
averages).

Full Name

The legal name of the investment product.  This field is more suitable for precise name-based filtering.

Symbol

The symbol a fund or stock is listed and traded under on an exchange. 

ID Number, Security ID, Policy ID

Unique ID numbers are assigned to each investment vehicle or benchmark. These identifiers are most
likely to stay with the investment vehicle throughout its lifetime. Name and Symbol may change
periodically.

Share Class

This indicates the type of share class for open-end funds. Shares of the same fund that offer different
shareholder rights and obligations, such as different fee and load charges. Common share classes are
A (front-end load), B (deferred fees), C (no sales charge and a relatively high annual 12b-1 fee, such as
1.00%). Multi-class funds hold the same investment portfolio for all classes, and differ only in their
surrounding fee structure.

197

196

196

196

200

200

201

203

203

205

204

204

203

199
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Oldest Share Class (Y/N)

It identifies whether this is the oldest share class for a mutual fund. This allows users to evaluate a
series of multi-class funds by looking at one representative share class for each unique portfolio. You
can add this condition to your filter to ensure that it only contains unique mutual fund portfolios. If
several classes of the same fund were started at the same time, only one of them is designated as the
oldest share class.

Oldest Share Class Security ID

The Security ID of the oldest share class for each mutual fund. This allows users to evaluate a series of
multi-class funds by identifying  all the share classes that are represented by the same unique
portfolio.

ETF (Exchange Traded Fund)

Is a fund traded on a stock market exchange? (Y/N)

Inception Date

The date on which an investment product began its operations.  For funds, this information is taken
directly from the prospectus.

Incorporated

The year in the inception date of the investment product.

Years Since Inception

The number of years (to 2 decimal places) since the inception date of the investment product.

Fund Family

Most funds belong to a family. These funds share certain characteristics and some families allow
transfer of funds among members without fees.

Web Site Address

The Web site address (URL) of the fund family of a given fund. Clicking on the Internet Explorer icon on
the toolbar will point the default internet browser to the web site of the investment vehicle.

State

The state the investment product is based in.

15.3 Fund Characteristics

These mutual fund characteristics can be used as Y/N flags to facilitate filtering and zeroing in on the
desired funds.

Fund of Funds

A fund that specializes in buying shares in other mutual funds rather than individual securities. Quite
often this type of fund is not discernible from its name alone, but rather through prospectus wording (i.e.
the fund's charter).
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Index Fund

A fund that tracks a particular index and attempts to match returns. While an index typically has a
much larger portfolio than a mutual fund, the fund's management may study the index's movements to
develop a representative sampling, and match sectors proportionately.

Enhanced Index Fund

A fund that pursues an enhanced index strategy. These funds, like index funds, attempt to match an
index's performance. Unlike index funds, however, enhanced index funds attempt to better the index by
either adding value or reducing volatility through selective stock-picking.

Socially Responsible ESG

A fund that selectively invests based on certain non-economic principles. Such funds may make
investments based on such issues as environmental responsibility, human rights, or religious views. A
socially conscious fund may take a proactive stance by selectively investing in, for example,
environmentally-friendly companies, or firms with good employee relations. This group also includes
funds that avoid investing in companies involved in promoting alcohol, tobacco, or gambling, or in the
defense industry.

A fund is considered a "Sustainable Investment" if it is described as focusing on sustainability, impact,
or environmental, social, and governance (ESG) factors in its prospectus or other regulatory filings.

Life Cycle

This indicates if the fund is geared toward investors of a certain age or with a specific time horizon for
investing. It is used to indicate a 'glide path' fund where the allocation shifts over time.

Hedge Fund

This indicates if the fund is a hedge fund.

Institutional Only

This indicates if the product is offered to institutional clients only.

Master-Feeder

A master-feeder (also known as hub and spoke) structure consists of a series of feeder funds that
invest their assets in a single master portfolio that is set up as a partnership or corporation.  The feeder
(spoke) funds are partners of the master (hub) fund.  This structure allows capital gains and income to
pass from the master to the feeder in many different sales formats.  Due to its efficiency, a number of
fund companies have adopted this method.

HOLDRS

(Holding Company Depository Receipts) are trust–issued receipts that represent an investor’s
ownership of a specific group of securities.

Buying HOLDR exchange traded funds looks, feels, and costs different than other ETFs.

Essentially, a HOLDR is a static basket of stocks selected from a particular industry. As a result,
HOLDRs do not track an underlying index like ETFs, and represent a rather narrow slice of an industry.
Not only are HOLDRs completely unmanaged, their components almost never change. Furthermore, if
a company is acquired and removed from a HOLDR, its stock is not replaced. This can result in even
more concentration and added risk. In contrast, indexes that ETFs invest in can change and rebalance
with some regularity, and generally contain more components.

Unlike ETFs, each company determines the composition of each HOLDR, and the individual stocks'
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initial weighting. One HOLDR can vary radically from another. For example, stocks in some HOLDRs
are initially equally-weighted, while other HOLDRs' allocations are based on such parameters as
market-cap, liquidity, and price/earnings, among others.

Leveraged Fund

This indicates if the fund is leveraged.  An ETF is classified as leveraged if it is identified as such under
the Investment Objective or the Investment Strategy section of the prospectus. A Closed-End fund is
identified as leveraged if it has a leverage % greater than zero.  

Inverse Fund

Indicates if an ETF uses a strategy of short selling, betting on the underlying index's decline.  The
strategy aims to provide the opposite performance to the benchmark. Therefore, inverse ETF is a
negative bet on the sector index and aims to provide a daily percentage movement opposite to it.  If, for
example, the sector index rises by 1%, the inverse sector ETF should fall by 1%; and if the sector
index falls by 1%, the inverse sector ETF should rise by 1%.

Dividend Yield Fund

Dividend Yielding ETFs hold securities with dividend growth. These are usually ETFs selected and
weighted by their cash dividend records and are another alternative for ETF investors looking for yield
with quality.

15.4 Objective

The Investment Objective is obtained from a fund’s prospectus and describes the investment approach
and desired results that a fund seeks to follow. Investment Objectives can include the types of
securities, type of companies, and term to maturity of securities (for fixed income investments) that a
fund would invest in to achieve its goals. The goals of a fund may include: current income, capital
appreciation, a combination of income and appreciation, tax-free income, etc.

Broad Category

It describes the most general category of a fund, such as Equity, Fixed Income, Allocation, Convertible,
Money Market, Alternative, Commodities, Miscellaneous, Tax Preferred, Property, and Index (which
identifies all benchmarks).

U.S. Category Group

The U.S. Category Group classifies funds as U.S. Equity, International Equity, Sector Equity,
Commodities, Allocation, Taxable Bond, Municipal Bond, Money Market and Alternative. (The
Alternative group includes fund categories such as Bear Market, Currency, Long-Short, Market
Neutral).

INVESTMENT OBJECTIVES

Aggressive Growth

Funds that seek rapid growth of capital and that may invest in emerging market growth companies
without specifying a market capitalization range. They often invest in small or emerging growth
companies and are more likely than other funds to invest in IPO's or in companies with high price/
earnings and price/book ratios. They may use such investment techniques as heavy sector
concentrations, leveraging, and short-selling.
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Asset Allocation

Funds that seek income and capital appreciation. Managers often use a flexible combination of stocks,
bonds, and cash; some, but not all, shift assets frequently based on analysis of business-cycle trends.

Balanced

Funds that seek both income and capital appreciation by investing in a generally fixed combination of
stocks and bonds. These funds generally hold a minimum of 25% of their assets in fixed-income
securities at all times.

Convertible Bond

Funds that invest primarily in bonds and preferred stocks that can be converted into common stocks.

Corporate Bond - General

Funds that seek income by investing in fixed-income securities, primarily investment-grade corporate
bonds.

Corporate Bond - High Quality

Funds that seek income by investing at least 65% of their assets in corporate debt securities rated A
or higher. They generally maintain average ratings of AA or better.

Corporate Bond - High Yield

Funds that seek income by generally investing 65% or more of their assets in bonds rated below BBB.
The price of these issues is generally affected more by the condition of the issuing company (similar to
a stock) than by the interest-rate fluctuation that usually causes bond prices to move up and down.

Diversified Emerging Markets

Funds that seek capital appreciation by investing primarily in equity securities issued in emerging
markets worldwide. These funds generally do not concentrate their investments in any one region.

Equity-Income

Funds that are expected to pursue current income by investing at least 65% of their assets in dividend-
paying equity securities.

Europe Stock

Funds that generally invest at least 65% of assets in equity securities of European issuers.

Foreign Stock

Funds that invest primarily in equity securities of issuers located outside the United States.

Government Bond - ARM (Adjustable-Rate Mortgage)

Funds that invest at least 65% of their assets in mortgage or mortgage-related securities with
adjustable coupons. These securities are usually backed by the U.S. government.

Government Bond - General

Funds that pursue income by investing in a combination of mortgage-backed securities, Treasuries,
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and agency securities.

Government Bond - Mortgage

Funds that seek income by generally investing at least 65% of their assets in securities backed by
mortgages, such as securities issued by the Government National Mortgage Association (GNMA), the
Federal National Mortgage Association (FNMA), and the Federal Home Loan Mortgage Corporation
(FHLMC).

Government Bond - Treasury

Funds that seek income by generally investing at least 80% of their assets in U.S. Treasury securities.

Growth

Funds that pursue capital appreciation by investing primarily in equity securities. Current income, if
considered at all, is a secondary concern.

Growth and Income

Funds that seek growth of capital and current income. Investments are typically selected for both
appreciation potential and dividend-paying ability.

Multiasset-Global

Funds that seek total returns by investing in varying combinations of equities, fixed-income securities,
and other asset classes. These funds may invest a significant portion of assets in securities of foreign
issuers.

Multisector Bond

Funds that seek income by diversifying their assets among several fixed-income sectors, such as U.S.
government obligations, foreign bonds, and high-yield domestic debt securities.

Municipal Bond-California

Funds that seek income by investing primarily in bonds exempt from California and federal income
taxes.

Municipal Bond-National

Funds that seek income that is exempt from federal income tax by investing primarily in bonds issued
by any state or municipality.

Municipal Bond-New York

Funds that seek income by investing primarily in bonds exempt from New York City, New York State,
and federal income taxes.

Municipal Bond-Single State

Offerings that seek income by investing primarily in bonds exempt from the income tax of the federal
government and of a single state other than New York or California.

Pacific Stock

Funds that invest primarily in equity securities of issuers located in countries in the Pacific Rim,
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including Japan, China, Hong Kong, Malaysia, Singapore, New Zealand, and Australia.

Small Company

Funds that seek capital appreciation by investing primarily in stocks of companies with market
capitalizations of less than $1 billion. In this objective, income payments from dividends are unlikely.

Specialty Communications

Funds that seek capital appreciation by investing primarily in equity securities of companies engaged in
the development, manufacture, or sale of communications products or services.

Specialty Financial

Funds that pursue capital appreciation by investing primarily in equity securities of financial-services
companies, including banks, brokerage firms, and insurance companies.

Specialty Health

Funds that seek capital appreciation by investing primarily in equity securities of health-care
companies, including drug manufacturers, hospitals, and biotechnology firms.

Specialty Natural Resources

Funds that seek capital appreciation by investing primarily in equity securities of companies involved in
the exploration, distribution, or processing of natural resources.

Specialty Precious Metals

Funds that pursue capital appreciation by investing primarily in equity securities of companies engaged
in the mining, distribution, or processing of precious metals.

Specialty Real Estate

Funds that seek capital appreciation from real-estate-related equity securities.

Specialty Technology

Funds that seek capital appreciation by investing primarily in equity securities of companies engaged in
the development, distribution, or servicing of technology-related equipment or processes.

Specialty Unaligned

Funds in this objective seek capital appreciation by concentrating their investments in a single industry
or sector other than those described by other Specialty objectives.

Specialty Utilities

Funds that seek capital appreciation by investing primarily in equity securities of public utilities
including electric, gas, and telephone-service providers. This group includes funds that invest primarily
in global communications.

World Bond

Funds that seek current income with capital appreciation as a secondary objective by investing
primarily in debt obligations issued throughout the world. These bonds are frequently foreign
government issues.
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World Stock

Funds that invest primarily in equity securities of issuers located throughout the world, while
maintaining a percentage of assets (normally 25% to 50%) in the United States.

Geographic Areas

United States of America
Canada
North America
Global
Global ex USA
Global Emerging Markets
Europe
Asia Pacific
Asia Pacific ex Japan
China
Japan
Latin America

15.5 Category

In an effort to distinguish funds by what they own, as well as by their prospectus objectives and styles,
Morningstar developed these Categories. While the prospectus objective identifies a fund's investment
goals based on the wording in the fund prospectus, the Category identifies funds based on their actual
investment styles as measured by their underlying portfolio holdings (portfolio and other statistics over
the past three years). The categories help investors identify the top-performing funds, assess potential
risk, and build well-diversified portfolios.

The driving principles behind the classification system are as follows:

Individual portfolios within a category invest in similar types of securities and therefore share the
same risk factors (e.g. style risk, prepayment risk).

Individual portfolios within a category can, in general, be expected to behave more similarly to one
another than to portfolios outside the category.

The aggregate performance of different categories differs materially over time.

Categories have enough constituents to form the basis for reasonable peer group comparisons.

The distinctions between categories are meaningful to investors and assist in their pursuit of
investing goals.

In the United States, categories map into the following U.S. Category Groups and Categories:

U.S. Category Group / Category Name

U.S. Equity

Large Value
Large Blend
Large Growth
Mid-Cap Value
Mid-Cap Blend
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Mid-Cap Growth
Small Value
Small Blend
Small Growth
Leveraged Net Long

Sector Equity

Communications
Consumer Cyclical
Consumer Defensive
Energy Limited Partnership
Equity Energy
Equity Precious Metals
Financial
Global Real Estate
Health
Industrials
Infrastructure
Natural Resources
Real Estate
Technology
Utilities
Miscellaneous Sector 

Allocation 

Conservative Allocation
Moderately Conservative Allocation
Moderate Allocation
Moderately Aggressive Allocation
Aggressive Allocation
Convertibles 
Global Allocation 
Tactical Allocation 
Target-Date 2000-2010
Target-Date 2015 
Target-Date 2020 
Target-Date 2025 
Target-Date 2030 
Target-Date 2035 
Target-Date 2040 
Target-Date 2045 
Target-Date 2050 
Target-Date 2055 
Target-Date 2060 
Target-Date 2065+ 
Target-Date Retirement 

International Equity

Foreign Large Value 
Foreign Large Blend 
Foreign Large Growth 
Foreign Small/Mid-Value 
Foreign Small/Mid-Blend 
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Foreign Small/Mid-Growth 
Global Large-Stock Growth 
Global Large-Stock Blend 
Global Large-Stock Value 
Global Small/Mid Stock 
Diversified Emerging Markets 
Diversified Pacific/Asia 
Miscellaneous Region 
Europe Stock 
Latin America Stock 
Pacific/Asia ex-Japan Stock 
China Region 
India Equity 
Japan Stock  

Nontraditional Equity

Long-Short Equity 
Derivative Income
Equity Hedged
Defined Outcome

Alternative

Macro Trading 
Event Driven 
Relative Value Arbitrage 
Multistrategy
Equity Market Neutral
Digital Assets

Miscellaneous

Trading—Leveraged Commodities 
Trading—Inverse Commodities 
Trading—Leveraged Debt 
Trading—Inverse Debt 
Trading—Leveraged Equity 
Trading—Inverse Equity 
Trading—Miscellaneous 

Commodities

Commodities Broad Basket 
Commodities Focused 

Taxable Bond

Long Government 
Intermediate Government 
Short Government 
Inflation-Protected Bond 
Long-Term Bond 
Intermediate Core Bond 
Intermediate Core-Plus Bond 
Short-Term Bond 
Ultrashort Bond 
Bank Loan 
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Stable Value 
Corporate Bond 
Preferred Stock 
High-Yield Bond 
Multisector Bond 
Global Bond 
Global Bond-USD Hedged
Target Maturity
Emerging-Markets Bond
Emerging-Markets Local-Currency Bond
Nontraditional Bond
Single Currency
Miscellaneous Fixed Income
Short-Term Inflation Protected Bond

Municipal Bond

Muni National Long 
Muni National Intermediate  
Muni National Short 
High-Yield Muni 
Muni Single State Long 
Muni Single State Intermediate 
Muni Single State Short 
Muni California Long 
Muni California Intermediate 
Muni Massachusetts 
Muni Minnesota 
Muni New Jersey 
Muni New York Long 
Muni New York Intermediate 
Muni Ohio 
Muni Pennsylvania 
Muni Target Maturity

Money Market

Money Market—Taxable 
Money Market—Tax-Free 
Money Market—Non-40 Act 
Prime Money Market

Definitions

U.S. Equity

Large Value 

Large-value portfolios invest primarily in big U.S. companies that are less expensive or growing more
slowly than other large-cap stocks. Stocks in the top 70% of the capitalization of the U.S. equity
market are defined as large cap. Value is defined based on low valuations (low price ratios and high
dividend yields) and slow growth (low growth rates for earnings, sales, book value, and cash flow). 

Large Blend 

Large-blend portfolios are fairly representative of the overall U.S. stock market in size, growth rates, and
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price. Stocks in the top 70% of the capitalization of the U.S. equity market are defined as large cap.
The blend style is assigned to portfolios where neither growth nor value characteristics predominate.
These portfolios tend to invest across the spectrum of U.S. industries, and owing to their broad
exposure, the portfolios' returns are often similar to those of the S&P 500 Index. 

Large Growth 

Large-growth portfolios invest primarily in big U.S. companies that are projected to grow faster than
other large-cap stocks. Stocks in the top 70% of the capitalization of the U.S. equity market are
defined as large cap. Growth is defined based on fast growth (high growth rates for earnings, sales,
book value, and cash flow) and high valuations (high price ratios and low dividend yields). Most of these
portfolios focus on companies in rapidly expanding industries. 

Mid-Cap Value 

Some mid-cap value portfolios focus on medium-size companies while others land here because they
own a mix of small-, mid-, and large-cap stocks. All look for U.S. stocks that are less expensive or
growing more slowly than the market. Stocks in the middle 20% of the capitalization of the U.S. equity
market are defined as mid-cap. Value is defined based on low valuations (low price ratios and high
dividend yields) and slow growth (low growth rates for earnings, sales, book value, and cash flow). 

Mid-Cap Blend 

The typical mid-cap blend portfolio invests in U.S. stocks of various sizes and styles, giving it a middle-
of the-road profile. Most shy away from high-priced growth stocks but aren't so price-conscious that
they land in value territory. Stocks in the middle 20% of the capitalization of the U.S. equity market are
defined as mid-cap. The blend style is assigned to portfolios where neither growth nor value
characteristics predominate. 

Mid-Cap Growth 

Some mid-cap growth portfolios invest in stocks of all sizes, thus leading to a mid-cap profile, but
others focus on midsize companies. Mid-cap growth portfolios target U.S. firms that are projected to
grow faster than other mid-cap stocks, therefore commanding relatively higher prices. Stocks in the
middle 20% of the capitalization of the U.S. equity market are defined as mid-cap. Growth is defined
based on fast growth (high growth rates for earnings, sales, book value, and cash flow) and high
valuations (high price ratios and low dividend yields). 

Small Value 

Small-value portfolios invest in small U.S. companies with valuations and growth rates below other
small-cap peers. Stocks in the bottom 10% of the capitalization of the U.S. equity market are defined
as small cap. Value is defined based on low valuations (low price ratios and high dividend yields) and
slow growth (low growth rates for earnings, sales, book value, and cash flow). 

Small Blend 

Small-blend portfolios favor U.S. firms at the smaller end of the market-capitalization range. Some aim
to own an array of value and growth stocks while others employ a discipline that leads to holdings with
valuations and growth rates close to the small-cap averages. Stocks in the bottom 10% of the
capitalization of the U.S. equity market are defined as small cap. The blend style is assigned to
portfolios where neither growth nor value characteristics predominate. 

Small Growth 

Small-growth portfolios focus on faster-growing companies whose shares are at the lower end of the
market-capitalization range. These portfolios tend to favor companies in up-and-coming industries or
young firms in their early growth stages. Because these businesses are fast-growing and often richly
valued, their stocks tend to be volatile. Stocks in the bottom 10% of the capitalization of the U.S.
equity market are defined as small cap. Growth is defined based on fast growth (high growth rates for
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earnings, sales, book value, and cash flow) and high valuations (high price ratios and low dividend
yields). 

Leveraged Net Long 

Leveraged net long portfolios seek income by establishing long and short positions in securities. The
most common strategy for leveraged net long portfolios is to take long positions in securities that have
been identified as attractive and short positions in securities that have been identified as overvalued.
These portfolios typically hold long positions in securities with an aggregate value of up to 130% of its
net assets. In addition, these portfolios will establish short positions in securities with a market value of
up to 30% of its net assets. The net long exposure therefore remains 100%, but it is a leveraged
exposure. This category is used only in Morningstar’s custom fund and separate account databases. 

Sector Equity

Communications

Communications portfolios concentrate on telecommunications and media companies of various kinds.
Most buy some combination of cable television, wireless-communications, and communications
equipment firms as well as traditional phone companies. A few favor entertainment firms, mainly
broadcasters, film studios, publishers, and online service providers. 

Consumer Cyclical 

Consumer cyclical portfolios seek capital appreciation by investing in equity securities of U.S. or non-
U.S. companies in the consumer cyclical sector. 

Consumer Defensive 

Consumer defensive portfolios seek capital appreciation by investing in equity securities of U.S. or non-
U.S. companies that are engaged in the manufacturing, sales, or distribution of consumer staples. 

Energy Limited Partnership 

Energy Limited Partnership funds invest a significant amount of their portfolio in energy master limited
partnerships. These include but are not limited to limited partnerships specializing in midstream
operations in the energy industry. 

Equity Energy 

Equity energy portfolios invest primarily in equity securities of U.S. or non-U.S. companies who
conduct business primarily in energy-related industries. This includes and is not limited to companies
in alternative energy, coal, exploration, oil and gas services, pipelines, natural gas services, and
refineries. 

Equity Precious Metals 

Precious-metals portfolios focus on mining stocks, though some do own small amounts of gold bullion.
Most portfolios concentrate on gold-mining stocks, but some have significant exposure to silver-,
platinum-, and base-metal-mining stocks as well. Precious-metals companies are typically based in
North America, Australia, or South Africa. 

Financial 

Financial portfolios seek capital appreciation by investing primarily in equity securities of U.S. or non-U.
S. financial-services companies, including banks, brokerage firms, insurance companies, and
consumer credit providers. 

Global Real Estate 

Global real estate portfolios invest primarily in non-U.S. real estate securities but may also invest in U.
S. real estate securities. Securities that these portfolios purchase include: debt securities, equity
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securities, convertible securities, and securities issued by real estate investment trusts and REIT-like
entities. 

Portfolios in this category also invest in real estate operating companies. 

Health 

Health portfolios focus on the medical and health-care industries. Most invest in a range of companies,
buying everything from pharmaceutical and medical-device makers to HMOs, hospitals, and nursing
homes. A few portfolios concentrate on just one industry segment, such as service providers or
biotechnology firms. 

Industrials

Industrial portfolios seek capital appreciation by investing in equity securities of U.S. or non-U.S.
companies that are engaged in services related to cyclical industries. This includes and is not limited
to companies in aerospace and defense, automotive, chemicals, construction, environmental services,
machinery, paper, and transportation. 

Infrastructure 

Infrastructure equity funds invest more than 60% of their assets in stocks of companies engaged in
infrastructure activities. Industries considered to be part of the infrastructure sector include: oil & gas
midstream; waste management; airports; integrated shipping; railroads; shipping & ports; trucking;
engineering & construction; infrastructure operations; and the utilities sector. 

Natural Resources 

Natural-resources portfolios focus on commodity-based industries such as energy, chemicals,
minerals, and forest products in the United States or outside of the United States. Some portfolios
invest across this spectrum to offer broad natural-resources exposure. Others concentrate heavily or
even exclusively in specific industries. Portfolios that concentrate primarily in energy-related industries
are part of the equity energy category. 

Real Estate 

Real estate portfolios invest primarily in US real estate investment trusts of various types. Securities
that these portfolios purchase include: debt securities, equity securities, convertible securities, and
securities issued by real estate investment trusts and REIT-like entities. Some portfolios in this
category also invest in real estate operating companies.

Technology

Technology portfolios buy high-tech businesses in the U.S. or outside of the U.S. Most concentrate on
computer, semiconductor, software, networking, and Internet stocks. A few also buy medical-device
and biotechnology stocks, and some concentrate on a single technology industry. 

Utilities 

Utilities portfolios seek capital appreciation by investing primarily in equity securities of U.S. or non-U.
S. public utilities including electric, gas, and telephone-service providers. 

Miscellaneous Sector 

Miscellaneous-sector portfolios invest in specific sectors that do not fit into any of Morningstar’s
existing sector categories and for which not enough funds exist to merit the creation of a separate
category. 

Allocation

Conservative Allocation
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Funds in allocation categories seek to provide both income and capital appreciation by primarily
investing in multiple asset classes, including stocks, bonds, and cash. These conservative strategies
prioritize preservation of capital over appreciation. They typically expect volatility similar to a strategic
equity exposure between 15% and 30%. 

Moderately Conservative Allocation

Funds in allocation categories seek to provide both income and capital appreciation by primarily
investing in multiple asset classes, including stocks, bonds, and cash. These moderately conservative
strategies prioritize preservation of capital over appreciation. They typically expect volatility similar to a
strategic equity exposure between 30% and 50%.

Moderate Allocation

Funds in allocation categories seek to provide both income and capital appreciation by primarily
investing in multiple asset classes, including stocks, bonds, and cash. These moderate strategies
seek to balance preservation of capital with appreciation. They typically expect volatility similar to a
strategic equity exposure between 50% and 70%.

Moderately Aggressive Allocation

Funds in allocation categories seek to provide both income and capital appreciation by primarily
investing in multiple asset classes, including stocks, bonds, and cash. These moderately aggressive
strategies prioritize capital appreciation over preservation. They typically expect volatility similar to a
strategic equity exposure between 70% and 85%.

Aggressive Allocation

Funds in allocation categories seek to provide both income and capital appreciation by primarily
investing in multiple asset classes, including stocks, bonds, and cash. These aggressive strategies
typically allocate at least 10% to equities of foreign companies and prioritize capital appreciation over
preservation. They typically expect volatility similar to a strategic equity exposure of more than 85%.

Convertibles 

Convertible-bond portfolios are designed to offer some of the capital-appreciation potential of stock
portfolios while also supplying some of the safety and yield of bond portfolios. To do so, they focus on
convertible bonds and convertible preferred stocks. Convertible bonds allow investors to convert the
bonds into shares of stock, usually at a preset price. These securities thus act a bit like stocks and a
bit like bonds. 

Global Allocation 

Global-allocation portfolios seek to provide both capital appreciation and income by investing in three
major areas: stocks, bonds, and cash. While these portfolios do explore the whole world, most of them
focus on the U.S., Canada, Japan, and the larger markets in Europe. It is rare for such portfolios to
invest more than 10% of their assets in emerging markets. These portfolios typically have at least 10%
of assets in bonds, less than 70% of assets in stocks, and at least 40% of assets in non-U.S. stocks
or bonds. 

Tactical Allocation 

Tactical Allocation portfolios seek to provide capital appreciation and income by actively shifting
allocations across investments. These portfolios have material shifts across equity regions, and bond
sectors on a frequent basis. To qualify for the tactical allocation category, the fund must have minimum
exposures of 10% in bonds and 20% in equity. Next, the fund must historically demonstrate material
shifts in sector or regional allocations either through a gradual shift during three years or through a
series of material shifts on a quarterly basis. Within a three-year period, typically the average quarterly
changes between equity regions and bond sectors exceeds 15% or the difference between the
maximum and minimum exposure to a single equity region or bond sector exceeds 50%. 
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Target-Date 2000-2010 

Target-date portfolios provide diversified exposure to stocks, bonds, and cash for those investors who
have a specific date in mind (in this case, the years 2000-2010) for retirement. These portfolios aim to
provide investors with an optimal level of return and risk, based solely on the target date. Management
adjusts the allocation among asset classes to more-conservative mixes as the target date approaches,
following a preset glide path. A target-date portfolio is part of a series of funds offering multiple
retirement dates to investors. 

Target-Date 2015 

Target-date portfolios provide diversified exposure to stocks, bonds, and cash for those investors who
have a specific date in mind (in this case, the years 2011-2015) for retirement. These portfolios aim to
provide investors with an optimal level of return and risk, based solely on the target date. Management
adjusts the allocation among asset classes to more-conservative mixes as the target date approaches,
following a preset glide path. A target-date portfolio is part of a series of funds offering multiple
retirement dates to investors. 

Target-Date 2020

Target-date portfolios provide diversified exposure to stocks, bonds, and cash for those investors who
have a specific date in mind (in this case, the years 2016-2020) for retirement. These portfolios aim to
provide investors with an optimal level of return and risk, based solely on the target date. Management
adjusts the allocation among asset classes to more-conservative mixes as the target date approaches,
following a preset glide path. A target-date portfolio is part of a series of funds offering multiple
retirement dates to investors. 

Target-Date 2025 

Target-date portfolios provide diversified exposure to stocks, bonds, and cash for those investors who
have a specific date in mind (in this case, the years 2021-2025) for retirement. These portfolios aim to
provide investors with an optimal level of return and risk, based solely on the target date. Management
adjusts the allocation among asset classes to more-conservative mixes as the target date approaches,
following a preset glide path. A target-date portfolio is part of a series of funds offering multiple
retirement dates to investors. 

Target-Date 2030 

Target-date portfolios provide diversified exposure to stocks, bonds, and cash for those investors who
have a specific date in mind (in this case, the years 2026-2030) for retirement. These portfolios aim to
provide investors with an optimal level of return and risk, based solely on the target date. Management
adjusts the allocation among asset classes to more-conservative mixes as the target date approaches,
following a preset glide path. A target-date portfolio is part of a series of funds offering multiple
retirement dates to investors.

Target-Date 2035

Target-date portfolios provide diversified exposure to stocks, bonds, and cash for those investors who
have a specific date in mind (in this case, the years 2031-2035) for retirement. These portfolios aim to
provide investors with an optimal level of return and risk, based solely on the target date. Management
adjusts the allocation among asset classes to more-conservative mixes as the target date approaches,
following a preset glide path. A target-date portfolio is part of a series of funds offering multiple
retirement dates to investors. 

Target-Date 2040 

Target-date portfolios provide diversified exposure to stocks, bonds, and cash for those investors who
have a specific date in mind (in this case, the years 2036-2040) for retirement. These portfolios aim to
provide investors with an optimal level of return and risk, based solely on the target date. Management
adjusts the allocation among asset classes to more-conservative mixes as the target date approaches,
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following a preset glide path. A target-date portfolio is part of a series of funds offering multiple
retirement dates to investors. 

Target-Date 2045 

Target-date portfolios provide diversified exposure to stocks, bonds, and cash for those investors who
have a specific date in mind (in this case, the years 2041-2045) for retirement. These portfolios aim to
provide investors with an optimal level of return and risk, based solely on the target date. Management
adjusts the allocation among asset classes to more-conservative mixes as the target date approaches,
following a preset glide path. A target-date portfolio is part of a series of funds offering multiple
retirement dates to investors. 

Target-Date 2050

Target-date portfolios provide diversified exposure to stocks, bonds, and cash for those investors who
have a specific date in mind (in this case, the years 2046-2050) for retirement. These portfolios aim to
provide investors with an optimal level of return and risk, based solely on the target date. Management
adjusts the allocation among asset classes to more-conservative mixes as the target date approaches,
following a preset glide path. A target-date portfolio is part of a series of funds offering multiple
retirement dates to investors. 

Target-Date 2055 

Target-date portfolios provide a diversified exposure to stocks, bonds, and cash for those investors who
have a specific date in mind (in this case, the years 2051-2055) for retirement. These portfolios aim to
provide investors with an optimal level of return and risk, based solely on the target date. Management
adjusts the allocation among asset classes to more-conservative mixes as the target date approaches,
following a preset glide path. A target-date portfolio is part of a series of funds offering multiple
retirement dates to investors.  

Target-Date 2060 

Target-date portfolios provide a diversified exposure to stocks, bonds, and cash for those investors who
have a specific date in mind (in this case, the years 2056-2060) for retirement. These portfolios aim to
provide investors with an optimal level of return and risk, based solely on the target date. Management
adjusts the allocation among asset classes to more-conservative mixes as the target date approaches,
following a preset glide path. A target-date portfolio is part of a series of funds offering multiple
retirement dates to investors.  

Target-Date 2065+ date portfolios provide a diversified exposure to stocks, bonds, and cash for those
investors who have a specific date in mind (in this case, the years 2061-2065 and beyond) for
retirement. These portfolios aim to provide investors with an optimal level of return and risk, based
solely on the target date. Management adjusts the allocation among asset classes to more-
conservative mixes as the target date approaches, following a preset glide path. A target-date portfolio
is part of a series of funds offering multiple retirement dates to investors.

Target-Date Retirement 

Target-Date Retirement portfolios provide a mix of stocks, bonds, and cash for those investors already
in or entering retirement. These portfolios tend to be managed to more of a conservative asset-
allocation strategy. These portfolios aim to provide investors with steady income throughout retirement. 

International Equity

Foreign Large-Value 

Foreign large-value portfolios invest mainly in big international stocks that are less expensive or growing
more slowly than other large-cap stocks. Most of these portfolios divide their assets among a dozen or
more developed markets, including Japan, Britain, France, and Germany. These portfolios primarily
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invest in stocks that have market caps in the top 70% of each economically integrated market (such as
Europe or Asia ex-Japan). Value is defined based on low valuations (low price ratios and high dividend
yields) and slow growth (low growth rates for earnings, sales, book value, and cash flow). These
portfolios typically will have less than 20% of assets invested in U.S. stocks. 

Foreign Large-Blend 

Foreign large-blend portfolios invest in a variety of big international stocks. Most of these portfolios
divide their assets among a dozen or more developed markets, including Japan, Britain, France, and
Germany. These portfolios primarily invest in stocks that have market caps in the top 70% of each
economically integrated market (such as Europe or Asia ex-Japan). The blend style is assigned to
portfolios where neither growth nor value characteristics predominate. These portfolios typically will
have less than 20% of assets invested in U.S. stocks. 

Foreign Large-Growth 

Foreign large-growth portfolios focus on high-priced growth stocks, mainly outside of the United States.
Most of these portfolios divide their assets among a dozen or more developed markets, including
Japan, Britain, France, and Germany. These portfolios primarily invest in stocks that have market caps
in the top 70% of each economically integrated market (such as Europe or Asia ex-Japan). Growth is
defined based on fast growth (high growth rates for earnings, sales, book value, and cash flow) and high
valuations (high price ratios and low dividend yields). These portfolios typically will have less than 20%
of assets invested in U.S. stocks. 

Foreign Small/Mid-Value 

Foreign small/mid-value portfolios invest in international stocks that are smaller and less expensive
than other stocks. These portfolios primarily invest in stocks that fall in the bottom 30% of each
economically integrated market (such as Europe or Asia ex-Japan). Value is defined based on low
valuations (low price ratios and high dividend yields) and slow growth (low growth rates for earnings,
sales, book value, and cash flow). These portfolios typically will have less than 20% of assets invested
in U.S. stocks. 

Foreign Small/Mid-Blend 

Foreign small/mid-blend portfolios invest in a variety of international stocks that are smaller. These
portfolios primarily invest in stocks that fall in the bottom 30% of each economically integrated market
(such as Europe or Asia ex-Japan). The blend style is assigned to portfolios where neither growth nor
value characteristics predominate. These portfolios typically will have less than 20% of assets invested
in U.S. stocks. 

Foreign Small/Mid-Growth 

Foreign small/mid-growth portfolios invest in international stocks that are smaller, growing faster, and
higher-priced than other stocks. These portfolios primarily invest in stocks that fall in the bottom 30% of
each economically integrated market (such as Europe or Asia ex-Japan). Growth is defined based on
fast growth (high growth rates for earnings, sales, book value, and cash flow) and high valuations (high
price ratios and low dividend yields). These portfolios typically will have less than 20% of assets
invested in U.S. stocks. 

Global Large-Stock Growth 

Global large-stock growth portfolios invest in a variety of international stocks and typically skew
towards large caps that are more expensive or projected to grow faster than other global large-cap
stocks. Global large stock growth portfolios have few geographical limitations. It is common for these
portfolios to invest the majority of their assets in developed markets, with the remainder divided among
the globe’s emerging markets. These portfolios are not significantly overweight U.S. equity exposure
relative to the Morningstar Global Market Index and maintain at least a 20% absolute U.S. exposure. 

Global Large-Stock Blend 
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Global large-stock blend portfolios invest in a variety of international stocks and typically skew towards
large caps that are fairly representative of the global stock market in size, growth rates, and price.
Global large stock blend portfolios have few geographical limitations. It is common for these portfolios
to invest the majority of their assets in developed markets, with the remainder divided among the
globe’s emerging markets. These portfolios are not significantly overweight U.S. equity exposure
relative to the Morningstar Global Market Index and maintain at least a 20% absolute U.S. exposure. 

Global Large-Stock Value 

Global large-stock value portfolios invest in a variety of international stocks and typically skew towards
large caps that are less expensive or growing more slowly than other global large-cap stocks. Global
large stock value portfolios have few geographical limitations. It is common for these portfolios to invest
the majority of their assets in developed markets, with the remainder divided among the globe’s
emerging markets. These portfolios are not significantly overweight U.S. equity exposure relative to the
Morningstar Global Market Index and maintain at least a 20% absolute U.S. exposure. 

Global Small/Mid Stock 

Global small/mid stock portfolios invest in a variety of international stocks that are smaller. Global-
stock portfolios have few geographical limitations. It is common for these portfolios to invest the
majority of their assets in developed markets, with the remainder divided among the globe’s smaller
markets. These portfolios are not significantly overweight U.S. equity exposure relative to the
Morningstar Global Market Index and maintain at least a 20% absolute U.S. exposure. 

Diversified Emerging Markets 

Diversified emerging-markets portfolios tend to divide their assets among 20 or more nations, although
they tend to focus on the emerging markets of Asia and Latin America rather than on those of the
Middle East, Africa, or Europe. These portfolios invest predominantly in emerging market equities, but
some funds also invest in both equities and fixed income investments from emerging markets. 

Diversified Pacific/Asia 

Diversified Pacific/Asia stock portfolios have a wider investment range than other Asia-oriented
portfolios. These portfolios can invest throughout the Pacific Rim, including Australia and New Zealand.
As a result, country weightings for these portfolios vary tremendously, though most retain some
exposure to Japan and Hong Kong. These portfolios invest at least 70% of total assets in equities and
invest at least 75% of stock assets in Pacific countries, including at least 10% in Japan. 

Miscellaneous Region 

Miscellaneous Region stock portfolios invest in countries or smaller regions that do not have their own
category. They typically have a narrow geographical range. 

Europe Stock 

Europe-stock portfolios invest at least 70% of total assets in equities and invest at least 75% of stock
assets in Europe. Most of these portfolios emphasize the region's larger and more developed markets,
including Britain, the Netherlands, Germany, France, and Switzerland. Many also invest in the region’s
smaller markets, including the emerging markets of eastern Europe. 

Latin America Stock 

Latin America stock portfolios invest almost exclusively in stocks from Latin America. Most of these
portfolios strongly favor the area's large markets, specifically Brazil, Mexico, and Argentina. Smaller
markets such as Peru or Colombia aren't generally as well-represented in these portfolios. These
portfolios invest at least 70% of total assets in equities and invest at least 75% of stock assets in Latin
America.

Pacific/Asia ex-Japan Stock 
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Pacific/Asia ex-Japan stock portfolios cover a wide geographic range. Most of these portfolios focus on
export-oriented nations such as Hong Kong, Singapore, Taiwan, and Korea. These portfolios invest at
least 70% of total assets in equities and invest at least 75% of stock assets in Pacific countries, with
less than 10% in Japan.

China Region 

China-region stock portfolios invest almost exclusively in stocks from China, Taiwan, and Hong Kong.
These portfolios invest at least 70% of total assets in equities and invest at least 75% of stock assets
in one specific region or a combination of China, Taiwan, and/or Hong Kong.

India Equity

India-stock portfolios emphasize companies based in India. These portfolios invest at least 70% of total
assets in equities and invest at least 75% of stock assets in India.

Japan Stock 

Japan-stock portfolios emphasize companies based in Japan. The Japanese stock market is one of the
largest in the world, so these portfolios' holdings vary significantly. Some portfolios concentrate on
Japan's larger companies, while others concentrate on the nation's smaller firms. These portfolios
invest at least 70% of total assets in equities and invest at least 75% of stock assets in Japan.

Nontraditional Equity

Long-Short Equity 

Long-short equity portfolios hold sizeable stakes in both long and short positions in equities, exchange
traded funds, and related derivatives. Funds shift their exposure to long and short positions depending
on the opportunities they uncover through bottom-up research. Funds in the category tend to have beta
values to relevant benchmarks of between 0.3 and 0.8.

Derivative Income 

Derivative income strategies primarily use an options overlay to generate income while maintaining
significant exposure to equity market risk. Income is typically generated through covered call writing
strategies, for example, while traditional equity risk factors dictate a substantial portion of the return.

Funds in the category will typically have beta values to relevant benchmarks of between 0.6 and 0.9.

Equity Hedged

Equity Hedged strategies use a variety of means to protect the value of their equity exposure during
times of market weakness. These funds may exchange equity risk for some other risk premium, such
as volatility. They may also make opportunistic trades, like employing market-timing moves to exit the
market altogether. These funds use a variety of options trades to hedge their equity risk, including put
writing, options spreads, collar strategies, and others. Funds in the category will typically have beta
values to relevant benchmarks of less than 0.6.

Defined Outcome

Defined Outcome funds deliver investors a predefined range of outcomes over a set period. This range is
determined by equity market performance and the derivative contracts that underlie each fund. The
funds’ features primarily include upside caps and downside buffers. Underlying asset classes tend to
be equity-based but may be derived from other asset classes. The products predominantly use options
to deliver these outcomes, but may also utilize swaps, or other derivatives.

Alternative

Macro Trading
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Macro trading strategies, using either systematic or discretionary methods, look for investment
opportunities by studying such factors as the global economy, government policies, interest rates,
inflation, and market trends. As opportunists, these funds are not restricted by asset class and may
invest across such disparate assets as global equities, bonds, currencies, and commodities, and make
extensive use of derivatives. These strategies often take significant non-price momentum directional
long or short positions as well as inter- and intra-asset class relative value trades. Market beta is
typically kept under 0.25.

Event Driven

Event driven strategies attempt to profit when security prices change in response to certain corporate
actions, such as bankruptcies, mergers and acquisitions, emergence from bankruptcy, shifts in
corporate strategy, and other atypical events. Activist shareholder and distressed investment strategies
also fall into this category. These portfolios typically focus on equity securities but can invest across
the capital structure. They typically have low to moderate equity market sensitivity since company-
specific developments tend to drive security prices.

Relative Value Arbitrage

Relative value strategies seek out pricing discrepancies between pairs or combinations of securities
regardless of asset class. They often employ one or a combination of debt, equity, and convertible
arbitrage strategies, among others. They can use significant leverage and typically seek to profit from
the convergence of values between securities. Funds in this category typically have low beta exposures
to major market indexes due to their offsetting long and short exposures.

Multistrategy

Multistrategy portfolios offer investors exposure to two or more alternative investment strategies, as
defined by Morningstar’s alternative category classifications, through either a single-manager or
multimanager approach. Funds in this category typically have a majority of their assets exposed to
alternative strategies, but at a minimum, alternatives must comprise greater than 30% of the strategy’s
gross exposure. The category includes funds with static allocations to alternative strategies as well as
those that tactically adjust their exposure to different alternative strategies and asset classes.
Multistrategy funds typically aim to have low to modest sensitivity to traditional market indexes,
although that may not be the case for strategies with lower alternatives allocations.

Equity Market Neutral

Equity market neutral strategies attempt to profit from long and short stock selection decisions while
minimizing systematic risk created by exposure to factors such as overall equity market beta, sectors,
market-cap ranges, investment styles, or countries. They try to achieve this by matching long positions
within each area against offsetting short positions, though they may vary their exposure to market risk
factors modestly. These funds’ investment strategies may be discretionary or systematic, and they
keep at least 75% of their gross assets in equities or equity-related instruments such as derivatives.
They typically have beta values to a relevant benchmark of less than 0.3.

Systematic Trend

Systematic trend strategies primarily implement trend-following, price-momentum strategies by trading
long and short liquid global futures, options, swaps, and foreign exchange contracts. The remaining
exposure may be invested in a mix of other complementary nontraditional risk premia. These portfolios
typically obtain exposure referencing a mix of diversified global markets, including commodities,
currencies, government bonds, interest rates and equity indexes.

Digital Assets

Digital assets that utilize blockchain technology can be described as an immutable, permissionless,
and often decentralized digital database. Digital-asset portfolios will invest the majority of their assets
into one or more broadly classified areas, including decentralized finance assets, stable coins,
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currency assets, smart contracts platforms, exchange assets, privacy assets, yield farming, and
nonfungible tokens, or NFTs, among others. Digital assets are often characterized by two risk style
factors: momentum and volatility. Portfolios may gain access to digital assets through physical or
derivative exposures and incorporate both long-only investments and other hedging techniques. To
qualify for inclusion, funds in this category must have a material portion of risk coming from digital
assets.

Miscellaneous

Trading—Leveraged Commodities 

These funds seek to generate returns equal to a fixed multiple of short-term returns of a commodity
index. The compounding of short-term returns results in performance that does not correspond to those
of investing in the index with external leverage. For example, a fund attempting to achieve 2 times the
returns of a given index on a daily basis is unlikely to deliver anything like 2 times the index’s returns
over periods longer than one day. Many of these funds seek to generate a multiple of the daily or
weekly return of the reference index. Trading funds are not considered suitable for a long-term investor
and are designed to be used by traders. 

Trading—Inverse Commodities 

These funds seek to generate returns equal to an inverse multiple of short-term returns of a commodity
index. The compounding of short-term returns results in performance that does not correspond to those
of investing in the index with external leverage. For example, a fund attempting to achieve negative 2
times the returns of a given index on a daily basis is unlikely to deliver anything like negative 2 times
the index’s returns over periods longer than one day. Many of these funds seek to generate a multiple
typically negative 1 to negative 3 times of the daily or weekly return of the reference index. Trading
funds are not considered suitable for a long-term investor and are designed to be used by active
traders. 

Trading—Leveraged Debt 

These funds seek to generate returns equal to a fixed multiple of the short-term returns of a fixed-
income index. The compounding of short-term returns results in performance that does not correspond
to those of investing in the index with external leverage. For example, a fund attempting to achieve 2
times the returns of a given index on a daily basis is unlikely to deliver anything like 2 times the index’s
returns over periods longer than one day. Many of these funds seek to generate a multiple of the daily
or weekly return of the reference index. Trading funds are not considered suitable for a long-term
investor and are designed to be used by active traders.

Trading—Inverse Debt 

These funds seek to generate returns equal to an inverse fixed multiple of short-term returns of a fixed-
income index. The compounding of short-term returns results in performance that does not correspond
to those of investing in the index with external leverage. For example, a fund attempting to achieve
negative 2 times the returns of a given index on a daily basis is unlikely to deliver anything like negative
2 times the index’s returns over periods longer than one day. Many of these funds seek to generate a
multiple typically negative 1 to negative 3 times of the daily or weekly return of the reference index.
Trading funds are not considered suitable for a long-term investor and are designed to be used by active
traders. 

Trading—Leveraged Equity 

These funds seek to generate returns equal to a fixed multiple of the short-term returns of an equity
index. The compounding of short-term returns results in performance that does not correspond to those
of investing in the index with external leverage. For example, a fund attempting to achieve 2 times the
returns of a given index on a daily basis is unlikely to deliver anything like 2 times the index’s returns
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over periods longer than one day. Many of these funds seek to generate a multiple of the daily or
weekly return of the reference index. Trading funds are not considered suitable for a long-term investor
and are designed to be used by active traders.

Trading—Inverse Equity 

These funds seek to generate returns equal to an inverse fixed multiple of short-term returns of an
equity index. The compounding of short-term returns results in performance that does not correspond to
those of investing in the index with external leverage. For example, a fund attempting to achieve
negative 2 times the returns of a given index on a daily basis is unlikely to deliver anything like negative
2 times the index’s returns over periods longer than one day. Many of these funds seek to generate a
multiple typically negative 1 to negative 3 times the daily or weekly return of the reference index.
Trading funds are not considered suitable for a long-term investor and are designed to be used by active
traders. 

Trading—Miscellaneous 

These funds seek to generate returns equal to a fixed multiple (positive or negative) of short-term
returns of an index. The reference index for this category is not equity, fixed-income, or commodity
linked. The compounding of short-term returns results in performance that does not correspond to those
of investing in the index with external leverage. For example, a fund attempting to achieve 2 times the
returns of a given index on a daily basis is unlikely to deliver anything like 2 times the index’s returns
over periods longer than one day. Many of these funds seek to generate a multiple of the daily or
weekly return of the reference index. Trading funds are not considered suitable for a long-term investor
and are designed to be used by active traders. 

Commodities 

Commodities Broad Basket 

Broad-basket portfolios can invest in a diversified basket of commodity goods including but not limited
to grains, minerals, metals, livestock, cotton, oils, sugar, coffee, and cocoa. Investment can be made
directly in physical assets or commodity-linked derivative instruments, such as commodity swap
agreements. 

Commodities Focused  

Focused portfolios invest in concentrated sectors of commodities including but not limited to
agriculture, energy, industrial metals, and precious metals.  Category Group Index: Bloomberg
Commodity TR USD 

Taxable Bond

 Long Government 

Long-government portfolios have at least 90% of their bond holdings invested in bonds backed by the U.
S. government or by government-linked agencies. This backing minimizes the credit risk of these
portfolios, as the U.S. government is unlikely to default on its debt. They are not risk-free, though.
Because these portfolios have durations of typically more than 6.0 years, they are more sensitive to
interest rates, and thus riskier, than portfolios that have shorter durations.  

Morningstar calculates monthly breakpoints using the effective duration of the Morningstar Core Bond
Index in determining duration assignment. Long term is defined as 125% of the three-year average
effective duration of the MCBI. 

Intermediate Government 

Intermediate-government portfolios have at least 90% of their bond holdings in bonds backed by the U.



STEELE Mutual Fund Expert158

© 2024 Steele Systems, Inc.

S. government or by government-linked agencies. This backing minimizes the credit risk of these
portfolios, as the U.S. government is unlikely to default on its debt. These portfolios have durations
typically between 3.5 and 6.0 years. Consequently, the group's performance—and its level of volatility—
tends to fall between that of the short government and long government bond categories. Morningstar
calculates monthly breakpoints using the effective duration of the Morningstar Core Bond Index in
determining duration assignment. Intermediate is defined as 75% to 125% of the three-year average
effective duration of the MCBI. 

Short Government 

Short-government portfolios have at least 90% of their bond holdings in bonds backed by the U.S.
government or by government-linked agencies. This backing minimizes the credit risk of these
portfolios, as the U.S. government is unlikely to default on its debt. These portfolios have durations
typically between 1.0 and 3.5 years, so they have relatively less sensitivity to interest rates and, thus,
low risk potential. Morningstar calculates monthly breakpoints using the effective duration of the
Morningstar Core Bond Index in determining duration assignment. Short is defined as 25% to 75% of
the three-year average effective duration of the MCBI. 

Inflation-Protected Bond 

Inflation-protected bond portfolios invest primarily in debt securities that adjust their principal values in
line with the rate of inflation. These bonds can be issued by any organization, but the U.S. Treasury is
currently the largest issuer for these types of securities.

Long-Term Bond 

Long-term bond portfolios invest primarily in investment-grade U.S. fixed-income issues including
government, corporate, and securitized debt. Their durations (a measure of interest-rate sensitivity)
typically range above 125% of the three-year average of the effective duration of the Morningstar Core
Bond Index.  

Intermediate Core Bond 

Intermediate-term core bond portfolios invest primarily in investment-grade U.S. fixed-income issues
including government, corporate, and securitized debt, and hold less than 5% in below-investment-
grade exposures. Their durations (a measure of interest-rate sensitivity) typically range between 75%
and 125% of the three-year average of the effective duration of the Morningstar Core Bond Index. 

Intermediate Core-Plus Bond 

Intermediate-term core-plus bond portfolios invest primarily in investment-grade U.S. fixed-income
issues including government, corporate, and securitized debt, but generally have greater flexibility than
core offerings to hold non-core sectors such as corporate high yield, bank loan, emerging-markets
debt, and non-U.S. currency exposures. Their durations (a measure of interest-rate sensitivity) typically
range between 75% and 125% of the three-year average of the effective duration of the Morningstar
Core Bond Index.  

Short-Term Bond 

Short-term bond portfolios invest primarily in corporate and other investment-grade U.S. fixed-income
issues and typically have durations of 1.0 to 3.5 years. These portfolios are attractive to fairly
conservative investors, because they are less sensitive to interest rates than portfolios with longer
durations. Morningstar calculates monthly breakpoints using the effective duration of the Morningstar
Core Bond Index in determining duration assignment. Short-term is defined as 25% to 75% of the three-
year average effective duration of the MCBI.

Ultrashort Bond 

Ultrashort-bond portfolios invest primarily in investment-grade U.S. fixed-income issues and have
durations typically of less than one year. This category can include corporate or government ultrashort
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bond portfolios, but it excludes international, convertible, multisector, and high-yield bond portfolios.
Because of their focus on bonds with very short durations, these portfolios offer minimal interest-rate
sensitivity and therefore low risk and total return potential. Morningstar calculates monthly breakpoints
using the effective duration of the Morningstar Core Bond Index in determining duration assignment. 

Ultrashort is defined as 25% of the three-year average effective duration of the MCBI. 

Bank Loan 

Bank-loan portfolios primarily invest in floating-rate bank loans and floating-rate below investment-grade
securities instead of bonds. In exchange for their credit risk, these loans offer high interest payments
that typically float above a common short-term benchmarks such as Libor or SOFR.  

Stable Value 

Stable-value portfolios seek to provide income while preventing price fluctuations. The most common
stable-value portfolios invest in a diversified portfolio of bonds and enter into wrapper agreements with
financial companies to guarantee against fluctuations in their share prices. These wrapper agreements
typically provide price stability on a day-to-day basis, thereby insulating each portfolio's net asset value
from interest-rate volatility. Therefore, the duration for each of these funds is essentially zero. This
category is used only in Morningstar’s custom fund, separate account, and collective investment trust
databases. 

Corporate Bond 

Corporate bond portfolios concentrate on investment-grade bonds issued by corporations in U.S.
dollars, which tend to have more credit risk than government or agency-backed bonds. These portfolios
hold more than 65% of their assets in corporate debt, less than 40% of their assets in non-U.S. debt,
less than 35% in below-investment-grade debt, and durations that typically range between 75% and
150% of the three-year average of the effective duration of the Morningstar Core Bond Index. 

Preferred Stock 

Preferred stock portfolios concentrate on preferred stocks and perpetual bonds. These portfolios tend to
have more credit risk than government or agency backed bonds, and effective duration longer than other
bond portfolios. These portfolios hold more than 65% of assets in preferred stocks and perpetual
bonds. 

High-Yield Bond 

High-yield bond portfolios concentrate on lower-quality bonds, which are riskier than those of higher-
quality companies. These portfolios generally offer higher yields than other types of portfolios, but they
are also more vulnerable to economic and credit risk. These portfolios primarily invest in U.S. high-
income debt securities where at least 65% or more of bond assets are not rated or are rated by a major
agency such as Standard & Poor's or Moody's at the level of BB (considered speculative for taxable
bonds) and below. 

Multisector Bond 

Multisector-bond portfolios seek income by diversifying their assets among several fixed-income
sectors, usually U.S. government obligations, U.S. corporate bonds, foreign bonds, and high-yield U.S.
debt securities. These portfolios typically hold 35% to 65% of bond assets in securities that are not
rated or are rated by a major agency such as Standard & Poor's or Moody's at the level of BB
(considered speculative for taxable bonds) and below.

Global Bond 

Global bond portfolios typically invest 40% or more of their assets in fixed-income instruments issued
outside of the U.S. These portfolios invest primarily in investment-grade rated issues, but their
strategies can vary. Some follow a conservative approach, sticking with high-quality bonds from
developed markets. Others are more adventurous, owning some lower-quality bonds from developed or
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emerging markets. Some portfolios invest exclusively outside the U.S., while others invest in both U.S.
and non-U.S. bonds. Many consistently maintain significant allocations to non-U.S. dollar currencies,
while others have the flexibility to make sizeable adjustments between their U.S. dollar and non-U.S.
currency exposures. 

Global Bond-USD Hedged 

USD hedged portfolios typically invest 40% or more of their assets in fixed-income instruments issued
outside of the U.S. These portfolios invest primarily in investment-grade rated issues, but their
strategies can vary. Some follow a conservative approach, sticking with high-quality bonds from
developed markets. Others are more adventurous, owning some lower-quality bonds from developed or
emerging markets. Some portfolios invest exclusively outside the U.S., while others invest in both U.S.
and non-U.S. bonds. Funds in this category hedge most of their non-U.S.-dollar currency exposure
back to the U.S. dollar. 

Target Maturity 

Taxable target maturity portfolios typically invest in corporate and other taxable U.S. investment-grade
fixed-income instruments that are all expected to mature in the same year.  

Emerging-Markets Bond 

Emerging-markets bond portfolios invest more than 65% of their assets in foreign bonds from
developing countries. The largest portion of the emerging-markets bond market comes from Latin
America, followed by Eastern Europe. Africa, the Middle East, and Asia make up the rest. 

Emerging-Markets Local-Currency Bond 

Emerging-markets local-currency bond portfolios invest more than 65% of their assets in foreign bonds
from developing countries in the local currency. Funds in this category have a mandate to maintain
exposure to currencies of emerging markets. The largest portion of the emerging-markets bond market
comes from Latin America, followed by Eastern Europe, Africa, the Middle East, and Asia. 

Nontraditional Bond 

Inclusion in nontraditional bond is informed by a balance of factors determined by Morningstar analysts.
Those typically include a mix of: absolute return mandates; goals of producing returns not correlated
with the overall bond market; performance benchmarks based on ultrashort-term interest rates such as
T-bills; the ability to take long and short market and security-level positions using a broad range of
derivatives; and few or very limited portfolio constraints on exposure to credit, sectors, currency, or
interest-rate sensitivity. Funds in this group typically have the flexibility to manage duration exposure
over a wide range of years and to take it to zero or a negative value.  

Single Currency 

Currency portfolios invest in a single currency through the use of short-term money market instruments;
derivative instruments including and not limited to forward currency contracts, index swaps, and
options; and cash deposits.

Miscellaneous Fixed Income

Miscellaneous Fixed Income portfolios have structures or mandates that make them unsuitable for
inclusion in other fixed-income categories. They do not receive Morningstar Ratings, should not be
compared against other peer groups, and are not included in calculations for ranking statistics. Among
others, constituents include so-called separate-account completion funds that are not designed for use
as stand-alone portfolios, and only in combination with other investments.

Short-Term Inflation Protected Bond 

Short-term Inflation-protected bond portfolios invest primarily in debt securities designed to provide
returns with a component explicitly tied to inflation. US Treasury Inflation Protected Securities include
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an adjustment to their principal values in line with the rate of inflation, as measured by the US
Consumer Price Index. These bonds can be issued by any organization or government, but the U.S.
Treasury is currently the largest issuer for these securities. Inclusion in the category may be informed
by a balance of factors but their durations (a measure of interest rate sensitivity) are typically shorter
than 4.0 years, their average weighted maturities are typically less than 7.0 years, and they typically
employ benchmarks limited to bonds with maturities of 10 or fewer years.

Municipal Bond

Muni National Long 

Muni national long portfolios invest in bonds issued by various state and local governments to fund
public projects. The income from these bonds is generally free from federal taxes. To lower risk, these
portfolios spread their assets across many states and sectors. These portfolios have durations of more
than 6.0 years (or average maturities of more than 12 years). 

Muni National Intermediate 

Muni national intermediate portfolios invest in bonds issued by various state and local governments to
fund public projects. The income from these bonds is generally free from federal taxes. To lower risk,
these portfolios spread their assets across many states and sectors. These portfolios have durations of
4.0 to 6.0 years (or average maturities of five to 12 years). 

Muni National Short 

Muni national short portfolios invest in bonds issued by state and local governments to fund public
projects. The income from these bonds is generally free from federal taxes and/or from state taxes in
the issuing state. To lower risk, some of these portfolios spread their assets across many states and
sectors. Other portfolios buy bonds from only one state in order to get the state-tax benefit. These
portfolios have durations of less than 4.0 years (or average maturities of less than five years). 

High-Yield Muni 

High-Yield Muni portfolios typically invest a substantial portion of assets in high-income municipal
securities that are not rated or that are rated at the level of or below BBB (considered high-yield within
the municipal-bond industry) by a major ratings agency such as Standard & Poor’s or Moody’s. 

Muni Single State Long 

Muni single-state long portfolios invest in bonds issued by state and local governments to fund public
projects. The income from such bonds is generally free from federal taxes and from state taxes in the
issuing state. To get the state-tax benefit, these portfolios buy bonds from only one state. These
portfolios have durations of more than 6.0 years (or average maturities of more than 12 years). 

Muni Single State Intermediate 

Muni single-state intermediate portfolios invest in bonds issued by state and local governments to fund
public projects. The income from such bonds is generally free from federal taxes and from state taxes
in the issuing state. To get the state-tax benefit, these portfolios buy bonds from only one state. These
portfolios have durations of 4.0 to 6.0 years (or average maturities of five to 12 years). 

Muni Single State Short 

Muni single-state short portfolios invest in bonds issued by state and local governments to fund public
projects. The income from such bonds is generally free from federal taxes and from state taxes in the
issuing state. To get the state-tax benefit, these portfolios buy bonds from only one state. These
portfolios have durations of less than 4.0 years (or average maturities of less than five years). 

Muni California Long 

Muni California long portfolios invest at least 80% of assets in California municipal debt. Because the
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income from these bonds is generally free from federal taxes and California state taxes, these portfolios
are most appealing to residents of California. These portfolios have durations of more than 6.0 years (or
maturities of more than 12 years). 

Muni California Intermediate 

Muni California intermediate portfolios invest at least 80% of assets in California municipal debt.
Because the income from these bonds is generally free from federal taxes and California state taxes,
these portfolios are most appealing to residents of California. These portfolios have durations of 4.0 to 

6.0 years (or average maturities of five to 12 years). 

Muni Massachusetts 

Muni Massachusetts portfolios invest at least 80% of assets in Massachusetts municipal debt and can
include long-, intermediate-, and short-duration portfolios. Because the income from these bonds is
generally free from federal taxes and Massachusetts state taxes, these portfolios are most appealing to
residents of Massachusetts. 

Muni Minnesota 

Muni Minnesota portfolios invest at least 80% of assets in Minnesota municipal debt and can include
long-, intermediate-, and short-duration portfolios. Because the income from these bonds is generally
free from federal taxes and Minnesota state taxes, these portfolios are most appealing to residents of
Minnesota. 

Muni New Jersey 

Muni New Jersey portfolios invest at least 80% of assets in New Jersey municipal debt and can include
long-, intermediate-, and short-duration portfolios. Because the income from these bonds is generally
free from federal taxes and New Jersey state taxes, these portfolios are most appealing to residents of
New Jersey. 

Muni New York Long 

Muni New York long portfolios invest at least 80% of assets in New York municipal debt. Because the
income from these bonds is generally free from federal taxes and New York state taxes, these
portfolios are most appealing to residents of New York. These portfolios have durations of more than 6.0
years (or average maturities of more than 12 years).

Muni New York Intermediate 

Muni New York intermediate portfolios invest at least 80% of assets in New York municipal debt.
Because the income from these bonds is generally free from federal taxes and New York state taxes,
these portfolios are most appealing to residents of New York. These portfolios have durations of 4.0 to
6.0 years (or average maturities of five to 12 years). 

Muni Ohio 

Muni Ohio portfolios invest at least 80% of assets in Ohio municipal debt and can include long-,
intermediate-, and short-duration portfolios. Because the income from these bonds is generally free
from federal taxes and Ohio state taxes, these portfolios are most appealing to residents of Ohio. 

Muni Pennsylvania 

Muni Pennsylvania portfolios invest at least 80% of assets in Pennsylvania municipal debt and can
include long-, intermediate-, and short-duration portfolios. Because the income from these bonds is
generally free from federal taxes and Pennsylvania state taxes, these portfolios are most appealing to
residents of Pennsylvania. 

Muni Target Maturity 

Muni target maturity portfolios typically invest in bonds issued by various U.S. state and local
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governments to fund public projects, all of which are expected to mature in the same year. The income
from these bonds is generally free from federal taxes. 

Money Market 

Money Market—Taxable 

These portfolios invest in short-term money market securities in order to provide a level of current
income that is consistent with the preservation of capital. These funds do not designate themselves as
Prime in Form N-MFP. 

Money Market—Tax-Free 

These portfolios invest in short-term municipal money market securities that are often exempt from
some federal and state taxes. These funds provide current income and aim to preserve capital. These
funds do not designate themselves as Prime in Form N-MFP. 

Money Market—Non-40 Act 

These portfolios invest in short-term money market securities in order to provide a level of current
income that is consistent with the preservation of capital. These funds are not subject to 2a-7
regulations under the Investment Company Act of 1940. This category is used only in Morningstar's
custom fund, separate account, and collective investment trust databases. 

Prime Money Market 

These portfolios invest in short-term money market securities in order to provide a level of current
income that is consistent with the preservation of capital. These funds designate themselves as Prime
in Form N-MFP.

15.6 Broad Category

Allocation

Asset Allocation pertains to funds that are a managed portfolio of equities, bonds, cash and property.

Alternative

Utilizing 'alternative' investment strategies.

Commodities

Precious & other metals, oil & other energy products, agricultural products, and other commodities.

Convertibles

Convertibles include funds investing predominantly in convertible bonds and convertible preferred stock.

Equity

Equity includes funds investing in equities and whose principal objective is capital appreciation, total
return, or income.

Fixed Income

Fixed Income pertains to funds that invest in fixed interest securities, which would include government
or corporate bonds, loan stock and non-convertible preferred stock.
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Miscellaneous

All other types that do not fall in any of the other categories.

Money Market

Money Market includes money market, building society and multi-currency deposit funds. These funds
are low risk. Cash and Deposit funds invest in short term instruments (less than one year), which
usually offer a floating rate of return.

Tax Preferred
Municipal bonds.

Property

15.7 Star Rating

The Morningstar Rating™, or "star rating", is a quantitative assessment of a fund’s past performance -
both return and risk - as measured from one to five stars. It uses focused comparison groups
(investment categories) to better measure fund manager skill. The Morningstar Rating is intended for
use as the first step in the fund evaluation process. A high rating alone is not a sufficient basis for
investment decisions.

The Morningstar Rating™ is based on “expected utility theory”, which recognizes that investors are a)
more concerned about a possible poor outcome than an unexpectedly good outcome and b) willing to
give up some portion of their expected return in exchange for greater certainty of return. The rating
accounts for all variations in a fund’s monthly performance, with more emphasis on downward
variations. It rewards consistent performance and reduces the possibility of strong short-term
performance masking the inherent risk of a fund.

The Morningstar Rating™ for funds is calculated for managed products (including mutual funds, variable
annuity and variable life subaccounts, exchange-traded funds (ETFs), closed-end funds, and separate
accounts) with at least a three-year history. Exchange-traded funds and open-ended mutual funds are
considered a single population for comparative purposes. It is calculated based on a Morningstar Risk-
Adjusted Return measure that accounts for variation in a managed product's monthly excess
performance, placing more emphasis on downward variations and rewarding consistent performance.
The top 10% of products in each product category receive 5 stars, the next 22.5% receive 4 stars, the
next 35% receive 3 stars, the next 22.5% receive 2 stars, and the bottom 10% receive 1 star.

Each share class is counted as a fraction of one fund within this scale and rated separately, which may
cause slight variations in the distribution percentages. This accounting prevents a single portfolio with
multiple share classes in a smaller category from dominating any portion of the rating scale.

When a fund changes investment categories, its historical information is given less weight, depending
on the magnitude of the change.

Ratings are not assigned to funds in some categories such as the Bear Market and Currency
categories because the funds in these categories take very different approaches to generating returns.
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15.8 ABCDE Ratings

The three ABCDE Ratings compare each fund to all other funds in the same investment Category:

 1. Return Rating

 2. Risk Rating (Volatility)

 3. Risk-Adjusted Rating

The ratings are presented on a letter grade A-B-C-D-E (quintile) basis: A fund with an "A" rating means
that it places in the top one-fifth (20%) of all funds in the same investment Category.

Return Rating

This field shows the relative quintile ranking of each fund within its investment Category based ONLY
ON RETURN, without taking risk into account. "A" = best, "E" = worst.

This rating is based on the "3-Year Average Return" field and is updated monthly.

Risk Rating (Volatility)

This field shows the relative quintile ranking of each fund within its investment Category based ONLY
ON RISK (price volatility—standard deviation of return), without taking return into account. "A" = least
risk, "E" = most risk.

This rating is based on the "3-Year Monthly Standard Deviation" field and is updated monthly.

Risk-Adjusted Rating

This field shows the relative quintile ranking of each fund within its investment Category based ON
BOTH RISK (price volatility) AND RETURN. "A" = best, "E" = worst.

This rating is based on the "3-Year Sharpe" field (a measure of risk-adjusted performance) and is
updated monthly.

 

15.9 Category Return Rank

This is the fund’s return percentile rank relative to all funds that have the same Category.

The highest (or most favorable) percentile rank is 1 and the lowest (or least favorable) percentile rank is
100. The top-performing fund in a category will always receive a rank of 1.

15.10 Category Ranking (5-years)

This column provides a quick look at the fund’s performance within its Category for the last 5 years.
Each bar represents the funds quintile rank (0, 1, 2, 3, 4, or 5) of its performance for that year within its
Category classification. The years are listed oldest to newest from left to right. A value of 0 (no bar
showing) indicates the fund does not have data for that year. Values 1 through 5, with 5 being the best
indicate relative performance.

It can be very useful as it allows you to see at a glance, for example, whether over the last 5 years a
given fund was consistently in the top fifth of funds in the same Category or not.

A different color is simply assigned to each quintile (1, 2, 3, 4, or 5) instead of using just the height of
each bar. Red means the fund was in the top 5th quintile (best performing), and so on and so forth.
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You can change the Category Rankings colors by clicking on Menu/Pages/Global Options.../Graph
Colors.

When this field is ranked, the funds will be sorted based on the average value of all five ranks. In case
of ties in the average value of all five ranks, the ranking algorithm will sort them by favoring the most
recent years. If all five ranks are identical, then funds are sub-sorted alphabetically.

You can filter funds based on values in this column as well. To specify a particular value, type in the
values [0..5] for each year in increasing order. For example, “1 3 5” specifies a 5 for the latest year, a 3
for the previous year, and a 1 for the year before that. You can specify up to 5 years. The numbers are
in the same order as the bars in the graph.

To filter by the average value of all five ranks clear the check box named “Compare to each year”.

See also  Investment Categories   Calendar Year Returns

 

15.11 Up/Down Market Performance

Up-Market Return (Bull market)

A Bull market in stocks is defined as a 20% rise in the S&P 500 Index from its previous trough over a
sustained period of time, typically 2 months or more, ending when the index reaches its peak and
subsequently declines by 20%. There is a Total and an Annualized return for each such period.

Down-Market Return (Bear market)

A Bear market in stocks is defined as a 20% decline in the S&P 500 Index from its previous peak over
a sustained period of time, typically 2 months or more, and ends when the index reaches its trough and
subsequently rises by 20%. There is a Total and an Annualized return for each such period.

Full-Cycle Return

A full cycle return includes a consecutive bull and bear market return cycle. There is a Total and an
Annualized return for each such period.

15.12 Index Funds

Index funds, such as those in the "Index Funds for Benchmarking" built-in securities group can be used
instead of indexes for benchmarking and comparisons for more real-world performance comparisons.
Several Index Funds faithfully follow their underlying index but, unlike the index, which is a theoretical
list of securities and their weights, they provide an investment vehicle that one can actually purchase/
hold and its performance does include the cost of managing its operation and maintaining it.

Using an Index Fund instead of its underlying index for comparing performance is a more correct and
accurate apples-to-apples comparison of investment vehicle to investment vehicle, instead of a mutual
fund that one can invest in (whose performance includes the cost of existing) versus an index which is
a hypothetical collection of securities (without any associated costs of acquiring and trading those
securities, and managing the operation).

When Modern Portfolio Theory was born, comparing a security to the "market", often referred to a large
list of securities such as the S&P 500, Russell 1000/2000/3000, Wilshire 5000. It was highly
impractical and expensive to attempt to actually attempt to hold the contents of such benchmarks.

142 196
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Today, however, low-cost Index Funds such as "Fidelity 500 Index" and "Vanguard S&P 500 ETF"
represent real-world incarnations of the underlying index that one can actually hold. As a result, for
example, it is more accurate and relevant to compare funds in the Large Cap category to those Index
Funds. If a considered mutual fund has not been matching (and is not projected to exceed) the
performance/risk provided by the Index Fund, the investor can instead actually buy the Index Fund
itself.

15.13 Indexes & Averages

Market Indexes

These are market and other indexes, such as the Dow Jones Industrial Average, or the Standard &
Poor's 500, that can provide benchmarks for comparison with individual mutual funds and portfolios.

Index Abbreviations

TR — Total Return includes performance of both capital gains as well as dividends reinvested.
Reinvestment of dividends is assumed on the last day of the month rather than every day during the
month.

PR — Price Return; does not reinvest dividends.

NR — Net Return indicates that this series approximates the minimum possible dividend reinvestment.
The dividend is reinvested after deduction of withholding tax, applying the rate applicable to non-resident
individuals who do not benefit from double taxation treaties. MSCI uses withholding tax rates applicable
to Luxembourg holding companies.

GR — Gross Return indicates that this series approximates the maximum possible dividend
reinvestment. The amount reinvested is the dividend distributed to individuals resident in the country of
the company, but does not include tax credits.

USD — United States Dollar Denominated (Other currencies are identified by their abbreviation, e.g.,
EUR, etc.)

LCL/ID/IL — This indicates an index that is listed in local currency. This listing represents the
theoretical performance of an index without any impact from foreign exchange fluctuations.

DJ — Dow Jones

FTSE — FTSE Group, comprised of the Financial Times and London Stock Exchange

EM — Emerging Markets

AC — All Country

Ex US — Excludes United States securities

REIT — Real Estate Investment Trust

LT — Long-term bonds

ST — Short-term bonds

Muni — Municipal bonds

ER — Excess Return

Free — Free float-adjusted
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Objective & Category Averages

These are the averages for all funds in each investment Objective or Category.

 

15.14 Morningstar Indexes

Morningstar Capital Market Indexes

These indexes are based on Morningstar’s research, with each index vetted for appropriateness and
investment value. The indexes reveal the most meaningful differences in stock style, capitalization,
sectors, and other traits. They can be used for precise asset allocation and benchmarking, and as
efficient tools for portfolio construction and market analysis.

Morningstar Style Indexes

These are 16 indexes that track the U.S. market by capitalization and investment style using a
comprehensive, rules-based, 10-factor methodology.

Morningstar Style Indexes are based on the same methodology as the Style Box, providing a cohesive,
integrated framework that can be seamlessly used at all stages of the investment process.

Constructed without gaps or overlap, these indexes enable investors to accurately track the behavior
and characteristics of each market segment. Their non-overlapping and comprehensive structure
ensures that each index can be used as a discrete building block for efficient portfolio construction.

Broad Market Index

U.S. Market:  Targets 97% market capitalization coverage to best represent the U.S. market.

Capitalization Indexes

Large Cap: 70% market capitalization

Mid Cap: 20% market capitalization

Small Cap: 7% market capitalization

Composite Style Indexes

Defined by a 10-factor model. Over 36-month rolling cycles, each index represents 1/3 of the
overall market.

U.S. Value

U.S. Core

U.S. Growth

Style Indexes

The 9 segments of the Style Box are specified by style and market capitalization.

Large Value, Large Core, Large Growth

Mid Value, Mid Core, Mid Growth

Small Value, Small Core, Small Growth

Morningstar Sector Indexes

The Morningstar Sector Index group consists of 14 indexes (three Super Sector and 11 Sector indexes)
that track the U.S. market using a comprehensive, non-overlapping structure.
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At the top tier, the stock universe is divided into three major economic spheres, or Super Sectors:
Cyclical, Defensive and Sensitive. The Super Sectors indicate the degree to which macro-economic
cycles affect sector groups. Next, each of these Super Sectors is further sub-divided into specific
groups, which collectively form the 11 Sectors.

The result is a unified hierarchical system that allows investors to easily evaluate the similarities and
differences of funds and portfolios by comparing exposure to the three Super Sectors, while also
permitting further examination of holdings at a sector level.

Cyclical

Basic Materials

Consumer Cyclical

Financial Services

Real Estate

Defensive

Consumer Defensive

Healthcare

Utilities

Sensitive

Communication Services

Energy

Industrials

Technology

Morningstar Global Equity Indexes

These indexes consist of securities from developed and emerging markets. They are designed to
capture the fundamental characteristics of global equity markets and provide accurate benchmarks for
performance measurement.

The Morningstar Global Equity Indexes track the performance of world markets through a portfolio of
highly investable, liquid stocks. Each index can be used as a discrete building block for efficient
portfolio construction, encouraging asset allocations across geographic regions and countries.
Morningstar uses a structured review process to build each index, screening for countries with a high
level of transparency, market regulation, and operational efficiency, as well as the absence of broad-
based investment restrictions.

Global Ex US

Developed Ex US

Emerging Mkt

Morningstar Dividend Indexes

These indexes help investors who are focused on income generation to better understand the income
potential of equities.

Dividend Composite Index: Contains all dividend-paying stocks that meet dividend consistency
and sustainability screens.

Dividend Leaders Index: Includes the 100 highest yielding stocks in the Dividend Composite
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Index.

Morningstar Bond Indexes

These indexes track the U.S. and global bond markets by sector and term structure. Morningstar's
rules-based methodology was designed to help investors track and invest in the broad bond market and
specific portions of it.

Morningstar Commodity Indexes

These indexes provide diversified commodity exposure. Each index employs different strategic
combinations of long futures, short futures, and cash.

15.15 Selected Market Indexes

An index is a collection of securities chosen to represent a specific investment area. Common indexes
include the Dow Jones Industrial Average, the S&P 500, and the NASDAQ Composite.

3-month T-Bill

Three-month Treasury Bills are short-term securities issued by the U.S. government that are generally
considered to be risk-free. Morningstar determines the arithmetic mean of the investment rates on all
three-month Treasury Bills issued during a given month as reported by the U.S. Treasury's Bureau of
the Public Debt. Morningstar then converts the investment rate into a price and then a monthly return,
using the assumption that the T-Bill is held to maturity.

American Stock Exchange (AMEX) Composite

A capitalization-weighted index representing the aggregate value of the approximately 750 firms listed
on the American Stock Exchange. The AMEX announced in 1998 that it will merge its listings with the
members of the NASDAQ National Market. The figure reported for the AMEX Composite is a price
return that does not include the reinvestment of dividends paid by member firms.

Consumer Price Index (CPI)

Morningstar collects prices on a monthly basis for the CPIU or Consumer Price Index for Urban
Consumers (seasonally adjusted). This index measures the changes in prices of goods and services
purchased by urban households. Many pension and employment contracts are tied to changes in
consumer prices, as protection against inflation and reduced purchasing power.

DJ Wilshire 4500

Listed for small-company funds, measures the performance of all U.S. common equity securities
excluding the stocks in the S&P 500. DJ Wilshire indexes are reported to Morningstar as total returns
with dividends reinvested.

DJ Wilshire 5000

Measures the performance of all U.S. common equity securities, and so serves as an index of all stock
trades in the United States.

Dow Jones Composite

Also known as the 65 Stock Average, consists of DJ Industrial Average, the DJ Transportation Average,
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and the Dow Jones Utility Average. The composite, like the other Dow Jones indexes, is a price-
weighted index. Price-weighted indexes are derived by adding up the prices of the components and
dividing this sum by a stock split-adjusted divisor. Dividends are reinvested to reflect the actual
performance of the underlying securities.

Dow Jones Industrial Average

Computed by summing the prices of the stocks of 30 blue-chip companies and then dividing that total
by an adjusted value--one which has been adjusted over the years to account for the effects of stock
splits on the prices of the 30 companies. Dividends are reinvested to reflect the actual performance of
the underlying securities.

Dow Jones Transportation

Consists of 20 railroad, airline and trucking stocks. Dividends are reinvested to reflect the actual
performance of the underlying securities. This index is also a price-weighted, and the figure we report is
a total return.

Dow Jones Utilities Average PR

Computed by summing the prices of the stocks of 15 large capitalization utility companies and then
dividing that total by an adjusted value--one which has been adjusted over the years to account for the
effects of stock splits on the prices of the 15 companies. "PR" means that this a price return index and
does not include dividends paid out by the companies in the index.

Dow Jones Utilities Average TR

Computed by summing the prices of the stocks of 15 large capitalization utility companies and then
dividing that total by an adjusted value--one which has been adjusted over the years to account for the
effects of stock splits on the prices of the 15 companies. "TR" means that this a total return index and
includes the reinvestment of dividends paid out by the companies in the index.

Barclays Capital (BarCap) 1-3 Year Government Bond

Comprised of both the Treasury Bond index (all public obligations of the U.S. Treasury, excluding flower
bonds and foreign-targeted issues) and the Agency Bond Index (all publicly issued debt of U.S.
Government agencies and quasi-federal corporations and corporate-debt guaranteed by the U.S.
Government). These bonds also must have maturities of one to three years. The returns we publish for
the index are total returns, which include reinvestment of dividends.

Barclays Capital (BarCap) Aggregate Bond Index

Composed of the Barclays Capital (BarCap) Govt/Credit Index, the Mortgage-Backed Securities
Indexes, and the Asset-Backed Securities Index, an unmanaged market value-weighted performance
benchmark for investment-grade fixed-rate debt issues, with maturities of at least one year, and an
outstanding par value of at least $100 million. The returns we publish for the index are total returns,
which include reinvestment of dividends.

Barclays Capital (BarCap) Credit Bond

This index tracks the returns of all publicly issued, fixed-rate, nonconvertible, dollar-denominated, SEC-
registered, investment-grade corporate debt. The returns we publish for the index are total returns,
which include reinvestment of dividends.

Barclays Capital (BarCap) Government Bond Index
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Listed for government-bond general and Treasury funds. Because it tracks the returns of U.S.
Treasuries, agency bonds, and one- to three-year U.S. government obligations, this index is effective for
tracking portfolios holding non-mortgage government securities. The returns we publish for the index are
total returns, which include reinvestment of dividends.

Barclays Capital (BarCap) Government/Credit

Represents a combination of the Government and Corporate Bond indexes. The returns we publish for
the index are total returns, which include reinvestment of dividends.

Barclays Capital (BarCap) Intermediate Credit Bond

Serves as a measure of all public-issued nonconvertible, investment-grade corporate debts that have a
maturity of one to three years. The returns we publish for the index are total returns, which include
reinvestment of dividends.

Barclays Capital (BarCap) Intermediate Government Index

Includes those indexes found in the LB Government Index which have a maturity of one to three years.
The returns we publish for the index are total returns, which include reinvestment of dividends.

Barclays Capital (BarCap) Intermediate Government/Credit

Includes both corporate (publicly-issued, fixed-rate, nonconvertible, investment grade, dollar-
denominated, SEC-registered, corporate dept.) and government (Treasury Bond index, Agency Bond
index, 1-3 Year Government index, and the 20+-Year treasury) indexes, including bonds with maturities
up to ten years. The returns we publish for the index are total returns, which include reinvestment of
dividends.

Barclays Capital (BarCap) Intermediate Treasury

This index includes treasury bonds with maturities of at least one year and up to 10 years with an
outstanding par value of at least 100 million. They include fixed-rate debt issues, rated investment
grade or higher by Moody's Investor Services, Standard & Poor's Corporation, or Fitch Investor's Service
(in that order). Treasuries include all public obligations of the U.S. Treasury, excluding flower bonds and
foreign-targeted issues. The returns we publish for the index are total returns, which include
reinvestment of dividends.

Barclays Capital (BarCap) Long Term Credit Bond

Serves as a measure of all public-issued nonconvertible investment-grade corporate debts that have a
maturity of 10 years or more. The returns we publish for the index are total returns, which include
reinvestment of dividends.

Barclays Capital (BarCap) Long Term Government Index

Includes those indexes found in the LB Government index which have a maturity of 10 years or more.
The returns we publish for the index are total returns, which include reinvestment of dividends.

Barclays Capital (BarCap) Long Term Government/Credit

Includes the LB Government and LB Corporate Bond indexes that have maturities of 10 years or longer.
The returns we publish for the index are total returns, which include reinvestment of dividends.

Barclays Capital (BarCap) Long-Term Treasury Index
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Includes all public obligations of the U.S. Treasury, excluding flower bonds and foreign-targeted issues
with maturities of 10 years or longer. The returns we publish for the index are total returns, which
include reinvestment of dividends.

Barclays Capital (BarCap) Mortgage-Backed Securities

Includes 15- and 30-year fixed-rate securities backed by mortgage pools of the Government National
Mortgage Association (GNMA). The returns we publish for the index are total returns, which include
reinvestment of dividends.

Barclays Capital (BarCap) Municipal Bond Index (LB Muni)

Listed for municipal-bond funds. This index serves as a benchmark for long-term, investment-grade, tax-
exempt municipal bonds. The returns we publish for the index are total returns, which include
reinvestment of dividends.

Merrill Lynch Corporate & Government Industrial/TR

This Merrill Lynch Corporate & Government Industrial Index contains investment grade (BB/BAA or
better) corporate debt and coupon-bearing Treasury issues and debt of agencies of the US
Government., with maturities ranging from 1-15+ years. It includes all issues of the US Government.
and agencies thereof, exclusive of agency pass-throughs, CMOs, and Flower Bonds.

Merrill Lynch Corporate Master Bonds/TR

The Merrill Lynch Corporate Master Bond Index reflects investment grade (BB/BAA or better) corporate
debt. It represents a cross-section of industries with maturities ranging from 1-15+ years.

Merrill Lynch Domestic Master/TR

The Merrill Lynch Domestic Master Index reflects domestic fixed income debt of mortgage-backed
securities and treasury, agency, and investment grade corporate issues with maturities ranging from 1-
30 years, exclusive of floating rate issues, equipment trust certificates, and Title II securities. The
treasury and mortgage-backed securities do not include CMO's and flower bonds.

Merrill Lynch Government Master Bonds/TR

This Merrill Lynch Government Master Bond Index is an index containing coupon-bearing Treasury
issues and debt of agencies of the US Government., with maturities ranging from 1-15+ years. It
includes all issues of the US Government. and agencies thereof, exclusive of agency pass-throughs,
CMOs, and Flower Bonds.

Merrill Lynch High Yield Master/TR

The Merrill Lynch High Yield Master Index reflects corporate debt of less than investment grade (BBB
(S&P) or BAA(Moody's)) that is not in default. It represents a cross-section of industries with maturities
ranging from 1 to 15+ years. $50 million is the minimum par amount outstanding required to qualify an
issue. Par amounts outstanding must be no less than $10 million at the start and at the close of the
performance measurement period. Floating rate debt, equipment trust certificates, and Title 11
securities are excluded.

Merrill Lynch Treasury Master/TR

The Merrill Lynch Treasury Master Index is a composite of coupon-bearing Treasury issues with
maturities ranging from 1-15+ years exclusive of Flower Bonds. Par amounts are over $10 million at the
start and close of the performance measurement period.
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MSCI AC World

A capitalization-weighted index of stocks from Argentina, Australia, Austria, Belgium, Brazil, Canada,
Chile, Columbia, Denmark, Finland, France, Germany, Greece, Hong Kong, India, Indonesia, Ireland,
Israel, Italy, Japan, Jordan, Korea, Luxembourg, Malaysia, Mexico, Netherlands, New Zealand, Norway,
Pakistan, Peru, Philippines, Poland, Portugal, Singapore, South Africa, Spain, Sri Lanka, Sweden,
Switzerland, Taiwan, Thailand, Turkey, United Kingdom, U.S.A., and Venezuela.

MSCI EAFE

This index is listed for foreign stock funds (EAFE refers to Europe, Australasia, and Far East). Widely
accepted as a benchmark for international stock performance, the EAFE Index is an aggregate of 21
individual country indexes that collectively represent many of the major markets of the world, including
Australia, Austria, Belgium, Denmark, Finland, France, Germany, Italy, Netherlands, Norway, Spain,
Sweden, Switzerland, and the United Kingdom.

MSCI Far East

The MSCI Far East Index includes companies in three countries: Japan, Hong Kong, and Singapore/
Malaysia.

MSCI Europe

This index is listed for Europe stock funds and measures the performance of stock markets in Austria,
Belgium, Denmark, Finland, France, Germany, Italy, the Netherlands, Norway, Spain, Sweden,
Switzerland, Ireland, Portugal, and the United Kingdom.

MSCI Pacific ex Japan

This index is listed for Pacific stock funds and measures the performance of stock markets in
Australia, Hong Kong, New Zealand, and Singapore, and Malaysia.

MSCI Pacific

This index is listed for Pacific stock funds and measures the performance of stock markets in
Australia, Hong Kong, Japan, New Zealand, and Singapore, and Malaysia.

NASDAQ Composite Index

Measures the performance of all issues listed in the NASDAQ Stock Market, except for rights,
warrants, units, and convertible debentures. Morningstar reports the NASDAQ Composite as a price
return.

New York Stock Exchange Composite (NYSE)

Serves as a comprehensive measure of the market trend for the benefit of investors who are concerned
with general stock market price movements. The index is a composite of all common stocks listed on
the NYSE and four sub-groups--Industrial, Transportation, Utility, and Finance. The return Morningstar
reports is a price return; it does not reflect the influence of reinvested dividends.

Russell 1000

Consists of the 1000 largest companies within the Russell 3000 index. Also known as the Market-
Oriented Index, because it represents the group of stocks from which most active money managers
choose. The returns for the index are total returns, which include reinvestment of dividends. Frank
Russell Company reports its indexes as one-month total returns.
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Russell 1000 Growth

Market-capitalization weighted index of those firms in the Russell 1000 with higher price-to-book ratios
and higher forecasted growth values. The Russell 1000 includes the largest 1000 firms in the Russell
3000, which represents approximately 98% of the investable U.S. equity market.

Russell 1000 Value

Market-capitalization weighted index of those firms in the Russell 1000 with lower price-to-book ratios
and lower forecasted growth values. The Russell 1000 includes the largest 1000 firms in the Russell
3000, which represents approximately 98% of the investable U.S. equity market.

Russell 2000

Consists of the smallest 2000 companies in the Russell 3000 Index, representing approximately 7% of
the Russell 3000 total market capitalization. The returns we publish for the index are total returns,
which include reinvestment of dividends.

Russell 2000 Growth

Market-weighted total return index that measures the performance of companies within the Russell
2000 Index having higher price-to-book ratios and higher forecasted growth values. The Russell 2000
Index includes the 2000 firms from the Russell 3000 Index with the smallest market capitalizations. The
Russell 3000 Index represents 98% of the investable U.S. equity market.

Russell 2000 Value

Market-weighted total return index that measures the performance of companies within the Russell
2000 Index having lower price-to-book ratios and lower forecasted growth values. The Russell 2000
Index includes the 2000 firms from the Russell 3000 Index with the smallest market capitalizations. The
Russell 3000 Index represents 98% of the investable U.S. equity market.

Russell 3000

Composed of the 3000 largest U.S. companies by market capitalization, representing approximately
98% of the U.S. equity market. The returns we publish for the index are total returns, which include
reinvestment of dividends.

S&P 500 MidCap 400/citigroup Value

Market capitalization-weighted index of the stocks in the Standard & Poor's MidCap 400 Index having
the highest book to price ratios. The index consists of approximately half of the S&P 400 on a market
capitalization basis.

S&P 500/Citigroup Growth

Market capitalization-weighted index of the stocks in the Standard & Poor's 500 Index having the
lowest book to price ratios. The index consists of approximately half of the S&P 500 on a market
capitalization basis.

S&P 500/Citigroup Value

Market capitalization-weighted index of the stocks in the Standard & Poor's 500 Index having the
highest book to price ratios. The index consists of approximately half of the S&P 500 on a market
capitalization basis.
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S&P MidCap 400/Citigroup Growth

Market capitalization-weighted index of the stocks in the Standard & Poor's MidCap 400 Index having
the lowest book to price ratios. The index consists of approximately half of the S&P 400 on a market
capitalization basis.

S&P SmallCap 600/Citigroup Growth

Market capitalization-weighted index of the stocks in the Standard & Poor's SmallCap 600 Index having
the lowest book to price ratios. The index consists of approximately half of the S&P 600 on a market
capitalization basis.

S&P SmallCap 600/Citigroup Value

Market capitalization-weighted index of the stocks in the Standard & Poor's SmallCap 600 Index having
the highest book to price ratios. The index consists of approximately half of the S&P 600 on a market
capitalization basis.

Standard & Poor's 100 (TR or PR)

An index comprised of the largest 100 stocks (according to the market capitalization) in the S&P 500
index. The returns we publish for the index are total returns, which include reinvestment of dividends.
TR indicates "Total Return," or the reinvestment of dividends. PR indicates "Price Return" where
dividends have not been reinvested.

Standard & Poor's 500 (TR or PR)

A market capitalization-weighted index of 500 widely held stocks often used as a proxy for the stock
market. It measures the movement of the largest issues. Standard & Poor's chooses the member
companies for the 500 based on market size, liquidity and industry group representation. Included are
the stocks of industrial, financial, utility, and transportation companies. Since mid-1989, this
composition has been more flexible and the number of issues in each sector has varied. TR (or
"Composite") indicates "Total Return," or the reinvestment of dividends. PR indicates "Price Return"
where dividends have not been reinvested.

Standard & Poor's 600 (TR or PR)

This small cap index consists of 600 domestic stocks chosen for market size, liquidity, and industry
group representation. It is a market weighted index (stock price x shares outstanding), with each stock
affecting the index in proportion to its market value. TR indicates "Total Return," or the reinvestment of
dividends. PR indicates "Price Return" where dividends have not been reinvested.

Standard & Poor's Mid-Cap 400 (TR or PR)

Includes approximately 10% of the capitalization of U.S. equity securities. These are comprised of
stocks in the middle capitalization range. At the original time of screening, this was a $200 million to
$5 billion market value range. Any mid-cap stocks already included in the S&P 500 are excluded from
this index, which started on December 31, 1990. The level of the index reflects the total market value of
all 400 component stocks relative to this date. A level of 135, for example, indicates that the market
value of the index portfolio has risen 35% from December 31, 1990. The S&P 400 figure is presented as
a total return. TR indicates "Total Return," or the reinvestment of dividends. PR indicates "Price Return"
where dividends have not been reinvested.

 Index Fund
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A fund that tracks a particular index and attempts to match returns. While an index typically has a
much larger portfolio than a mutual fund, the fund's management may study the index's movements to
develop a representative sampling, and match sectors proportionately.

Copyrights for their respective indexes:

© 2010 Dow  Jones & Company, Inc.

© 2010 Morgan Stanley Capital International, Inc. All Rights Reserved. Unpublished. PROPRIETARY TO MORGAN STANLEY

CAPITAL INTERNATIONAL INC."

15.16 User-Defined Notes

To use the Notes field, simply place the cursor on the fund and type in the comment for that fund. To
edit an existing note double-click on the Notes cell of the record you want to change.

Notes can be up to 120 characters each. If a note is longer than its column width, it will wrap
automatically to the next line. A red line will appear at the bottom of the cell if the comment is too long
to fit in the cell. At this point you can make the column wider or make all the cells larger. See 
Database View Options  for cell adjustment tips.

To create another Notes column, select Database..Add Column and type in the name of the column.

The Notes are stored globally (in the User.Mem file) and will show up no matter which Notebook you
have open.

 

15.17 Management

15.17.1 Senior Portfolio Manager Name

The names of the 4 most senior portfolio managers of the fund. Some companies prefer not to list an
individual and will instead list a company name or that it is team-managed.

 

15.17.2 Manager Starting Date & Tenure

The Manager Starting Date is the date that the most senior portfolio manager started managing the
fund.

The Manager Tenure is the number of years this portfolio manager has been managing the fund.

 

15.17.3 Management Company Name

This long text field contains the full management company name (often called the fund FAMILY name).
The family name is usually (but not always) also mentioned in some way in the Name field.

This field and the Management Company Code are not the only fields that can identify the funds in
each family, however. Generally, the telephone numbers listed for funds in the same family are
identical, and can be used in many cases for selecting funds of the same family.

 

109
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15.17.4 Management Company Code

Similarly to the Fund Number field, this unique numeric code is meant to assist users in performing
selections of the funds under a management company (or "family") without having to use the
management company name, which is long and may change more often than its code.

 

15.18 Portfolio Information

15.18.1 General Portfolio Information

Portfolio Date

The date the portfolio was reported.

Number of Holdings

The total number of holdings in the portfolio..

Top-10 Holdings Percent

The aggregate assets, expressed as a percentage, of the fund's top 10 portfolio holdings. This figure
can be used as a measure of portfolio risk. Specifically, the higher the percentage, the more
concentrated the fund is in a few companies or issues, and the more the fund is susceptible to the
market fluctuations in these few holdings.

15.18.2 Style Boxes

Equity Style Box

The Equity Style Box is a grid that provides a graphical representation of the investment style of stocks
and portfolios. It classifies securities according to market capitalization (the vertical axis) and
growth and value factors (the horizontal axis) and provides analysis on a 3-by-3 Style Box - as well
as providing the traditional style box assignment, which is the basis for the Category field. Two of the
style categories, value and growth, are common to both stocks and portfolios. However, for stocks, the
central column of the style box represents the core style (those stocks for which neither value or
growth characteristics dominate); for portfolios, it represents the blend style (a mixture of growth and
value stocks or mostly core stocks). Furthermore, the core style for individual stocks is wider than the
blend style for portfolios. See Equity Style Box Breakdown .

Bond Style Box

This model is based on the two pillars of fixed-income performance: interest-rate sensitivity and credit
quality. The three duration groups are short, intermediate, and long-term, and the three credit quality
groups are high, medium, and low quality. These groupings display a portfolio's effective duration and
credit quality to provide an overall representation of the fund's risk, given the length and quality of bonds
in its portfolio. As with equity funds, nine possible combinations exist, ranging from short duration/high
quality for the safest funds to long duration/low quality for the riskiest.

The Style Box fields contain numeric values of 0 (blank) and 1-9 which can be easily used in the
Filtering environment.
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15.18.3 Equity Style Box Breakdown

Equity Style Box

The Equity Style Box is a grid that provides a graphical representation of the investment style of stocks
and portfolios. It classifies securities according to market capitalization (the vertical axis) and
growth and value factors (the horizontal axis) and provides analysis on a 3-by-3 Style Box - as well
as providing the traditional style box assignment, which is the basis for the Category field. Two of the
style categories, value and growth, are common to both stocks and portfolios. However, for stocks, the
central column of the style box represents the core style (those stocks for which neither value or
growth characteristics dominate); for portfolios, it represents the blend style (a mixture of growth and
value stocks or mostly core stocks). Furthermore, the core style for individual stocks is wider than the
blend style for portfolios. Large-cap stocks are those that together account for the top 70% of the
capitalization of each style zone; mid-cap stocks represent the next 20%; and small-cap stocks
represent the balance.  The market caps that correspond to these breakpoints are flexible and may
shift from month to month as the market changes.  See Style Boxes .

The Equity Style Box Breakdown percentage figures represent the percentage of a fund’s assets that
are classified to belong to each of the 9 equity style classifications. For example, a value of 46.58 in
the “Large Cap - Value” column means that 46.58% of that fund’s assets have been classified as
securities belonging to the “Large Cap - Value” classification.

Large Cap-Value

Top row, left corner quadrant of the Equity Style Box.

Large Cap-Blend

Top row, middle column quadrant of the Equity Style Box.  

Large Cap-Growth

Top row, right corner quadrant of the Equity Style Box.

Mid Cap-Value

Middle row, left corner quadrant of the Equity Style Box.

Mid Cap-Blend

Middle row, middle column quadrant of the Equity Style Box.  

Mid Cap-Growth

Middle row, right corner quadrant of the Equity Style Box.

Small Cap-Value

Bottom row, left corner quadrant of the Equity Style Box.

Small Cap-Blend

Bottom row, middle column quadrant of the Equity Style Box.  

Small Cap-Growth
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Bottom row, right corner quadrant of the Equity Style Box.

15.18.4 Assets - Total Net Assets

This is the total amount of assets under management expressed in millions. For example, a figure of
1,340.2 means $1,340,200,000.

 

15.18.5 NAV - Net Asset Value

The net asset value (NAV) is the dollar value price per share of the fund, which can change every
trading day. The NAV shown for each fund is from the final trading day of the month of the data file.

Fund expenses for management, administrative, 12b-1 fees and other costs taken out of fund assets
are reflected in the fund's NAV.

15.18.6 Turnover - Portfolio Turnover Rate

This field indicates the rate (expressed as a percent) at which securities in the fund's portfolio are sold
and replaced by newly purchased securities per year.

Generally, the greater the buying and selling activity, the higher the turnover rate.

The rate is calculated by dividing the average of annual purchases and sales, by the average total net
assets for the year.

 

15.18.7 Asset Allocation Breakdown

Expressed as percentages, the following fields, including the Cash field, represent the portion of each
fund invested in these general categories of securities:

1. US Stocks

2. Preferred Stocks

3. Convertible Issues

4. Non-US Stocks

5. US Bonds

6. Non-US Bonds

7. Cash & Equivalents

8. Other Securities

There are two sets of asset allocation breakdowns: Net positions (Long and Short) and Short-only
positions.

 

15.18.8 Equity World Region Allocation

Each region's exposure is presented as the percentage of the non-cash equity assets held by a fund.
Regional exposure information summarizes a portfolio's exposure to geopolitical risk.
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The various world regions are organized as follows:

Developed Markets
Emerging Markets

Americas
o North America

United States
Canada

o Latin America

Greater Europe
o United Kingdom

o Developed Europe

Eurozone
Europe excluding Eurozone

o Emerging Europe

o Middle East

o Africa

Greater Asia
o Japan

o Australasia

o Developed Asia

o Emerging Asia

15.18.9 Equity Sectors

Portfolio diversification is generally thought of in terms of market capitalization and investment style,
yet sector diversification is equally important. For example, pursuing a growth investment style via
internet stocks leads to substantially different portfolios, and results, than pursuing growth via health
services stocks. 

The sector breakdown structure allows for intelligent diversification, and makes it easier to understand
the decisions being made by portfolio managers. 

It divides the stock universe into 3 major economic spheres or Equity Super Sectors: Cyclical,
Defensive and Sensitive. Within each of these Super Sectors, 3 sectors for Defensive,  4 for Cyclical
and 4 for Sensitive are defined for a total of 11 individual sectors.

This allows investors to quickly evaluate the similarities and differences of funds and portfolios by
comparing exposure to the 3 Super Sectors, but also permits further examination of holdings at the
individual sector level.

Cyclical

Basic Materials
Consumer Cyclical
Financial Services
Real Estate 

Defensive

Consumer Defensive
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Healthcare
Utilities 

Sensitive

Communication Services
Energy
Industrials
Technology

CYCLICAL

Basic Materials

Companies that manufacture chemicals, building materials and paper products. This sector also
includes companies engaged in commodities exploration and processing. Companies in this sector
include ArcelorMittal, BHP Billiton and Rio Tinto.

Consumer Cyclical

This sector includes retail stores, auto and auto parts manufacturers, companies engaged in residential
construction, lodging facilities, restaurants and entertainment companies. Companies in this sector
include Ford Motor Company, McDonald’s and News Corporation.

Financial Services

Companies that provide financial services which includes banks, savings and loans, asset management
companies, credit services, investment brokerage firms, and insurance companies. Companies in this
sector include Allianz, J.P. Morgan Chase and Legg Mason.

Real Estate

This sector includes mortgage companies, property management companies and REITs. Companies in
this sector include Kimco Realty Corporation, Vornado Realty Trust and Westfield Group.

DEFENSIVE

Consumer Defensive

Companies engaged in the manufacturing of food, beverages, household and personal products,
packaging, or tobacco. Also includes companies that provide services such as education & training
services. Companies in this sector include Philip Morris International, Procter & Gamble and Wal-Mart
Stores.

Healthcare

This sector includes biotechnology, pharmaceuticals, research services, home healthcare, hospitals,
long-term care facilities, and medical equipment and supplies. Companies in this sector include Astra
Zeneca, Pfizer and Roche Holding.

Utilities

Electric, gas, and water utilities. Companies in this sector include Electricité de France, Exelon and
PG&E Corporation.
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SENSITIVE

Communication Services

Companies that provide communication services using fixed-line networks or those that provide wireless
access and services. This sector also includes companies that provide internet services such as
access, navigation and internet related software and services. Companies in this sector include AT&T,
France Telecom and Verizon Communications.

Energy

Companies that produce or refine oil and gas, oil field services and equipment companies, and pipeline
operators. This sector also includes companies engaged in the mining of coal. Companies in this
sector include BP, ExxonMobil and Royal Dutch Shell.

Industrials

Companies that manufacture machinery, hand-held tools and industrial products. This sector also
includes aerospace and defense firms as well as companies engaged in transportation and logistic
services. Companies in this sector include 3M, Boeing and Siemens. 

Technology

Companies engaged in the design, development, and support of computer operating systems and
applications. This sector also includes companies that provide computer technology consulting
services. Also includes companies engaged in the manufacturing of computer equipment, data storage
products, networking products, semiconductors, and components. Companies in this sector include
Apple, Google and Microsoft.

15.18.10Fixed-Income Sectors

The fixed-income securities in an investment portfolio are mapped into one of 17 Sectors, which in turn
roll up to 6 Fixed-income Super Sectors. These  sectors help investors and investment professionals
easily compare and understand the sector exposure of each portfolio. This data is especially useful for
comparing two investments that may be in the same Category.

Fixed-Income Super Sectors & Sectors

Government

Government
Government Related

Municipal

Municipal Taxable
Municipal tax-Exempt

Corporate 

Bank Loan
Convertible
Corporate Bond
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Preferred Stock

Securitized 

Agency Mortgage-Backed
Non-Agency Residential Mortgage-Backed
Commercial Mortgage-Backed
Covered Bond
Asset-Backed

Cash & Equivalents

Cash & Equivalents

Derivatives

Swap
Future/Forward
Option/Warrant

SUPERSECTORS

Government

This Super Sector includes all conventional debt issued by governments, bonds issued by a Central
Bank or Treasury, and bonds issued by local governments, cantons, regions and provinces. 

Municipal 

The Municipal Super Sector includes taxable and tax-exempt debt obligations issued under the
auspices of states, cities, counties, provinces, and other non-federal government entities. 

Corporate 

This Super Sector includes bank loans, convertible bonds, conventional debt securities issued by
corporations, and preferred stock. 

Securitized 

The Securitized Super Sector includes all types of mortgage-backed securities, covered bonds and
asset-backed securities. 

Cash & Equivalents 

This Super Sector includes cash in the bank, certificates of deposit, currency, and money market
holdings. Cash can also be any fixed-income securities that mature in less than 12 months. This Super
Sector also includes commercial paper and any repurchase agreements held by the fund. 

Derivatives 

The Derivatives Super Sector includes the common types of fixed-income derivative contracts: futures
and forwards, options and swaps. 

SECTORS
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GOVERNMENT

Government

This sector includes all conventional debt issued by governments, including bonds issued by a Central
Bank or Treasury and bonds issued by local governments, cantons, regions and provinces. 

Government Related

This sector includes debt obligations issued by government agencies as well as interest-rate swaps
and Treasury futures that are generally considered to have a risk profile commensurate with government
bonds but may not have explicit government backing. Bonds issued by government-sponsored
enterprises such as Federal National Mortgage Association and Federal Home Loan Mortgage
Corporation can be found in this sector, while securities backed by mortgages that carry guarantees
from government agencies can be found in the agency mortgage backed sector.

MUNICIPAL

Municipal Taxable

United States regulations require that bonds benefiting from a federal tax exemption be issued only for
certain purposes. The interest on municipal bonds may be taxable (that is, not excluded from gross
income for federal income tax purposes) if they are deemed to be issued in support of certain private
activities.

Municipal Tax-Exempt

Local governments, state governments, provinces, and regional authorities are often referred to more
generally as "municipalities" and typically issue bonds in order to raise money for operations and
development. This financing is sometimes used to build or upgrade hospitals, sewer systems, schools,
housing, stadiums, or industrial complexes. Some municipal bonds are backed by the issuing entity,
while others are linked to a revenue stream, such as from a toll way or a utility. Municipal bonds in the
United States are typically exempt from federal taxes and often the taxes of the states in which they
are issued. Those taxation advantages may allow municipal governments to sell bonds at lower interest
rates than those offered by comparable taxable bonds.

CORPORATE

Bank Loan

The bank loans most commonly held within investment portfolios are typically referred to as leveraged
loans, because the balance sheets of their borrowers carry heavy debt burdens. Loans of this kind are:
normally issued with interest payments that float above a commonly used short-term benchmark such
as the London Interbank Offered Rate, or LIBOR, by at least 300 basis points; typically senior to nearly
all other debt and equity in a company's capital structure; and very often secured by specific assets or
cash flows. 

Convertible
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Convertible bonds and convertible preferreds give their owners an opportunity to convert each security to
a certain number of shares of common stock at a certain price. As the stock approaches that price, the
option to convert becomes more valuable and the price of the convertible also rises. These securities
usually provide lower interest payments because the option to convert to stock could potentially be
quite valuable at some point in the future.

Corporate Bond

This sector includes all conventional debt securities that are issued by corporations. Corporate bonds
are issued with a wide range of coupon rates and maturity dates.

Preferred Stock

Preferred stock is legally structured as equity, above common equity in a company's capital structure,
but does not offer voting rights. Preferred stock often pays a fixed dividend and has priority over
common equity when an issuing company elects to pay dividends. Although preferred stocks are not
debt instruments, investors often treat them as such because of their income payouts and higher
capital-structure placement.

SECURITIZED

Agency Mortgage-Backed

This sector contains securities that represent a claim on the cash flows associated with pools of
mortgages guaranteed by a government agency. Rolling into this sector are items such as mortgage
pass-throughs, mortgage CMOs, and mortgage ARMs. These securities are guaranteed by Ginnie
Mae, an agency of the U.S. government, or by U.S.-government-sponsored enterprises such as Fannie
Mae or Freddie Mac.

Non-Agency Residential Mortgage-Backed 

Non-agency residential mortgage-backed securities are those not issued and guaranteed by Fannie
Mae, Freddie Mac, or Ginnie Mae. Conforming loan size limits set by the U.S. government determine if
a mortgage loan can qualify for an agency guarantee, and those that do not qualify make up the bulk of
non-agency RMBS collateral. Because they lack a third-party guarantee, protection in the case of non-
agency RMBS is generally provided through the creation of subordinate securities. These are first in
line to offer credit protection to the senior most AAA rated classes and are accordingly priced at lower
prices relative to AAAs, reflecting their higher exposure to credit risk.

Commercial Mortgage-Backed 

A type of mortgage-backed security backed by mortgages on commercial rather than residential real
estate.

Covered Bond 

Covered bonds are securities issued by a bank and backed by either high-quality mortgage loans or
public-sector loans, which represent the "cover pool." Issuers raise assets for cover pools by selling
"covered bonds" to investors, which maintain a claim on the cover pool but also a claim on the general
assets and credit of the issuer. Part of what differentiates a cover pool from the assets supporting a
typical mortgage-backed security is that the cover pool remains on the balance sheet of its issuer,
usually a bank or special financial institution set up for this purpose.
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Asset-Backed 

Asset-backed securities are based on the expected cash flows from debts such as auto loans, credit
card receivables, and computer leases among others. The cash flows for asset-backed securities can
be fixed or variable. These securities typically range in effective maturity from two to seven years.

CASH & EQUIVALENTS

Cash & Equivalents 

Cash can be cash in the bank, certificates of deposit, currency, or money market holdings. Cash can
also be any fixed-income securities that mature in less than 12 months. Cash also includes
commercial paper and any repurchase agreements held by the fund.

DERIVATIVES

Swap

Swaps are risk-shifting, over-the-counter agreements that allow one party to trade one type of exposure
for another. Each party agrees in advance to trade one set of payments (e.g., fixed or floating interest
rates on a predetermined notional amount) for a different set of payments for a set amount of time.

Future/Forward

By entering into a futures contract, the buyer (long position) has an obligation to purchase a specific
underlying asset at an agreed-upon price at a specific date in the future. The seller of the futures
contract takes a short position in the asset and agrees to sell it according to those terms.

Forward contracts are very similar to futures contracts in that they also represent the obligation to buy
or sell a specific asset on a specific future date.

Option/Warrant

Options are contracts that allow the holder to profit if the price of the underlying asset moves in a
certain direction. Call options give the holder (the long position) the right, but not the obligation, to buy
an asset at a predetermined strike price and profit when the asset price is higher than the strike price.
Put options give the holder the right to sell an asset at a specific strike price and profit when the market
price of the asset is below the strike price. The parties that write options take a short position and have
the obligation to sell or buy the asset from the long position if the option is exercised.

Warrants are a type of call option that is issued by the company, usually as part of a bond offering.

15.18.11Top 10 Sectors

The Top 10 Sectors allocation of the mutual fund based on their percentage in its portfolio.

These Sectors are Economic for equity funds, Bond-type breakdown for bond funds and Country
breakdown for non-U.S. funds.

 



STEELE Mutual Fund Expert188

© 2024 Steele Systems, Inc.

15.18.12Top 10 Countries

The Top 10 Countries allocation of the mutual fund based on their percentage in its portfolio.

15.18.13Top 10 Securities

The top 10 security holdings of each mutual fund based on their percentage in its portfolio.

15.18.14Average Price/Earnings Ratio

The Price/Earnings Ratio or P/E Ratio is a stock's current price divided by the company's trailing 12-
month (TTM) earnings per share from continuous operations.

The P/E ratio of a fund is the weighted average of the price/earnings ratios of the stocks in a fund's
portfolio. In computing the average, each portfolio holding is weighted by the percentage of equity
assets it represents, so that larger positions have proportionately greater influence on the fund's final P/
E. 

A high P/E usually indicates that the market will pay more to obtain the company's earnings because it
believes in the firm's ability to increase its earnings. Companies in those industries enjoying a surge of
popularity (e.g., telecommunications, biotechnology) tend to have high P/E ratios, reflecting a growth
orientation. (P/Es can also be artificially inflated if a company has very weak trailing earnings, and thus
a very small number in this equation's denominator.) 

A low P/E indicates the market has less confidence that the company's earnings will increase;
however, a fund manager or an individual with a 'value investing' approach may believe such stocks have
an overlooked or undervalued potential for appreciation. More staid industries, such as utilities and

mining, tend to have low P/E ratios, reflecting a value orientation.

A fund's price/earnings ratio can act as a gauge of the fund's investment strategy in the current market
climate, and whether it has a value or growth orientation. 

15.18.15Average Price/Book Ratio

The price/book ratio of a fund is the weighted average of the price/book ratios of all the stocks in a
fund’s portfolio.

Book value is the total assets of a company, less total liabilities. 

A company’s P/B ratio is calculated by dividing the market price of its outstanding stock by the
company’s book value, and then adjusting for the number of shares outstanding. (Stocks with negative
book values are excluded from this calculation.) 

In computing a fund’s average P/B ratio, each portfolio holding is weighted by the percentage of equity
assets it represents; larger positions thus have proportionately greater influence on the final P/B. A low
P/B may indicate that the stocks are bargains, priced below what the company’s assets could be
worth if liquidated.

The price/book ratio can tell investors approximately how much they are paying for a company’s
assets, based on historical, rather than current, valuations. Historical valuations generally do not reflect
a company’s current market value. Value investors frequently look for companies that have low price/
book ratios.

The P/B ratio of a company relates the per-share market price of the company’s stock to its per-share
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book value, the historical accounting value of the company’s tangible assets. This figure may not
always represent the real value of a company because it excludes such intangible assets as patents
and trademarks. A high P/B ratio indicates that the price of the stock exceeds the actual worth of the
company’s assets. A low P/B ratio would indicate that the stock is a bargain, priced below what the
company’s assets could be worth if liquidated. Historically, value investing based on P/Bs has been
very popular with both investors and fund managers. By investing in stocks with low P/B ratios, an
investor can actually purchase the tangible assets of the company for less than they are worth. One
way in which stocks can become undervalued in this way is because book value records the assets at
their initial cost minus all depreciation. If the company has older assets that have been significantly
depreciated, their actual worth may be much higher.

15.18.16Average Market Capitalization

(Applies to Equity Funds Only)

It is defined as the overall "size" of a stock fund's portfolio as the geometric mean of the market
capitalization for all of the stocks it owns.

It is calculated by raising the market capitalization of each stock to a power equal to that stock's stake
in the portfolio. The resulting numbers are multiplied together to produce the geometric mean of the
market caps of the stocks in the portfolio, which is reported as Average Market Capitalization. For
example, if a fund currently held equal stakes in three stocks, with market capitalizations of $2 billion,
$10 billion, and $25 billion, the geometric mean would equal:  ($2 billion 1̂/3) x ($10 billion 1̂/3) x ($25
billion 1̂/3)  = $7.94 billion.

This number is different from the fund's median market capitalization - the capitalization of the median
stock in its portfolio. The geometric mean better identifies the portfolio's "center of gravity." That is, it
provides more accurate insight into how market trends (as defined by capitalization) might affect the
portfolio.  This calculation is based on the fund’s most recently updated portfolio and month-end stock
statistics as they have been determined by the underlying equities held by the fund.

(The median is a statistical measure of central tendency.

A median market capitalization is found by arranging the securities in a portfolio in order by market
capitalization and selecting the middle market capitalization value. The market capitalization for an
individual security is calculated by multiplying the number of shares outstanding of the security by the
current market value of the security.)

15.18.17Average Bond Quality

Average Bond Quality gives a snapshot of the portfolio's overall credit quality.

It is an average of each bond's credit rating, adjusted for its relative weighting in the portfolio as
assigned by Standard & Poor's or Moody's. Because it is rare to find individual bonds in a portfolio with
a rating below B, the average credit quality of bond funds used by Morningstar ranges from AAA
(highest) to B (lowest). AAA bonds carry the highest credit rating, while bonds issued by speculative
companies usually carry the lowest credit ratings.

For taxable bonds, anything at or below BB is considered a high-yield or junk bond. For municipal
bonds, anything at or below BBB is considered a high-yield or junk bond. For the purpose of
Morningstar's calculations, U.S. government bonds are considered AAA. Non-rated municipal bonds
generally are classified as BBB. Other nonrated bonds generally are considered B. "beB" means below
B.
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15.18.18Average Coupon

(Applies to Fixed Income and Mixed Funds Only) The average of the fixed income securities’ face
coupon rate in a portfolio. This does not take into account the current market value of the fixed income
security or the current yield.

Following is the formula used to calculate average coupon:

  

where

  x = number of fixed income securities

  C = Coupon Rate

  t = each fixed income security

 

15.18.19Average Duration

(Applies to Fixed Income and Mixed Funds Only)

Duration is a measure of a fixed income security’s lifetime that accounts for the entire pattern of cash
flows over the life of the fixed income security. It measures the weighted average maturity of a fixed
income security’s cash flows on a present value basis. Another explanation is that duration is the
number of years needed to fully recover the purchase price of a fixed income security, given the present
value of its cash flows.

Following is the formula used to calculate average duration:

X
where

 t = the time period in which the cash flow is received (usually coupon bonds are paid semi-
annually)

 n = the remaining time to maturity

 x = total number of fixed income securities in the portfolio

 PV = present value

 MV = market value of the fixed income security

 s = each fixed income security
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15.18.20WAM - Weighted Average Maturity

This field is only applicable to fixed-income and money-market funds. It is the average number of years
that all the income securities of a fund will take to mature, weighted by the value of each security.

The weighted average maturity of a fund indicates whether the securities in the fund's portfolio represent
short, intermediate, or long-term debt obligations, providing investors with insights regarding the
potential risks and rewards associated with different terms to maturity.

Following is the formula used to calculate weighted average maturity:

where

  t = each individual fixed income security

  n = the number of fixed income securities

  MV = market value of the fixed income security

  Y = years left to maturity

 

15.19 Fees and Expenses

15.19.1 Expenses - Expense Ratio: Management Fees

It is the percentage of fund assets used to pay for operating expenses and management fees, including
12b-1 fees, administrative fees, and all other asset-based costs incurred by the fund, except brokerage
costs.

Fund expenses are reflected in the fund's NAV.  Sales charges are not included in the expense ratio.

The expense ratio for fund of funds is the aggregate expense ratio as defined as the sum of the wrap or
sponsor fees plus the estimated weighted average of the underlying fund fees. The Expense Ratio is
collected annually from a fund's prospectus. 

15.19.2 Actual 12b-1 Fees

The maximum annual charge deducted from fund assets to pay for marketing, advertising, and
distribution expenses, as opposed to management fees.

Although usually set on a percentage basis, this amount will occasionally be a flat figure. Only active
12b-1 plans are represented here. This information is taken directly from the fund’s prospectus. Not all
funds charge such fees.

The Expense Ratio includes the 12b-1 fee, as well as the management fee, and any other
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miscellaneous fees and/or waivers.  It does not include brokerage fees.

15.19.3 Front Load - Maximum

The initial, or front-end, sales charge is a one-time deduction from an investment made into the fund. 

The sale charge is expressed as a percentage of the amount to be invested. It is a "front load" which is
deducted immediately upon investment in the fund and is used to pay for sales commissions and other
marketing-related expenses. Therefore, if you buy $1,000 of a fund with a 5% front load, essentially,
you will be paying a $50 sales charge and investing the remaining $950.

The sales charge serves as a commission for the broker who sold the fund. The load fee compensates
the broker or financial planner for the service of providing professional investment advice.

This is the maximum front-end sales charge. The amount is generally relative to the amount of the
investment, so that larger investments incur smaller rates of charge. Visit the fund's website or refer to
the fund's prospectus for details on breakpoints and their corresponding reduced sales charges, when
applicable.

A fund's potential fees and sales charges are an important factor to consider before making an
investment. Funds with no sales charges and other back-end fees are often referred to as "No-Load"
mutual funds.

15.19.4 Deferred, Redemption Charges

Deferred sales charges are "back-end loads" which are assessed when you sell your shares within a
specified time period after buying them. This percentage amount usually declines as more time
passes, so that if you hold the shares long enough, there would be no deferred charge upon their sale.
Usually, such charges apply only to the amount of the initial purchase, and not to the return portion of
your investment.

The percentage charged is usually applied to the lower of the beginning price or ending price.

Redemption fees are also expressed as a percentage, applied only upon the sale of your shares, and
they usually decline with time. However, they apply to every dollar redeemed, regardless of the amount
of your initial investment.

This fee does not go back into the pockets of the fund company, but rather into the fund itself and thus
does not represent a net cost to shareholders. Also, unlike contingent deferred sales charges,
redemption fees typically operate only in short, specific time clauses, commonly 30, 90, 180, or 365
days. However, some redemption fees may exist for up to five years. Charges are not imposed after the
stated time has passed. These fees are typically imposed to discourage market timers, whose quick
movements into and out of funds can be disruptive. The charge is normally imposed on the ending
share value, appreciated or depreciated from the original value.

These figures are maximum amounts. Please visit the website of the fund and consult the prospectus
of each fund to find out the exact schedule of fees.

Redemption Fee Maximum Period expressed in days is the period that must pass for the
redemption fee to be reduced to zero.



Data Definitions 193

© 2024 Steele Systems, Inc.

15.19.5 True No-Load

Denoted with a "Y", this is any fund with maximum sales charges and 12b-1 fees equal to zero.

Management fees, however, may be higher, since marketing charges come directly out-of-pocket. True
no-load funds are normally, but not always, cheaper to own than load funds with distribution fees. While
true no-load funds may be attractive from an expense standpoint, this does not suggest that funds with
loads should be shunned. Many funds with consistently above-average track-records have fees and
expenses attached. In many cases these may be marketing fees (often 12b-1 fees) or charges to cover
administrative costs, rather than broker commissions. Clearly, investors fare best by reading a fund’s
prospectus carefully, and weighing the factor of fees and expenses into any fund-investing decision.

15.20 Purchasing Information

15.20.1 Open - Accepting New Funds?

This field answers the question, "Is this fund open to accept NEW investors?".

If the answer is N (No), then the fund is "closed" to new investors. Some funds stop accepting new
investments when their total assets exceed a certain level, because as a fund's asset size grows, its
ability to accomplish its particular investment objectives may be affected. In trying to avoid
compromising their goals, certain funds may stop opening new accounts, usually only for a temporary
period of time.

Normally, this does not apply to EXISTING customers - investors with established accounts who are
interested in increasing their investment.

This field is updated monthly. If you are very interested in a fund that is listed as NOT open, you might
want to call that fund to verify if it is still closed, and to inquire as to when it may re-open.

 

15.20.2 Systematic Withdrawal Plan

This is a plan offered by mutual funds that pays specific amounts to shareholders at predetermined
intervals.

It can be a useful feature in retirement planning.

15.20.3 Minimum Purchase Amounts

These fields indicate the minimum INITIAL dollar amount required to open an account, and the
minimum SUBSEQUENT amount required when adding to an existing account.

 

15.20.4 Min. IRA Purchase Amounts

These fields indicate the minimum INITIAL dollar amount required to open an IRA account, and the
minimum SUBSEQUENT amount required when adding to an existing IRA account.

Since IRA's have relatively low maximum amounts that can be invested in them, mutual fund
companies usually have different (lower) minimum purchase amounts for IRA initial and subsequent
investments.
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15.20.5 Switch - Telephone Switching

Telephone switching is a special service provided by some investment companies that manage more
than one mutual fund (they offer a "family" of funds), allowing investors to move their money easily
among the funds in the family, via telephone.

If the field value is Y (yes), then switching is available, and you should find out what other funds are in
the same family that you might want to be switching some of your invested dollars to.

Many investment companies offer this service free of charge, but not all. To be safe, ask about any
switching charges before telephoning in a switch.

You can find out which funds are in the same family by selecting those that have either the same
TELEPHONE number(s) or, in the Pro and Pro Plus editions, the same MANAGEMENT COMPANY
CODE or NAME.

 

15.20.6 Toll-Free & Telephone Number

The telephone number fields are provided for obtaining information from the funds directly, such as
ordering a prospectus and account forms. The Telephone Number is provided, because not all funds
have a toll-free number, and those that do are sometimes very busy.

 

15.21 Short-Term Performance

15.21.1 Short-Term Performance

This area includes the following data:

 1. 1-Month Return

 2. 3-Month Return

 3. 6-Month Return

 4. 9-Month Return

 5. 12-Month Return

Each of the short-term period returns represents the total return for the period.

 

The formula used to calculate these returns is as follows:

R = (v2 - v1) / v1 x 100

v1 = Value of the investment at beginning of the period
v2 = Value of the investment at end of the period

R = Total return for the period expressed as a percentage

 

15.21.2 YTD - Year-To-Date Return

This field holds the total return accumulated in the current calendar year so far. For example, when the
month of the data file is April, the value represents the total return for the months of January through
April.
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In December, this field value will match the 12-Month return field value.

The returns do account for management, administrative, 12b-1 fees and other costs taken out of fund
assets.

15.21.3 Monthly Returns

The value for each field is the total return for the security in each month shown. It includes all
distributions, such as dividends, and capital gains.

The returns do account for management, administrative, 12b-1 fees and other costs taken out of fund
assets.

The last 120 months (10 years) are included in the Personal and Pro editions, while the Pro Plus
database includes monthly historical returns back to 1962.

15.21.4 Yield - 12-Month Yield

Also known as distribution yield, this field reflects the income distributions of the most recent 12-month
period as they relate to the current month-end NAV (net asset value).

This yield is the income distribution yield to the investor. Income refers only to interest payments from
fixed-income securities and dividend payoffs from common stocks.

It is calculated by dividing the sum of the income distributions per share paid during the last 12 months
by the sum of the current offering price (NAV) plus any capital gains distributions per share made
during that period. The result is multiplied by 100 and is expressed as a percent.

The formula for the 12-Month Yield is:

Income distributions per share for last 12-months / (Current Offer Price (NAV) + Capital Gains per share
for last 12-months)

15.21.5 SEC 30-day Yield

SEC 30-day Yield

30-day yield as required by the SEC. Calculated according to the standards of the Securities and
Exchange Commission.

The calculation is based on a 30-day period ending on the last of the previous month. It is computed by
dividing the net investment income per share earned during the period by the maximum offering price
per share on the last day of the period. The figure lags by one month.

SEC Yield Effective Date

The date of the most recent SEC Yield.
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15.22 Long-Term Performance

15.22.1 Calendar Year Returns

The value for each field is the total return for the fund in each CALENDAR year shown. The last 10
calendar year returns are included in the Personal and Pro edition data files, while the Pro Plus data
files include annual return data since 1962.

Each December, the oldest historical year is dropped and the new annual return is added to the list, so
all the annual years are advanced in their values. You will notice that your Database View files reflect
this shift, and you may want to make adjustments as this happens.

The returns do account for management, administrative, 12b-1 fees and other costs taken out of fund
assets.

15.22.2 Annualized Returns: 3, 5, 10, 15, & 20-Year

These fields reflect the annualized average rate of return of a security an investor would have enjoyed for
each of the periods listed. The annualized return is equivalent to the compound rate of return which,
over a certain period of time, would produce a security's total return over that same period.

Reinvestment of all dividends and capital gains distributions for each period is assumed. The returns do
account for management, administrative, 12b-1 fees and other costs taken out of fund assets. 

These long-term return performance fields are computed with monthly data, ending with the month of
the data file being viewed. They are updated monthly.

1)1(
1

T

n
T

t
tA RR

T = Number of periods

n = Number of periods in a year (12 for monthly returns)

15.22.3 Total Returns: 3, 5, 10, 15, & 20-Year

Total (cumulative) return figures include the actual change in NAV  (net asset value) over the period
listed, plus it is assumed that all dividends and capital gains distributions are reinvested at the time
they were made. Any miscellaneous distributions and stock splits are also accounted for accurately in
these calculations.

The returns do account for management, administrative, 12b-1 fees and other costs taken out of fund
assets. 

These long-term return performance fields are computed with monthly data, ending with the month of
the data file being viewed.

180



Data Definitions 197

© 2024 Steele Systems, Inc.

The formula used to calculate these returns is as follows:

R = (v2 - v1) / v1 x 100

 

v1 = Value of the investment at beginning of the period

v2 = Value of the investment at end of the period

R = Total return for the period expressed as a percentage

 

15.22.4 Load-Adjusted Returns

The Load-Adjusted Returns correspond to the normal Average and Total Returns except that they are
adjusted for (net of) front-end, deferred and back-end (redemption) loads. Load-Adjusted Total Return
and Load-Adjusted Average Return are the total and annualized returns over the life of the fund. The
"Years Since Inception" field contains the fractional number of years the fund has been in existence.

For funds with front-end loads, the full amount of the load is deducted. For deferred loads, the
percentage charged often declines the longer the shares are held. This charge, often coupled with a
12b-1 fee, usually disappears entirely after several years. The mutual fund load-adjusted return is
defined as the holding period return where a shareholder invests money at the beginning of the period,
pays all applicable loads and redemption fees, and completely liquidates the investment at the end of
the period.

 

See also:

Annualized Returns: 3, 5, 10, 15, & 20-Year

Total Returns: 3, 5, 10, 15, & 20-Year

Maximum Sales Charge

15.22.5 After-Tax Returns

SEC Pre-Liquidation Return

A tax-adjusted total return that is based on the following assumptions:

1. The investor does not sell the holding at the end of the time period.

2. Distributions are taxed at the highest individual federal tax-rate in effect at the time of each
distribution and then reinvested.

3. State and local taxes are excluded.

4. Only the capital gains are adjusted for tax-exempt funds, because the income from these funds is
nontaxable.

SEC Post-Liquidation Return

A tax-adjusted total return that is based on the following assumptions:

1. The investor sells the holding at the end of the time period and pays capital gains taxes on any

196
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appreciation in price.

2. Distributions are taxed at the highest individual federal tax-rate in effect at the time of each
distribution and then reinvested.

3. State and local taxes are excluded.

4. Only the capital gains are adjusted for tax-exempt funds, because the income from these funds is
nontaxable.

These returns follow the guidelines established by the SEC in the spring of 2001 for reporting after-tax
performance. Besides the tax-adjustment, these returns are also adjusted for the effects of sales loads
per the SEC's recommendation.

The actual after-tax return depends on each investor's individual tax situation and may differ from
these figures.

If the shares are in a tax-deferred account such as an IRA or 401(k) plan, these returns do not apply
to that investment because these accounts are not subject to current taxes.

If a fund or ETF incurs a loss that generates a tax benefit, the post-liquidation after-tax return may
exceed the fund's or ETF's other return figures.

After-tax returns for most funds and ETFs are calculated using the tax liability implied by each fund's
or ETF's declared distributions. However, the exact tax characteristics of many distributions are not
known until after the close of the calendar year.

15.23 Risk and Statistics

15.23.1 Modern & Post-Modern Portfolio Theory

Modern Portfolio Theory (MPT)

When MPT was first introduced, it revolutionized the investment world. It held that risk was as
important as return. Investors who considered the tradeoff of a return - its risk - could make more
money over the long term. Before this concept was revealed, investors measured the desirability of an
investment solely by its expected return. Return was measured, as always, by the gain made on an
investment. Risk was measured by the amount the investment would fluctuate, or deviate, from its
average rate of return, i.e., its standard deviation.

Today, many professionals and investors feel that standard deviation is not an adequate definition of
risk. Few people care if investments fluctuate upward; upside volatility does not seem risky. It is the
downside movements that investors view as risky. Post-Modern Portfolio Theory agrees that volatility
equals risk, but distinguishes between good volatility and bad.

Post-Modern Portfolio Theory (PMPT)

PMPT is a portfolio optimization methodology that uses the downside risk of returns instead of the
mean variance of investment returns used by MPT. The difference lies in each theory's definition of risk,
and how that risk influences expected returns. Post-Modern Portfolio Theory (PMPT) uses the standard
deviation  of negative returns (Downside Standard Deviation ) as the measure of risk, while MPT203 210
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uses the standard deviation of all returns as a measure of risk.

The differences between risk, as defined by the standard deviation of returns, between the post-modern
portfolio theory and modern portfolio theory is the key factor in portfolio construction. MPT assumes
that risk is symmetrical, whereas PMPT assumes it is asymmetrical. Therefore, MPT becomes
essentially a special (symmetrical) case of PMPT. Downside risk captures what investors fear: having
negative returns. After all, high positive returns are viewed as something positive.

Investors see risk in three ways:

   - The risk of loss (that is, returns below zero)

   - The risk of underperformance (returns below a benchmark, such as a model portfolio or the S&P
500)

   - The risk of failing to meet one's specific financial goals

PMPT comes together around the concept of the investor's Minimum Acceptable Return (MAR). No
longer is the portfolio balanced along the investor's efficient frontier. Now it is constructed to meet a
predetermined goal, such as setting aside a certain amount for retirement, meeting a benchmark,
beating a peer group, or reducing annual pension contributions. The goal is set in advance. Intermediate
performance is relatively unimportant. Reaching the goal is what is valued. Like a bond held to maturity,
any change in value before that date is relatively immaterial although liquidity can be very important to
some investors. Once the investor's goal and the return necessary to meet that goal are determined,
investments or asset classes are selected using measures such as the Sortino  ratio.

PMPT's answer to the Sharpe  ratio, the Sortino  ratio appropriately incorporates the MAR and
downside risk to separate the good from the bad for a portfolio. Conceptually, the Sortino ratio is
calculated by subtracting the MAR from the return on the investment. The result is then divided by the
downside risk (Downside Deviation ).

15.23.2 Primary Index MPT statistics

Each fund in the database is assigned a primary benchmark index, based on its broad asset class.

This Primary Index is used as the benchmark for the calculations of the Modern Portfolio Theory
statistics such as alpha, beta, r-squared, Treynor.

15.23.3 Best-fit Index MPT statistics

The Best-fit Index is the market index that shows the highest correlation with a fund over the most-
recent 36 months, as measured by the highest r-squared of the regression of the fund against that
index.

Regressions are performed of a fund's monthly excess returns against the monthly excess returns of
several well-known market indexes. The index with the highest correlation coefficient (r-squared)
becomes the Best-fit index. Modern Portfolio Theory statistics (such as alpha, beta, r-squared, Treynor)
computed against the Best-fit Index facilitate comparisons of relatively similar funds.

15.23.4 Months Available

The number of months available for statistical calculations for each of the 1, 3, 5, 10, 15, and 20-year
periods is provided because sometimes less than the total number of months for each period is
available (12, 36, 60, 120, 180, 240 months), and that should be taken into consideration when
analyzing the various statistics.
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15.23.5 Beta

The various factors that influence the economy and financial markets in general, affect different
investments to a different degree. Beta is the primary measure of this MARKET RISK of an investment.

It measures the volatility of an investment in relation to the overall "market", reflected by an index such
as the Standard & Poor's 500 Total Return Index (i.e., assuming that all distributions are reinvested).

The market portion of the total risk of an investment, also known as systematic risk, cannot be reduced
through diversification (undiversifiable risk).

For a measure of the TOTAL RISK of an investment, one should look at the standard deviation of that
investment.

The market is defined to have a beta of 1.0. Therefore, securities with a beta less than 1.0 are thought
to be less risky than the market, and vice versa. Betas for most common stocks fall in the range of 0.5
to 1.5.

For example, a 3-year beta of 1.2 indicates that the security tended to fluctuate up or down 20%
MORE than the market (index) during that 3-year period. Likewise, a beta of 0.8 indicates fluctuation,
up or down, 20% LESS than the market.

While beta has limited predictive reliability for any one security over short time periods, it has been
found to be highly useful as a forecasting tool over longer periods for well diversified equity portfolios,
like most mutual funds.

Investments with LOW CORRELATION to the index (low r-squared, e.g., less than 0.30-0.50), have
betas that are not very meaningful and should not be relied upon.

 
Following is the formula used to calculate the beta of an investment:

 
where

    ß = beta

    n = number of observations

    x = rate of return of the market index

    y = rate of return of the investment

 

15.23.6 Alpha

Alpha is a measure of risk-adjusted performance. Alpha is thought of as the "active return" on an
investment and gauges the performance of an investment against a market index or benchmark which
is considered to represent the market’s movement as a whole. The "excess return" of an investment
relative to the return of a benchmark index is the investment’s alpha.

The return which results from bearing selection risk is called "residual return" or alpha. Alpha can be
either positive, negative, or zero. An important objective of each investor or portfolio manager should be
to strive for a positive alpha. This is the “value added” for departing from the overall market return and
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bearing the risk of selection.

It can be thought of as a measure of the difference between a portfolio’s actual returns and its expected
performance, given its level of risk as measured by beta. A positive alpha figure indicates the portfolio
has performed better than its beta would predict. In contrast, a negative alpha indicates the portfolio
has underperformed, given the expectations established by beta.

Alpha is used for mutual funds and all types of investments. It is expressed as a percentage measuring
how the portfolio or fund performed compared to the benchmark index.

Alpha, along with beta, is one of two key coefficients in the Capital Asset Pricing Model used in
Modern Portfolio Theory (MPT) and is closely related to other important quantities such as r-squared,
standard deviation, Sharpe ratio and Treynor ratio. All of these indicators are intended to help investors
determine the risk-return profile of an investment. The higher the r-squared, the higher the correlation
between the returns of the investment and those of the benchmark, and the more meaningful are the
alpha, beta and Treynor statistics.

Portfolio managers seek to generate alpha in diversified portfolios with diversification intended to
eliminate unsystematic risk (diversifiable risk). Because alpha represents the performance of a portfolio
relative to a benchmark, it is often considered to represent the value that a portfolio manager adds to or
subtracts from a fund's return. In other words, alpha is the return on an investment that is not a result of
general movement in the greater market (as represented by the benchmark used). As such, an alpha of
zero would indicate that the portfolio or fund is tracking perfectly with the benchmark index and that the
manager has not added or lost any value.

Alpha is generated by regressing a security's or mutual fund's excess return over a risk-free rate
against a benchmark's (e.g., S&P 500 index's) excess return. The beta represents the investment's risk
(the slope coefficient). The alpha is the intercept.

Following is the formula used to calculate the alpha of an investment:

 

where

    a = alpha

    b = beta

    n = number of observations

    x = rate of return of the market index

    y = rate of return of the investment

 

15.23.7 r-Squared

r-Squared is a measure of how the fluctuation of an investment is correlated to the fluctuation of its
market as reflected by an appropriate index.

Its value range is from 0.00 to 1.00. A high value indicates a strong correlation with the market, while a
value close to zero indicates little or no correlation with the movement of the market.
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Another way of looking at the r-squared of a portfolio is as the proportion of market risk to total risk
(market risk plus selection risk). For example, a security with an r-squared value of 0.90 can be
expected to have 90% of its variability accounted for by market factors.

Investments with LOW CORRELATION to the market (low r-squared, e.g., less than 0.30-0.40), have
betas, alphas, and Treynor statistics that are not as meaningful and should be interpreted accordingly.

r-squared is the coefficient of determination of the least-squares regression of the excess return of each
security with the excess return of the market, which has been employed to calculate the alpha and
beta of each security.

The index is selected to reflect the market for the security.

 
Following is the formula used to calculate the coefficient of determination:

where

  R2 = coefficient of determination

  r = correlation coefficient

Correlation Coefficient (r):

A security's correlation coefficient, which is statistically designated by the letter r, is an abstract
measure of how the security is correlated to the market index. An r value of +1.00 indicates perfect
positive correlation with the market; a measure of -1.00 is an indication of perfect negative correlation (i.
e., the security moves down when the market goes up and vice versa); and an r value of 0.00 indicates
that the security’s movement has no correlation with the market.

Following is the formula used to calculate the correlation coefficient:

 

 

 
where

r = correlation coefficient

x = rate of return for the index for a given month

 = the mean rate of return for the index for the same month

y = the rate of return for a security for the same month

 = the mean rate of return for the same security for the same month
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15.23.8 Monthly Mean

This is the arithmetic AVERAGE of the monthly returns for the stated time periods (1, 3, 5, 10, 15, 20
years) and can be used with the monthly standard deviation to estimate a security's volatility.

 
See also: Standard Deviation .

15.23.9 Monthly Standard Deviation

The standard deviation measures the TOTAL RISK of a security in terms of the volatility of its return. It
is a measure of the dispersion of a security's monthly returns around its average return over the stated
time periods (1, 3, 5, 10, 15, 20 years).

As used by statisticians, one standard deviation above and below the mean or expected value
estimates the range within which the return will fall two-thirds of the time. Therefore, standard deviation
can be a comforting statistic to know, since it establishes the size of the range within which our
experience will fall with 68% confidence. A range of plus or minus two standard deviations will give us a
95% confidence interval.

For example, if a security has an average return of 2% and a standard deviation of 5%, it means that
we can expect with a probability of about 68% a return to be within plus or minus one standard
deviation, which is within a range of -3% to +7%. Also, there is a probability of 95% that a return is
within plus or minus two standard deviations from the mean or between -8% and +12%.

Following is the formula used to calculate standard deviation:

where

S = standard deviation

x = rate of return

 = average rate of return for entire period

n = number of observations

 

Mean - Monthly Mean

This is the arithmetic AVERAGE of the monthly returns for the stated time periods (1, 3, 5, 10, 15, 20
years) and can be used with the monthly standard deviation to estimate a security's volatility.

See Downside Standard Deviation .

15.23.10Annualized Standard Deviation

The Annualized Standard Deviation of each security is computed by multiplying its monthly standard
deviation by the square root of 12. It can be used with the annualized returns of various periods.
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Since the data used to compile most of the statistical information shown is calculated on a monthly
basis, the standard deviation can be annualized to show the expected range of a security's annual
return. The formula used for computing it is as follows:

 

where

S = annualized standard deviation

s = monthly standard deviation

See Monthly Standard Deviation  for more details.

15.23.11Sharpe

The Sharpe statistic measures the RISK-ADJUSTED PERFORMANCE of an investment by taking into
account both the return and the TOTAL RISK (volatility) of the investment. Investments with higher
Sharpe statistics have performed better on this risk-adjusted basis for the stated time periods (1, 3, 5,
10, 15, 20 years).

The Sharpe measure is calculated by dividing the EXCESS return of a security by its STANDARD
DEVIATION for the stated time periods (1, 3, 5, 10, 15, 20 years).

The EXCESS return of a security is the return of that security minus the risk-free rate of return, in this
case the 90-day Treasury bill rate.

The only difference between the Treynor and Sharpe statistics is the measure of risk that is used. The
Treynor measure uses beta instead of the standard deviation.

A greater Sharpe ratio is better. When examining two similar investments, the investment with a higher
Sharpe ratio would be preferable because that investment has more return for each unit of risk.

Also see Standard Deviation , Sortino Ratio , Downside Deviation .

15.23.12Treynor

The Treynor statistic measures the RISK-ADJUSTED PERFORMANCE of an investment by taking into
account both the return and the MARKET RISK of the investment. Investments with higher Treynor
statistics have performed better on this risk-adjusted basis for the stated time periods (1, 3, 5, 10, 15,
20 years).

The Treynor measure is calculated by dividing the EXCESS return of a security by its BETA for the
stated time periods (1, 3, 5, 10, 15, or 20 years).

The EXCESS return of a security is the return of the security minus the risk-free rate of return, in this
case the 90-day Treasury bill rate.

The only difference between the Treynor and Sharpe statistics is the measure of risk that is used. The
Treynor measure uses beta instead of the standard deviation.

 
Also see Beta .
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15.23.13Volatility Group

The Volatility Group number is based on each fund's annualized standard deviation over the stated time
period (1, 3, 5, 10, 15, 20 years). Zero designates the lowest monthly volatility over time and is usually
associated with Money Market funds, while funds in Group 9 have the highest volatility.

Volatility Group Standard Deviation Range

0 Money Market Funds
1 Up to 7.99
2 8.00 to 10.99
3 11.00 to 13.99
4 14.00 to 16.99
5 17.00 to 19.99
6 20.00 to 22.99
7 23.00 to 25.99
8 26.00 to 28.99
9 29.00 and over

15.23.14Skewness

In probability theory and statistics, skewness is a measure of the asymmetry from the normal
distribution in a set of statistical data. Skewness can be negative or positive, depending on whether
more data points are skewed to the left (negative skew) or to the right (positive skew) of the data
average. A normal (symmetrical) distribution has a skewness of zero.

Skewness is very important to finance and investing. Most sets of data, including stock prices and
asset returns, have either a positive or a negative skew rather than following the balanced normal
distribution (which has a skewness of zero). By knowing which way data is skewed, one can better
estimate whether a given (or future) data point is more likely to be greater or less than the mean.

The mean and standard deviation have the same units as the original data (and the variance has the
square of those units). However, the skewness has no units: it is a pure number.

T

t
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t
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T
Skewness
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1

1

1

T = Number of periods

15.23.15Kurtosis

In probability theory and statistics, kurtosis is a measure of the "peakedness" of a probability
distribution. Higher kurtosis means more of the variance is the result of infrequent extreme deviations,
as opposed to frequent modestly sized deviations.

Typically, a high kurtosis portrays a chart with fat tails and a low, even distribution, whereas a low
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kurtosis portrays a chart with skinny tails and a distribution concentrated toward the mean.
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15.23.16Sortino

Developed by Frank Sortino, the Sortino Ratio is an adjustment on the Sharpe Ratio in that it only
penalizes downside volatility. This is done by creating a value known as Downside Deviation which is
based on some Minimum Acceptable Return (MAR) which in this case is the "risk-free rate of return",
the U.S. Treasury 90-day T-bill.

It is similar to the Sharpe Ratio except it uses downside risk (Downside Deviation ) in the
denominator instead of standard deviation  (total volatility). Since upside variability is not necessary
a bad thing, Sortino ratio is sometimes more preferable than the Sharpe  Ratio. See Post-Modern
Portfolio Theory .

Similarly to the Sharpe ratio, a greater Sortino ratio is better. When examining two similar investments,
the investment with a higher Sortino ratio would be preferable because that investment has more return
for each unit of risk.

Sortino Ratio = Return of investment - benchmark return (risk-free rate) / Downside Standard Deviation

Monthly Sortino Ratio:

d

rfRR
Sortino

ˆ

Annualized Sortino Ratio:

d

ArfA
A

n

RR
Sortino

ˆ

,

n = Number of periods in a year (12 for monthly returns)

15.23.17Information Ratio

The Information ratio is a measure of the risk-adjusted return of a financial security (or asset or
portfolio). The Information Ratio is a special version of the Sharpe Ratio. The benchmark is used to
calculate the Information Ratio whereas the risk-free rate is used for the Sharpe Ratio.

It is defined as expected active return divided by Tracking Error , where active return is the difference
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between the return of the security and the return of a selected benchmark index, and Tracking Error is
the standard deviation of the active return.

Generally, the Information Ratio compares the returns of the manager's portfolio with those of a
benchmark such as the yield on three-month Treasury Bills or an index such as the S&P 500 Total
Return index.

The Information Ratio is often used to gauge the skill of managers of mutual funds, hedge funds, etc. In
this case, it measures the expected active return of the manager's portfolio divided by the amount of
risk that the manager takes relative to the benchmark. The higher the information ratio, the higher the
active return of the portfolio, given the amount of risk taken, and the better the manager.
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Annualized Information Ratio:

A

AbmA
A

TE

RR
IR ,

T = Number of periods

15.23.18Tracking Error

Tracking error is a measure of the volatility of excess returns of an investment relative to a benchmark.
It is used to compute the Information Ratio .
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Annualized Tracking Error:

nTETEA

T = Number of periods

n = Number of periods in a year (12 for monthly returns)
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15.23.19Capture Ratio Upside

Upside Capture Ratio measures a manager's performance in up markets relative to the market
(benchmark) itself. It is calculated by taking the fund’s upside capture return and dividing it by the
benchmark’s upside capture return.

The up-market capture ratio is used to evaluate how well an investment manager performed relative to
an index during periods when that index has risen. The ratio is calculated by dividing the manager's
returns by the returns of the index during the up-market and multiplying that factor by 100.

An investment manager who has an up-market ratio greater than 100 has outperformed the index during
the up-market. For example, a manager with an up-market capture ratio of 120 indicates that the
manager outperformed the market by 20% during the specified period. 

Determine number of upside periods:
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15.23.20Capture Ratio Downside

Downside Capture Ratio measures a manager's performance in down markets relative to the market
(benchmark) itself. It is calculated by taking the fund’s upside capture return and dividing it by the
benchmark’s downside capture return.

It is used to evaluate how well an investment manager performed relative to an index during periods
when that index has dropped. The ratio is calculated by dividing the manager's returns by the returns of
the index during the down-market and multiplying that factor by 100.

An investment manager who has a down-market ratio less than 100 has outperformed the index during
the down-market. For example, a manager with a down-market capture ratio of 80 indicates that the
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manager's portfolio declined only 80% as much as the index during the period in question.

Determine number of downside periods:
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Downside Capture Return:
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Downside Capture Ratio:
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T = Number of periods

15.23.21Relative Risk

Relative Risk measures the uncertainty (volatility) of future returns of an investment relative to a
benchmark.

It is the ratio of the standard deviation of the security over the standard deviation  of the benchmark,
in this case the S&P 500 Total Return index. (There is no need for annualization.)

ˆ

ˆ
bm

RelativeRisk

15.23.22Batting Average

Batting Average is a measure of a manager's ability to consistently beat the market. It is calculated by
dividing the number of months in which the manager beat or matched the benchmark by the total
number of months in the period. For example, a manager who meets or outperforms the benchmark
every month in a given period would have a batting average of 100. A manager who beats the
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benchmark half of the time would have a batting average of 50.

Let I be the indicator function such that I(true)=1 and I(false)=0:

1001
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T = Number of periods

15.23.23Percent Of Positive Months

This is the percentage of monthly returns in a given time period that are greater or equal to zero. (The
percentage of months that the investment did not lose money during the stated period.)

15.23.24Maximum Drawdown

The peak to trough decline in an investment's value over a given period measured as the percentage
decrease from peak to trough.

The Maximum Drawdown represents the maximum loss from a peak to a trough of an investment before
a new peak is attained. It is an indicator of downside risk over a specified time period. It can be used to
assess the relative riskiness of an investment strategy against another, as it focuses on capital
preservation, which is a key concern for most investors.

Maximum Drawdown provides a worst case scenario. It is the percentage of an investment that would
have been lost, if an investor bought at the absolute peak value of an investment, held it all the way
down, and sold at rock-bottom. If an investment never lost any value, the maximum drawdown would be
0%. The worst possible maximum drawdown would be 100%, meaning the investment's value became
zero. Most maximum drawdown values fall somewhere between these two extremes.

Maximum drawdown measures only the largest drawdown. It does not reveal if other losses were short
and sharp or long and drawn-out and how long it took to recover from them. It only measures the size of
the largest loss for the period and does not reflect the frequency of large losses.

15.23.25Downside Standard Deviation

A measure of downside risk that focuses on returns that fall below a minimum threshold or Minimum
Acceptable Return (MAR). It is used in the calculation of the risk-adjusted performance measure known
as the Sortino  Ratio.

Standard deviation , the most widely used measure of investment risk, has some limitations, such
as the fact that it treats all deviations from the average - whether positive or negative - as the same.
However, investors are generally more concerned with negative divergences than positive ones, i.e.
downside risk is a bigger concern. Downside deviation resolves this issue by focusing only on downside
risk. It includes negative excess returns and replaces any positive returns with zero in the calculation.

Another advantage over standard deviation is that downside deviation can also be tailored to the specific
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objectives and risk profile of different investors who have various levels of minimum acceptable return. In
this case, the MAR is the risk-free rate of return, the U.S. Treasury 90-day T-bill rate. See Post-Modern
Portfolio Theory .
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Annualized Downside Deviation:
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T = Number of periods

n = Number of periods in a year (12 for monthly returns)

15.23.26Upside Standard Deviation

A measure of upside volatility that focuses on returns that are above a minimum threshold or Minimum
Acceptable Return (MAR). In this case, the MAR is the risk-free rate of return, the U.S. Treasury 90-
day T-bill rate. In contrast with Downside Standard Deviation , it includes positive excess returns and
replaces any negative returns with zero in the calculation.
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Annualized Upside Deviation:
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T = Number of periods

n = Number of periods in a year (12 for monthly returns)

15.23.27Semi-Standard Deviation

Semi-Standard Deviation characterizes the downside risk of a distribution and focuses on the portion of
risk that is below (to the left of) the mean. Semi-deviation measures the volatility of the returns that
occur below the average return.
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Generally, if the returns have negative skewness the semi-deviation will be greater than the standard
deviation. Those portfolio strategies that have positive skewness generally will have a semi-deviation
smaller than the standard deviation .

However, many investors probably do not often define their return objectives around an average
experience. The Downside Deviation  risk measure builds on the idea of semi-deviation, but captures
the downside risk relative to a minimum return expectation.
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Annualized Semi-Standard Deviation:
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T = Number of periods

n = Number of periods in a year (12 for monthly returns)

15.23.28Loss Standard Deviation

Measures the volatility of downside performance.

The calculation is generally similar to Standard Deviation , except it calculates an average (mean)
return only for periods with a loss and measures the variation of only the loss periods around the loss
mean. 

Essentially the same calculation as Downside Standard Deviation , but with the Minimum
Acceptable Return equal to zero.

T

t
tR

T
LD

1

2
0,0min

1

1

Annualized Loss Standard Deviation:

nLDLDA

203

210

203

210



Data Definitions 213

© 2024 Steele Systems, Inc.

T = Number of periods

n = Number of periods in a year (12 for monthly returns)

15.24 Variable Annuity Data

15.24.1 Sub-Account Information

This information includes the Sub-account Inception Date, the Total Net Assets and the TNA Date
as well as the Underlying Mutual Fund ID.

It should be noted that the Sub-account Inception date and the Sub-account Total Net Assets can be
different from the underlying fund's inception date and total assets under management.

There are also Tax-status & Retirement Plan Y/N flag fields which can be used for filtering.  They
identify the tax status of the investment (whether qualified for tax deferral or not), as well as the types of
retirement programs for which the annuity can serve as an investment vehicle.

- Tax Qualified

- Tax Non-Qualified

- Can Be KEOGH

- Can Be IRA

- Can Be 401k

- Can Be 403b

- Can Be 457

15.24.2 Policy Information

Policy Name & Policy ID

The name and ID of the policy which is part of the annuity insurance product.

Policy Type

Identifies the policy as a Variable Annuity, a Variable Life, or a Variable Universal Life policy.

Issue Age

The maximum age of the annuitant for which the company will issue a contract.

Premium Type

The method of investment chosen by the individual. The payment option can be of various types,
including:
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Single Payment Plan

The individual makes a lump sum payment which is allowed to grow until the annuity phase begins.

Flexible Payment Plan

Allows the individual to make payments at any time, subject to the minimum payment
requirements outlined in the prospectus.

 

Other fields include the Policy Inception Date, Payout Type (Deferred or Deferred With Immediate
Annuity), whether the Policy is Open (Y/N), and the Annuity Age.

15.24.3 Insurance Company Information

The insurance company information includes the Insurance Company Name, Insurance Company
ID, Insurance Company Website, Company Address and Telephone Numbers.

It also includes the insurance company rating. (See A.M. Best Rating )

15.24.4 A.M. Best Rating

A.M. Best's Financial Strength Rating is an independent opinion, based on a comprehensive
quantitative and qualitative evaluation, of a company's balance sheet strength, operating performance
and business profile.

A.M. Best's Financial Strength Rating (FSR) is an opinion of an insurer's ability to meet its obligations
to policyholders. Rating Modifiers and Affiliation Codes may also be associated with these ratings. The
following list outlines the rating scale and associated descriptions.

 

Secure Vulnerable

A++, A+ (Superior) B, B- (Fair)

A, A- (Excellent) C++, C+ (Marginal)

B++, B+(Good) C, C- (Weak)

 D (Poor)

 E (Under Regulatory  Superv ision)

 F (In Liquidation)

 S (Rating Suspended)

 
Not Rated Categories (NR) are assigned to companies reported on by A.M. Best, but not assigned a
Best's Rating. The five categories and descriptions are listed below.

 
NR-1: Insuf f icient Data

NR-2: Insuf f icient Size and/or Operating Experience

NR-3: Rating Procedure Inapplicable

NR-4: Company  Request

NR-5: Not Formally  Followed

 
Best's Ratings are under continuous review and subject to change and/or affirmation. For the latest 
Best's Ratings and Best's Company Reports (which include Best's Ratings), visit the A.M. Best
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website at http://www.ambest.com. See Guide to Best's Ratings for explanation of use and charges.

Best's Ratings reproduced herein appear under license from A.M. Best and do not constitute, either
expressly or implied, an endorsement of Steele Expert or its recommendations, formulas, criteria or
comparisons to any other ratings, rating scales or rating organizations which are published or
referenced herein. A.M. Best is not responsible for transcription errors made in presenting Best's
Ratings. Best's Ratings are proprietary and may not be reproduced or distributed without the express
written permission of A.M. Best Company.

15.24.5 Annuity Options

The options available for receiving annuity payments. Annuity products typically offer several options
from which to choose. The most common Y/N options include:

Life Annuity

Guarantees payments for the life of the annuitant regardless of how long or short a time period that may
be.

Life Annuity with Refund

Similar to the Life Annuity except that it guarantees the return of the entire principal invested if the
annuitant dies before the principle is exhausted. If the annuitant exhausts the principal, payments are
guaranteed for the life of the annuitant.

Certain and Life

Guarantees payments for a fixed period of time or the life of the annuitant, whichever is longer.

Joint and Survivor

Guarantees annuity payments for the life of the annuitant and spouse.

Fixed Period

Guarantees payments for a fixed time period beyond which no more payments will be made.

Interest Option

Preserves the principle invested. Under the Interest Option, payments are calculated based on the
interest earned from the investments, thus preserving the principle to be passed on to the heirs of the
annuitant.

 

Withdrawal Options include Systematic Withdrawal, Free Withdrawal and Minimum Free
Transaction.

15.24.6 Death Benefit

The payment guaranteed to the beneficiary should the annuitant die before annuity payments begin.
The death benefit usually provides for some minimum payment that will return the principle invested
and, in many cases, the growth as well. The four types of death benefits in common use today are
listed below along with a brief description:
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Standard

Typically guarantees the greater of a) the account value or b) the sum of purchase payments less any
withdrawals.

Step Up

Similar to the Standard Death Benefit except that it provides a periodic review of the Death Benefit and
locks in a minimum benefit to be paid. This adjustment is typically made once every five to seven
years.

Rising Floor

Unlike the other types of death benefits, the Rising Floor Death Benefit guarantees a minimum growth
of the money invested.

15.24.7 Fees & Expenses

These include:

Expenses

- Mortality Expense Risk

- Administration Fees

- Distribution Fees

- Total Insurance Expense (equal to the sum of the above three percentages)

Charges

- Policy Front-End Load

- CDSC charges (See Contingent Deferred Sales Charge (CDSC) )

Contract Charge

A yearly fee charged to cover the costs of administering the variable account. This charge may be
expressed as a dollar amount or a percentage of assets. When expressed as a percentage, the dollar
amount usually reflects is the maximum amount the company will deduct. This charge may also be
waived if the assets held are greater than a minimum dollar value stated by the company.

15.24.8 Contingent Deferred Sales Charge (CDSC)

A fee deducted from any premature withdrawals from the annuity. Typically expressed as a percentage
of the amount withdrawn, the CDSC will decline the longer the money is invested. In some cases the
CDSC table may apply to each individual payment rather than only the initial investment.

The CDSC fields include the CDSC Percent / Duration columns as well as:
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- Is There a CDSC?

- Is there a CDSC Back-End?

- CDSC Maximum Percent

- CDSC Total Years

15.24.9 Purchasing Information

Initial & Subsequent Purchase Amounts - Qualified & Non-Qualified

The purchase amounts based on the tax status of the investment (whether it is qualified for tax deferral
or not).

Contract Charge & Minimum Free Balance

A yearly fee charged to cover the costs of administering the variable account. This charge may be
expressed as a dollar amount or a percentage of assets. When expressed as a percentage, the dollar
amount usually reflects the maximum amount the company will deduct. This charge may also be
waived if the assets held are greater than a minimum dollar value (Minimum Free Balance) stated by
the company.

Transfer Fee

The amount charged for transferring money from one sub-account to another. The companies will
typically allow a specified number of free transfers and specify a Minimum Transfer Amount.

15.24.10Fixed Account

Many variable annuities offer the option of investing in an account that guarantees a percentage growth
for the money invested. An annuity may offer one or more fixed account options, which vary by the
length of investment and interest rate guaranteed.
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16 Glossary

16.1 AA/AA Bond Rating

A high grade assigned to a debt obligation by a rating agency. Such a rating indicates a very strong
capacity to pay interest and repay principal. An AA rating indicates only slightly lower quality than the
top rating of AAA.

 

16.2 AAA Bond Rating

The highest grade assigned to a debt obligation by a rating agency. Such a rating indicates an
unusually strong capacity to pay interest and repay principal.

 

16.3 BBB/BAA Bond Rating

A medium-grade assigned to a debt obligation by a rating agency. Such a rating indicates an adequate
ability to pay interest and repay principal; however, adverse developments are more likely to impair this
ability than would be the case for bonds rated A and above. A BBB or BAA rating is the lowest
category in which a bond can be considered investment grade.

 

16.4 Blue Chip

A very high quality investment involving a lower-than-average risk of loss of principal or reduction in
income. The word blue chip is generally used to refer to securities of companies having a long history of
sustained earnings and dividend payments. The 30 stocks in the Dow Jones Industrial Average -
including IBM, AT&T, Exxon - are unquestionably blue chips.

 

16.5 Closed-End Fund

A Closed-End Fund issues only a fixed number of shares. They tend to have specialized portfolios of
stocks, bonds, convertibles, or combinations thereof, and may be oriented toward income, capital
gains, or a combination of these objectives. The Mutual Fund Expert does not contain Closed-End
funds.

 

16.6 Closed Fund

A fund that has stopped issuing new shares. Funds close either because they are so large that the
managers cannot find enough good investments or because the manager prefers investing only in small
companies, and cannot cope with large amounts of money.

 

16.7 Convertible

Convertible funds invest the majority of their portfolios in convertible bonds and convertible preferred
shares.
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16.8 Covered Option

A call option sold short by an investor owning the underlying stock. In case the option is later exercised
against the short seller of the option, the seller is covered by the stock that is owned.

 

16.9 Decile

The decile rank appears on the Ranks & Averages Report and Ranks & Averages tables. It reflects
groupings of percentile rankings as follows:

Decile Rank Percentile Rank
1 1-10%
2 11-20%
3 21-30%
4 31-40%
5 41-50%
6 51-60%
7 61-70%
8 71-80%

9 81-90%

10 91-100%

Thus a fund with a decile rank of 1 is in the top 10 percent of all records within the selected group
whereas a fund with a decile rank of 10 is in the bottom 10 percent of the group.

The decile ranking will appear blank for a field that has no value in the current field.

 

16.10 Fees & Expenses

Front or back-end load fees are not included in the return field since we cannot know how long a
particular position is being held in the fund. However, all expenses (management fees) are removed on
a daily basis from the Net Asset Value.

 

16.11 Front-End Load

Sales commission investors pay at the time they buy shares of a mutual fund. Loads are not reflected
in the returns, which are calculated based on the NAV.

 

16.12 Fund Detail SEC Report

Only available in the Professional versions. The SEC Returns Report provides you with most of the
data available about a fund (normal long term performance returns are not included on the report). The
SEC Returns are adjusted for (net of) front-end loads and deferred fees.
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Use one of the following methods to display the SEC Returns Report.

Select the Fund Detail SEC Pro Page,

or select SEC Returns from the Page menu.

 

16.13 Graph - Long-Term Performance

The graph depicts the yearly return over time, as compared to S&P 500 and the matching investment
objective average. Use one of the following methods to display the Long-Term Performance Graph.

Select the Long-Term Performance Page,

or select Pages...Long-Term Performance Graph from the menu.

 

16.14 Graph - Long-Term Growth

The Long-Term Growth Graph depicts the growth of an investment over time, as compared to S&P 500
and the matching investment objective average. The Expert assumes you are interested in the actual
growth for the starting year and makes the initial investment in the prior year.

Use one of the following methods to display the Long-Term Growth Graph.

Select the Long-Term Growth Page,

or select Pages...Long-Term Growth Graph from the menu.

 

16.15 Graph - Short-Term Performance

The graph depicts the yearly return over the last twelve months, as compared to S&P 500 and the
matching investment objective average.

Use one of the following methods to display the Performance Report.

Select the Short Term Performance Page,

or select Short Term Performance from the Page menu.

 

16.16 Graph - Short-Term Growth

The graph depicts the growth of an investment over the last twelve months, as compared to S&P 500
and the matching investment objective average. The Expert assumes you are interested in the actual
growth for the starting year.

Use one of the following methods to display the Short-Term Growth Graph.

Select the Short Term Growth Page,

or select Short Term Growth from the Page menu.
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16.17 Graph - Risk-Return

Just tag a group of funds and click on the Risk-Return Plot” page to see how each fund compares to
the S&P 500. Each fund is plotted in so that the further right it is, the riskier it is (higher volatility). The
further up it is, the higher returns it made during that period. The funds in the upper left corner tend to
be the best in the group (low risk - high return).

16.18 Investment Objective

Goals of a mutual fund, such as long-term capital gains, with income secondary.

 

16.19 Legal Advisor

The legal counsel hired to represent the fund in any legal proceedings.

Sub-Advisor

A company that manages the underlying mutual fund under the supervision of the advisor.

 

16.20 Load

Commission charge that buyers of certain mutual funds must pay. The load goes to the stockbroker
and the distributor, or—in the case of most low-load funds—to the fund itself. Loads are not reflected in
the returns, which are calculated based on the NAV.

 

16.21 Management Fee

The money paid to the managers of an investment company. The fee is generally based on a
percentage of the net asset value of the fund with the percentage becoming smaller as the fund’s
assets grow larger. Fees vary considerably among firms but average about 1/2 of 1% of assets. A
fund’s management fee must be listed in its prospectus and can be found in a number of publications.
All expenses (management fees) are removed on a daily basis from the Net Asset Value.

 

16.22 Market Capitalization

Value of a corporation as determined by the market price of its issued and outstanding common stock.
It is calculated by multiplying the number of outstanding shares by the current market price of a share.

 

16.23 Market Index

These are market and other indexes, such as the Dow Jones Industrial Average, or the Standard &
Poor’s 500, that can provide very useful benchmarks for comparison with individual mutual funds.
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16.24 Mutual Fund

An open-end investment company that continually offers new shares and stands ready to redeem
existing shares from the owners. Since the shares are purchased directly from and are sold directly to
the mutual fund, there is no secondary market in these companies’ stock. Individual mutual funds vary
substantially in terms of the types of investments, the sales charges (many have none), and the
management fees.

 

16.25 Net Asset Value

The market value of a fund share, what the public pays to buy the shares. It is calculated by dividing
the fund’s net assets by the number of shares outstanding.

 

16.26 No-Load

A fund that does not charge a front-end commission. A “pure” no-load also has no deferred sales
charge, no redemption fee and no 12b-1 fee.

 

16.27 Open-End Investment Company

A fund that can continually issue more shares and thus add to its net assets. Such a fund also buys
shares directly from its customers and sells shares directly to its customers.

 

16.28 Option

A contract that permits the owner, depending on the type of option held, to purchase or sell an asset at
a fixed price until a specific date. An option to purchase an asset is a call and an option to sell an
asset is a put. Depending on how an investor uses options, the risks can be quite high.

 

16.29 Performance

How well a fund has fared over a certain time period, usually measured by capital gains, dividend, and
interest the fund had earned.

 

16.30 Portfolio

Various securities held by an individual or a fund. The more diversified the investments in a portfolio, the
more likely the investor is to earn the same return as the objective of that portfolio.

 

16.31 Portfolio Comparison Report

The Portfolio Comparison Report displays data for the first two tagged Portfolio funds side-by-side.

The Portfolio Comparison Graph can accommodate up to ten funds in the Portfolio Table. If you want
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more than ten funds to be displayed in the table, you will need to resize the Portfolio Table and re-edit
the report.

16.32 Price Return (PR)

A price only index—does not include dividends reinvested.

 

16.33 Prospectus

Official document describing a mutual fund. It must be furnished to investors. The prospectus includes
financial information and a description of a company’s business history, officers, operations, pending
litigation (if any), and plans (including the use of the proceeds from the issue.

 

16.34 Prospectus Date

Prospectus Date

The date of issue of the most recent prospectus on file. Prospectuses are typically updated yearly by
the companies.

16.35 Redemption Fee

Charge a fund may levy, especially if an investor sells shares purchased recently.

 

16.36 Risk

Either the volatility of an instrument (variability of returns from an investment), or the possibility that the
investment will lose value. Since investors are generally averse to risk, investments with greater
inherent risk must promise higher expected yields.

 

16.37 Securities

Stocks, bonds, options, warrants, or other instruments that signify a corporation’s obligations to an
investor.

 

16.38 Securities and Exchange Commission (SEC)

Federal agency, created in 1934, that administers the securities laws. The federal agency that
administers U.S. securities laws. The SEC, headed by five appointed members, was created under the
Securities Exchange Act of 1934.
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16.39 Total Return (TR)

A total return—includes reinvested dividends or distributions.

 
 

16.40 Transfer Agent - Custodian

Transfer Agent

The transfer agent maintains and distributes shareholders’ records, prepares account statements, tax
information and other shareholder notices.

Custodian

The custodian maintains the assets and securities of the underlying mutual funds. By law the fund’s
advisor cannot serve as the custodian.

 

16.41 Turnover Ratio

Trading activity of a mutual fund, calculated by dividing the lesser of purchases or sales for the fund’s
fiscal year by the monthly average of the portfolio’s net assets. Excluded are securities that mature
within a year. A turnover ratio of 100 percent is the equivalent of a complete portfolio turnover.

 

16.42 Volatile

Subject to large price fluctuations. Traders generally prefer volatile securities if they buy and sell on
short-term price movements.
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